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Areas Covered 

Before Reading This Manual

This section explains the notes for your safety and conventions used in this manual.

Chapter 1 Overview

This chapter explains component names and basic operations of this server, as well as an 
overview of the software provided with this server. In addition, the workflow, from placing the 
server to starting the operation, is also described. 

Chapter 2 Checking before OS Installation

This chapter explains the preparation on the server and cautions necessary before OS installation. 
Please read this chapter before starting installation.

Chapter 3 OS Installation Using ServerStart

This chapter explains how to install the OS in the server using ServerStart.

Chapter 4 Manual OS Installation

This chapter explains how to install the OS without using ServerStart.

Chapter 5 Operations after OS Installation

This chapter explains the operations to be performed after OS installation. Be sure to perform 
those operations before operating the server.

Chapter 6 High Reliability Tools

For stable PRIMERGY server operations, we recommend that high reliability tools be installed. 
This chapter explains the installation and necessary settings of high reliability tools.

Chapter 7 Installing Hardware Options

This chapter explains how to install internal options.

Chapter 8 Configuring Hardware and Utilities

This chapter explains how to make the environment settings necessary to operate the server and 
how to use each utility.

Chapter 9 Operation and Maintenance

This chapter explains the operations that become necessary after starting to use this server as well 
as daily care and maintenance.

Appendix 

This appendix explains the specifications for the server and for its internal options. 
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Before Reading This Manual

Trademarks
Microsoft, Windows, and Windows Server are trademarks or registered trademarks of Microsoft Corporation in the USA
and other countries.
Intel, Celeron, Pentium, and Xeon are registered trademarks or trademarks of Intel Corporation or its subsidiaries in the
USA and other countries.
Linux is a trademark or registered trademark of Linus Torvalds in the USA and other countries.
Red Hat and all Red Hat-based trademarks and logos are trademarks or registered trademarks of Red Hat, Inc. in the
USA and other countries.
Other product names used are trademarks or registered trademarks of their respective manufacturers. 
Other products are copyrights of their respective manufacturers. 

All Rights Reserved, Copyright© FUJITSU LIMITED 2006

Screen shot(s) reprinted with permission from Microsoft Corporation.

For Your Safety... 
This manual contains important information, required to operate the server safely. 
Thoroughly review the information in this manual before using the server. Especially note the points under "Safety Precautions", and only
operate the server with a complete understanding of the material provided. 
This manual and "Safety Precautions" should be kept in an easy-to-access location for quick reference when using this server. 

Data Backup
To protect data stored in this device (including basic software and application software), perform backup and other necessary operations.
Note that data protection is not guaranteed when repairs are performed. It is the customer's responsibility to maintain backup copies in
advance. 
In case of data loss, Fujitsu assumes no liability for data maintenance or restoration and damages that occur as a result of the data loss for any
reason, except for items covered under warranty. 

High Safety
The Products are designed, developed and manufactured as contemplated or general use, including without limitation, general office use,
personal use, household use, and ordinary industrial use, but are not designed, developed and manufactured as contemplated for use
accompanying fatal risks or dangers that, unless extremely high safety is secured, could lead directly to death, personal injury, severe physical
damage, or other loss (hereinafter "High Safety Required Use"), including without limitation, nuclear reaction control in nuclear facility,
aircraft flight control, air traffic control, mass transport control, medical life support system, missile launch control in weapon system. You
shall not use this Product without securing the sufficient safety required for the High Safety Required Use. If you wish to use this Product for
High Safety Required Use, please consult with our sales representatives in charge before such use.

Problems may occur with this device in the event of an instantaneous voltage drop of the power supply due to lightning, etc. To prevent an
instantaneous voltage drop of the power supply, we recommend that you use an uninterruptible power supply system. 
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Remarks

Warning Descriptions
Various symbols are used throughout this manual. These are used to emphasize important points for 
your safety and that of others. The following are the symbols and their meanings. Fully understand these 
symbols when reading this manual.

The following symbols are used to indicate the type of warning or caution being described. 

Symbols
Symbols used in this manual have the following meanings.

Key Descriptions / Operations 
Keys are represented throughout this manual in the following manner. 
E.g.: [Ctrl] key, [Enter] key, [→] key, etc.
The following indicate pressing several keys at once: 
E.g.: [Ctrl] + [F3] key, [Shift] + [↑] key, etc.

CD-ROM Drive and DVD-RAM Drive Descriptions

In this manual, both CD-ROM and DVD-RAM drives are described as CD-ROM drives. Unless 
otherwise noted, a CD-ROM drive can also mean a DVD-RAM drive.

Ignoring this symbol could be potentially lethal.

Ignoring this symbol may lead to physical injury and/or damage the server or internal options.

A triangle mark emphasizes the urgency of the WARNING and CAUTION. Details are 
described next to the triangle.

A barred circle ( ) warns against certain actions (Do Not). Details are described next to the 
circle. 

A black circle indicates actions that must be taken. Details are described next to the black 
circle. 

These sections explain prohibited actions and points to note when using this device. Make 
sure to read these sections. 

These sections explain information needed to operate the hardware and software properly.  
Make sure to read these sections.

→ This mark indicates reference pages or manuals. 
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Entering Commands (Keys)
Command entries are displayed in the following way. 

• At each blank in a command line (as pointed out above), press the [Space] key once.
• When using Windows or DOS OS, commands are not case sensitive.
• CD-ROM drive names are shown as [CD-ROM drive]. Enter your drive name according to your 

environment. 
[CD-ROM drive]:\setup.exe

Screen Shots and Figures
Screen shots and figures are used as visual aids throughout this manual. Windows, screens, and file 
names may vary depending on the OS, software, or configuration of the server used. Figures in this 
manual may not show cables that are actually connected for convenience of explanation. 

Consecutive Operations

Consecutive operations are described by connecting them with arrows (→). 

Server Types
Server types are described as follows.

Example: Procedure of clicking the [Start] button, pointing to [Programs], and clicking [Accessories]
↓
Click [Start] → [Programs] → [Accessories].

table: Server Types

Type Expressions and 
abbreviations 

Servers without an internal hard disk Diskless type

Stationary servers Tower type

Rack mount servers using a Rack Conversion kit Rack mount type
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Abbreviations
The following expressions and abbreviations are used throughout this manual. 

*1: Unless otherwise noted, Windows Server 2003 can also mean SBS 2003 and Windows 2003 x64.

Reference Information

Software Manuals
Software Manual contains other reference information and cautions for ServerStart not described in this 
manual. Please read it before using ServerStart.
Software Manual is contained as a "README.TXT" file in the root directory on the ServerStart CD-
ROM. Use a text editor to read it.

Latest Information about Software Provided with This Server
For the latest information regarding ServerStart and other software provided with this server, refer to the 
Fujitsu PRIMERGY website (http://primergy.fujitsu.com).

table: Abbreviations of Product Names
Product name Expressions and abbreviations

PRIMERGY TX150 S5 This server or the server

Microsoft® Windows® Small Business Server 2003 SBS 2003 *1 Windows

Microsoft® Windows® Small Business Server 2003 
R2

SBS 2003 R2

Microsoft® Windows Server® 2003 R2, Standard 
Edition

Windows Server 2003 R2 Windows 
Server 
2003

Microsoft® Windows Server® 2003, Standard 
Edition

Windows Server 2003, 
Standard Edition

Microsoft® Windows Server® 2003, Standard x64 
Edition

Windows Server 2003 x64 *1

Microsoft® Windows Server® 2003 R2, Standard 
x64 Edition

Windows Server 2003 R2 x64

Microsoft® Windows® 2000 Server Windows 2000 Server

Microsoft® Windows® Preinstallation Environment Windows PE

Microsoft® Windows® XP Professional Windows XP Professional

Microsoft® Windows® 2000 Professional Windows 2000 Professional

Microsoft® Windows Server® 2003 Service Pack Service Pack

Microsoft® Windows® 2000 Service Pack

Red Hat Enterprise Linux ES (v.4 for x86) Linux
Red Hat Enterprise Linux ES (v.4 for EM64T)

http://primergy.fujitsu.com
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Warning and Caution Labels 

Warning and caution labels are found on the server. 
Do not remove or stain these labels. 
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Chapter 1

Overview
This chapter explains component names and 
basic operations of this server, as well as an 
overview of the software provided with this 
server. In addition, the workflow, from placing 
the server to starting the operation, is also 
described. 

1.1 TX150 S5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
1.2 Supplied Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
1.3 Component Names and Functions . . . . . . . . . . . . . . . . . . 22
1.4 Standard Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
1.5 Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
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1.1 TX150 S5

This server is entry server with high-speed processing and cost-effectiveness. This 
server has the following features.

High Reliability

Memory Modules Enabling High-Speed Processing

For the memory, the system is equipped with DDR II 533 Unbuffered Lowprofile DIMM enabling high-
speed processing.

Disk Array Configuration

The array system can be configured using an onboard SAS array controller. In the case of the onboard 
SAS array controller, the array system (RAID1) can be configured with two hard disk drives.
Also, a SAS array controller card is supported. In the case of the SAS array controller card, the array 
system (RAID 0/1/5/0+1) can be configured.

When configuring the array system using onboard SAS controller
Up to two hard disk units can be installed.

Redundant Function

For the disk array configuration (except for RAID 0), a failed hard disk unit in a storage system can be 
replaced or repaired without turning off the server and peripheral devices (a hot-plug is supported).

Hardware and Software Designed for Data Security

Locks on the drive covers and the password setting in the BIOS Setup Utility protect hardware and data 
assets in the server against theft, ensuring data security.

Proactive Fan Function

When a fan fails or the ambient temperature rises, the system fan speed is increased automatically to 
avoid increase in temperature in the server, ensuring stable server operation.

High Reliability Tools

High reliability tools, such as ServerView which is the tool for monitoring the server status, offer stable 
system operation. For information about high reliability tools, refer to "1.2.2 High Reliability Tools" 
( pg.20).
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High-speed Processing

Intel® Processor 

The server has an Intel® processor.

When Intel® Pentium® D Processor or Intel® Xeon® Processor is installed, it is a dual core processor, 
which physically functions as two CPUs.

Excellent Scalability

Maximum Memory Size of 8 GB

In addition to the preinstalled 512MB memory, the memory is expandable to 8GB.

Maximum Hard Disk Size of 587.2 GB

Up to four internal hard disk units can be installed in the 3.5-inch storage bays. The hard disk size can be 
increased up to 587.2 GB.

When configuring the array system using onboard SAS controller
Up to two internal hard disk units can be installed. More than two hard disk units cannot be added. 
Also, when RAID 1 is configured, capacity for one hard disk is available.

Five PCI Slots

The server has five PCI slots. Functions can be added by using expansion cards.

5-inch Internal Option Bay

The server has three 5-inch storage bays. One of them has an internal CD-ROM drive by default.
The 5-inch internal options such as backup unit can be installed to accommodate for an increasing 
amount of data.

Rack Mount Type

With the Rack Conversion kit, the server can be installed on a rack.
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1.2 Supplied Software

ServerStart for supporting setup and high reliability tools for avoiding problems during 
server operation are supplied with this server.

1.2.1 Setup Support Tool - ServerStart

ServerStart is a setup support tool that helps to install PRIMERGY.
It offers easy server installation and proper installation of recommended drivers.

Installing the OS using ServerStart

The following benefits are provided by using ServerStart to install the OS.

User definition, access privileges, network settings

Install

ServerStart

Auto setup

Not using ServerStart

Using ServerStart

&
Setup

It is necessary to input successively for installation, 
resulting in more mistakes and longer time

Example:
Operations such as setting IP address, 
creating users, and registering computer 
name are required

Auto installation of recommended drivers (SCSI, LAN, 
etc.) enables high reliable installation
High reliability tools can be installed 
automatically *2

Example:
Operations during OS installation is automated *1

High reliability tools are software with comprehensive strength for stable 
system operation of the server management

*2

Complex hardware settings (e.g. RAID setting)

RAID can be configured automatically

Some input (License window, etc.) and media repositioning are excluded*1
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Supported OSs

The following OSs can be installed using ServerStart V6.609.

• Microsoft® Windows Server® 2003, Standard Edition

• Microsoft® Windows Server® 2003, Enterprise Edition

• Microsoft® Windows Server® 2003, Standard x64 Edition

• Microsoft® Windows Server® 2003, Enterprise x64 Edition

• Microsoft® Windows Server® 2003 R2, Standard Edition

• Microsoft® Windows Server® 2003 R2, Enterprise Edition

• Microsoft® Windows Server® 2003 R2, Standard x64 Edition

• Microsoft® Windows Server® 2003 R2, Enterprise x64 Edition

• Microsoft® Windows® 2000 Server

• Microsoft® Windows® 2000 Advanced Server

ServerStart does not support to install SBS 2003 / Linux.
The OS which the server does not support cannot be installed.

Configuration File (SerStartBatch.ini)

A configuration file stores the server setup information configured in ServerStart. To create a 
configuration file, use the ServerStart floppy disk supplied with this server. Store only one file on each 
floppy disk. Do not set the ServerStart floppy disk to the write-protected state.
You can use any name for the configuration file. However, the file must be installed in the server as 
"SerStartBatch.ini". When installing the configuration file, make sure to save it as "SerStartBatch.ini" on 
the ServerStart floppy disk.
Start up ServerStart, insert the ServerStart floppy disk containing "SerStartBatch.ini", and click [Start] 
to install the server.
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Intuitive User Interface
The intuitive user interface allows you to easily set the necessary information.

Main Window

When ServerStart is started, the following window appears. The window and tool bar differ depending 
on the mode.

Tool Bar

In Guide/Expert Mode

While the wizard is running, do not click the  icon to move to the previous or next window or 
to upper tree level. To move to a different window, click the [Previous], [Up], or [Next] button at the 
bottom of the wizard window.

Brings you to 
the next page.

Brings you up
one tier.

Brings you to 
the main screen.

Ends ServerStart. Changes the size 
of icons.

Brings you to 
the previous page.

Resets the status 
function.

ON/OFF of the tree display is set.
It doesn't support, and never click.
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Wizard Window

Clicking a wizard displays a wizard window.
Set items in the wizard window. To move to a step in the next wizard window, click the operation button 
at the bottom of the window. Clicking [help] displays a tip for setting the item.

Network Configuration
ServerStart can configure a network at server installation.
 For details on available network patterns, refer to "Using ServerStart to Configure the Network".

Automatic Driver Installation
Recommended drivers for automatically recognized expansion cards are installed with the server. This 
prevents possible mistakes in driver installation, such as installation of an older version or drivers which 
were not supplied with this server.

Automatic RAID Configuration
When an array controller card is used, specify the RAID type and the number of hard disk units before 
starting installation. A storage system can be configured without starting the RAID utility.

Remote Installation
Using ServerStart, you can store resources necessary for installation, such as the OS and ServicePack, in 
another server on the network, and install the OS via the network. This method is convenient when the 
server does not have a CD-ROM or floppy disk drive.
SystemcastWizard Professional (optional) is a useful tool for extracting a lot of files in a short time.
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1.2.2 High Reliability Tools

High reliability tools are a comprehensively useful set of software for stable system operations of the 
server. The following tools have respective roles to manage normal operations or recovery from errors: 
• Server monitoring tools
• System diagnosis support tools
• LAN driver detailed setting tools

Server Monitoring Tools
The server monitoring tools monitor the hardware status on behalf of the administrator and notify him/
her in the event of an error. 

Early Detection of a Server Failure [ServerView]

ServerView is software that monitors whether the server hardware is in a normal state to protect 
important server resources. When using ServerView, the server hardware is monitored all the time. If an 
error that could cause trouble is detected, the administrator is notified in real-time. This allows the server 
administrator to remove a system error early and avoid trouble. 

Early Detection of a Disk Problem [RAID Management Tool]

RAID Management Tool is software that performs array configurations, disk initialization and storage 
system monitoring. When an event occurs, it leaves an event log in the event viewer's application logs. 
At the same time, a pop-up window indicates a hard disk failure, rebuild status, etc. 

System Diagnosis Support Tools
The system diagnosis support tools are for supporting system diagnosis during normal operation or in 
the event of trouble. 

Early Solution to Problems [DSNAP]

DSNAP is a command line utility for collectively acquiring failure investigation information. Command 
line operation makes easy to set the configuration information of the system file and major registries, 
and collect the event log. 
When a problem occurs in your Windows Server 2003 / Windows 2000 Server system, DSNAP is used 
for a support engineer to understand your system software configuration and settings correctly and to 
promote research smoothly. Provide this with memory dump to your support engineer.

LAN Driver Advanced Setup Tools
These tools set details on the LAN, including the use of the Teaming (load balance) function and VLAN 
configuration.

Broadcom Advanced Control Suite (BACS)

BACS is a tool for setting details on the onboard LAN when it is used to configure a VLAN.

Intel® PROSet

Intel® PROSet is a tool for setting details on the LAN card when it is used for using the Teaming 
function or when it is used for configuring a VLAN.
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1.2.3 Installing High Reliability Tools

You can install all high reliability tools provided with PRIMERGY by specifying them in "Application 
Wizard" when the OS is installed is initiated with ServerStart.
The following high reliability tools are installed.

A: Installed in any case
N: Installed if selected (Not selected by default)
S: Installed if selected (Selected by default)

SBS 2003 and Linux do not support batch installation with ServerStart.
ServerView must be configured after installation even when the high reliability tools have been 
installed at once with ServerStart. Refer to "Chapter 6 High Reliability Tools" ( pg.171).

When using ServerStart to install the OS, RAID Management Tool and ServerView are installed at a 
time. These cannot be selected individually.
To use all functions of ServerView, "Java2 Runtime Environment Standard Edition" and "Web server" 
are required. When using ServerStart to install the OS, "Java2 Runtime Environment Standard 
Edition" is installed automatically. For Web server, you can use either of the followings by selecting a 
menu.
• ServerView (for apache)

Install ServerView Web-Server (Web server for ServerView, Apache for Win32 base) and install 
ServerView configuring to use this Web server.

• ServerView (for IIS)
Install Microsoft Internet Information Server (IIS) supplied with Windows separately. ServerView is 
installed with the setting to operate using IIS installed on the system.

When IIS is not found in the system, ServerView Web-Server is installed even if "ServerView (for IIS)" 
is selected. ServerView (for apache) is selected by default for guided mode. To install ServerView (for 
IIS), select "RAID Management Tool / ServerView (for IIS)". If "RAID Management Tool / ServerView 
(for IIS)" is selected, ServerView (for apache) is not installed.
Intel® PROSet will be installed only when an optional LAN card is installed properly and the driver is 
applied correctly.
If the OS is installed on other than drive C using ServerStart, Intel® PROSet will not be installed. In this 
case, install Intel® PROSet manually. For details, refer to "5.7.1 Intel® PROSet Installation" 
( pg.166).

table: High reliability tools installation

High reliability tool
ServerStart installation

Guided mode Expert mode

RAID Management Tool / ServerView (for apache) S N

RAID Management Tool / ServerView (for IIS) N N

DSNAP S S

Broadcom Advanced Control Suite (BACS) A N

Intel® PROSet A A
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1.3 Component Names and Functions

This section explains the component names and functions of the server and 
baseboard.

1.3.1 Server (Front View) 

a Drive cover key
We recommend you lock it to prevent unauthorized access to the inside of the server.

b System identification LED
This LED is used for maintenance. When pressing the system identification LED button, the 
front and rear LEDs are lit blue so that the locations of devices being maintained can be 
determined. 
Also, the [System Identification LED Display] button of ServerView can be used to light them. 

c System identification LED button
When pressing system identification LED button, the front and rear system identification LEDs 
are lit blue so that the locations of devices being maintained can be determined. 

d Reset switch
Pressing this switch resets and restarts the system.

Do not restart the system when the hard disk access LED is blinking.
Data in the hard disk may be damaged. 

a b c d e
f
g

h
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o
p

r

q

Drive cover

Pull the drive cover 

down to the lower 

end of the server.
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e Maintenance switch
This switch is used only by maintenance personnel. Do not touch this. 

f System status LED ( )
This LED lights or blinks in amber when an error is detected in the server components. If this 
LED lights or blinks, contact an office listed in the "Contact Information" of "Start Guide".

g Hard disk access LED ( )
This LED blinks when data is being written to or read from the hard disk.

h Power LED ( )
This LED is lit green when the server is turned on.

Power LED is lit when the server is in standby mode (when the AC power is on and the DC
power is off), but this does not indicate an error.

i Power switch 
Press this switch to turn the server on. 

Do not turn the server off when the hard disk access LED is blinking. 
Data in the hard disk may be damaged. 

j 5-inch storage bay
Contains a 5-inch internal device. 
Unlike external devices, an internal option does not need to be connected to the outlet because its 
power is supplied from the server. It also saves space.

k CD-ROM drive
Reads data or programs from a CD-ROM. 

l CD-ROM eject button
Press this button to eject a CD-ROM.
Do not press this when the CD-ROM access LED is on. 

m CD-ROM access LED
This LED blinks when data is being read from a CD-ROM. 

n Drive cover
This slides up and down.

o Floppy disk eject button
Press this button to eject a floppy disk.
Do not press this when the floppy disk access LED is on. 

p Floppy disk access LED
This LED blinks when data is being written to or read from a floppy disk. 

q Floppy disk drive
Writes/reads data to/from a floppy disk. 

r USB connector ( )
Connects peripheral equipment conforming to the USB standard (2.0 or 1.1). 

?
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Inside the Hard Disk Cover

a 3.5-inch storage bay
Contains an internal hard disk. 

b Hard disk access display LED ( )
This LED is lit green when data is being written to or read from the hard disk. 

c Hard disk failure LED ( )
It is lit or blinks depending on the hard disk status as follows.

table: Meaning of the Hard Disk Access Display LED
LED status Hard disk access status

Off Hard disk is not accessed

Lights in green Hard disk is accessed

table: Meaning of the Hard Disk Failure LED
LED status Hard disk status

Off In normal mode or hot spare mode

Lights in amber Error detected in the hard disk (in an array configuration)

Blinks in amber Rebuilding

a

b

c

Hard disk cover

Remove the hard 

disk cover.
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1.3.2 Server (Rear View) 

a Inlet
Connects power cables.

b Mouse connector ( )
A mouse is plugged in.

c System status LED
This LED lights or blinks in amber when an error is detected in the server components. If this 
LED lights or blinks, contact an office listed in the "Contact Information" of "Start Guide".

System status LED is lit when the server is in standby mode (when the AC power is on and the
DC power is off), but this does not indicate an error. 

d System identification LED
This LED is used for maintenance. When pressing the system identification LED button, the 
front and rear LEDs are lit blue so that the locations of devices being maintained can be 
determined. 
Also, the [System Identification LED Display] button of ServerView can be used to light them. 

e Keyboard connector ( )
A keyboard is plugged in.

f Serial port connector (  )
Cables of peripheral equipment conforming to the RS-232C standard such as modems are 
plugged in.

g Display connector ( )
A display cable is plugged in.

a

b

c
d
e

f

g

h
i

K

j
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h Parallel port (option)
A printer cable is plugged in.

i USB connector ( )
Connects peripheral equipment conforming to the USB standard (2.0 or 1.1). 

j Remote Management Controller port
This is a port for the Remote Management Controller. The Remote Management function can be 
used from Web interface by connecting a LAN cable. For information on how to use the Remote 
Management Controller, refer to "D Remote Management Controller" ( pg.278).

k LAN (10/100/1000BASE-T) port ( )
An Unshielded Twisted Pair (UTP) cable is plugged in.
For 1000Mbps connection, a category 5 enhanced or a category 6 cable is required.
For 10Mbps/100Mbps connection, a category 5 or higher cable is required. 

The meaning of the LED is shown in the table below. 

table: Meaning of the LAN Port LED
LED 

location LED status Connection status

Upper LED Lights in green Link is being established

Blinks in green Data is being transferred

Off Link is not established

Lower LED Lights in amber Connection established at 1000 Mbps

Lights in green Connection established at 100 Mbps

Off Connection established at 10 Mbps

LED
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1.3.3 Server (Internal)

a Power supply unit 
b Memory slot

Contains memory.
c 5-inch storage bay

Contains a 5-inch internal optional device. 
Unlike external devices, an internal option does not need to be connected to the outlet because its 
power is supplied from the server. It also saves space.

d 3.5-inch storage bay
Contains a 3.5-inch internal optional device.

e Expansion Card Slot 
Contains extension cards that enhance the server functions. 
PCI cards with the PCI bus interface can be installed in the Expansion Card slots. 

f CPU

a b

c

d

e

f

FrontRear
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1.3.4 Baseboard

a Parallel port connector
A parallel port cable is plugged in when using a parallel port option.

b CPU socket
Installs the CPU.

c Memory slot
Contains memory. If more memory is added, the amount of the data that can be read at a time 
increases and the processing performance of the server improves.

d Front Panel connector
A front panel cable is plugged in.

e Floppy connector
A floppy disk drive cable is plugged in. 

f Power connector
g IDE connector

An IDE cable for the internal CD-ROM drive unit or the internal DVD-RAM drive unit is 
plugged in. 

ba c

d

e

f

g

no m l

i

h

j

k
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h USB connector
i ATX 12V Power connector
j SATA connector

This is not used for this server.

k SAS connector
A SAS cable for the internal hard disk is plugged in. Although there are two SAS connectors, use 
upper connector only.

l Internal battery
Settings for the clock function of this server and for BIOS are saved.

m PCI Slots
Contains an expansion card. PCI slots (1 to 5) are numbered from bottom to top in the above 
figure. 

n Jumper
For details about jumper settings, refer to "8.1 Jumper Settings" ( pg.212). 

o Serial connector
A serial port cable is plugged in when installing a serial port.
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1.4 Standard Operations 

This section explains such standard operations as turning the server on/off and 
inserting/ejecting CD-ROMs.

1.4.1 Sliding the Drive Cover

1 Turn the drive cover key counterclockwise to unlock the cover.

2 Slide the drive cover. 
Slide the drive cover down to use the floppy disk drive, CD-ROM drive, or a 5-inch internal 
option device.

Drive cover key

Drive cover
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The driver cover key is unique to each device. Do not lose the key. 
If the key is lost, the lock must be broken and replaced on a paid basis. Manage the drive cover key 
very carefully. 
Contact an office listed in the "Contact Information" of "Start Guide" if you lose it.

1.4.2 Opening the Rack Door 

This section explains how to open the front and rear doors of the 40U standard rack.
Refer to the manual included with the rack for procedures on opening other rack doors. 

Opening the Front Door

1 Turn the rack key and pull the rack handle up.
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2 Turn the handle in the direction of the arrow and pull it forward.

Opening the Rear Door

1 Turn the rack key and pull the rack handle up.

Turn and then pull
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2 Turn the handle in the direction of the arrow and pull it forward.

Unless you are inserting/removing media or turning the power on/off, keep the door closed. Keeping 
the door closed blocks electric waves from cell phones, etc. 
Do not lose the keys. Contact an office listed in the "Contact Information" of "Start Guide" if you do lose 
them. 

1.4.3 Turning On the Server 

• Do not move, strike, or shake the server when it is turned on. This can damage 
the hard disk in the server and cause data loss. 

• Turn the server on when the temperature is in its operating environment range 
(10-35°C). For details about the operating environment, refer to "Start Guide" 
and "Safety Precautions". 
When operating the device outside of this operating environment, the server
may operate improperly, damage data etc. 
Furthermore, Fujitsu cannot be held responsible for any related damage, malfunction,
or loss of data, etc. 

• The fans rotate at high speed immediately after the server is turned on, but this 
is not defective. When the temperature is in the server's operating environment 
range (10-35°C), they start to rotate at normal speed later. 

• Be sure to wait for 10 seconds or more after shutdown before turning the 
server on. 

Turn and then pull
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1 Slide the drive cover.
"1.4.1 Sliding the Drive Cover" (pg.30)

2 Make sure that the floppy disk drive and CD-ROM drives are empty. 

3 Turn on the display and peripheral devices. 

4 Press the power switch on the front of the server. 
The server's power LED is lit green. 
When the power is turned on, the server performs Power On Self Tests (POST). If any 
abnormalities are detected by POST, error messages are displayed ("9.2.2 Error Messages" 
( pg.239)). 

The time to turn the server off can be set with the ASR setting (on the [Power On/Off] tab) using 
ServerView. For details, refer to "3.4 Serious Error Handling (ASR)" in "ServerView User’s Guide."
If you press the [F12] key right after the POST memory amount check, the Boot Menu is displayed, 

where you can change the boot disk ("  How to Start the BIOS Setup Utility" ( pg.213)).

1.4.4 Turning Off the Server 

1 Slide the drive cover.
"1.4.1 Sliding the Drive Cover" (pg.30)

2 Make sure that the floppy disk drive and CD-ROM drives are empty. 

• In the event of smoke or sparks, immediately unplug the electric cord. 
Failure to do so could lead to a fire or electrocution.

• Follow the procedures below to turn off the server. Data can be lost if 
these procedures are not followed correctly. 

The server’s power 
LED is lit green
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3 Shut down the OS.
In the following cases, the server is turned off after the OS is shut down (Step 4 is not necessary).
• Windows OS
• ServerView is installed
In other cases, make sure that the access LEDs of floppy disk and hard disk are off when the OS 
is shut down.

4 Press the power switch on the front of the server. 
The server's power LED is lit amber.

5 Turn off the display and peripheral devices. 

The time to turn the server off can be set with the ASR setting (on the [Power On/Off] tab) using 
ServerView. For details, refer to "3.4 Serious Error Handling (ASR)" in "ServerView User’s Guide."

Cautions when Turning the Power Off (When the OS is Windows 
Server 2003 or Windows 2000 Server)

• For Windows Server 2003
"Do Nothing", "Prompt Input", "Standby", "Hibernation", or "Shutdown" can be specified as the 
operating mode of the power switch in the OS settings (normally, "Shutdown" is specified).

• For Windows 2000 Server
"Standby", "Hibernation", or "Power Off" can be specified as the operating mode of the power switch 
in the OS settings (normally, "Power Off" is specified).

On this server, functions corresponding to "Standby" and "Hibernation" are supported as BIOS and 
hardware functions. However, some drivers and software installed in the server do not support these 
functions. For this reason, functions corresponding to "Standby status" and "Hibernation status" are 
unavailable on this server.
When the operating mode is set to "Standby" or "Hibernation", the system may operate improperly or
hard disk data may be corrupted. For details about operating mode settings, refer to the OS manual. 

• Be sure to wait for 10 seconds or more after shutdown before turning the 
server on. 

The servers power 
LED is lit amber
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1.4.5 Inserting and Ejecting a Floppy Disk 

Cautions
When using floppy disks, note the following points to avoid failures:
• Do not expose the disk to any fluids. 
• Do not open the shutter of the floppy disk and touch the disk surface. 
• Do not bend the floppy disk or place heavy objects on it. 
• Do not expose the floppy disk to strong magnetic fields. 
• Do not drop the floppy disk on hard surfaces. 
• Do not store the disk in extremely hot or cold conditions. 
• Do not store the disk in humid or dusty conditions. 
• Do not put layers of labels on the floppy disk. Doing so may cause the drive to be clogged with the 

disk. 
• Keep the disk away from condensation or water droplets. 

Inserting the Floppy Disk 

Use a floppy disk formatted in DOS/Windows. Operations are not guaranteed when you use other 
floppy disks.

1 Insert the floppy facing the label up into the floppy disk drive at the side with a 
shutter.
It makes a clicking sound and the floppy disk eject button pops out. 

Floppy disk eject button

Shutter

Label
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Ejecting the Floppy Disk 

1 Make sure that the floppy disk access LED is off. 

Do not eject the floppy disk while the floppy disk access LED is on. Doing so may damage
data. 

2 Press the floppy disk eject button.
The floppy disk comes out.

Floppy disk access LED
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1.4.6 Inserting and Ejecting a CD-ROM (DVD-RAM)

This section explains how to insert and eject a CD-ROM and DVD-RAM. Unless otherwise noted, CD-
ROM includes DVD-RAM.
When using CD-ROMs, note the following points to avoid failures.

Cautions for Handling CD-ROMs

• Do not put labels, or apply ink or pencil, to both sides of the CD-ROM. 
• Do not touch or scratch the data side of the CD-ROM. 
• Do not bend the CD-ROM or place heavy objects on it. 
• When cleaning the CD-ROM, use a slightly wet cloth to wipe it from the center to the edge, and then 

wipe it with a dry cloth. 
• Do not expose the disk to any fluids. 
• Do not store the disk in extremely hot or cold conditions. 
• Do not store the disk in humid or dusty conditions. 

Cautions for Handling Drives

• Do not use CD-ROMs that do not follow the notes described in "  Cautions for Handling CD-
ROMs" ( pg.38), or distorted, broken, or cracked CD-ROMs. Doing so may cause failures. If these 
CD-ROMs are used and the drive fails, the warranty will be invalidated. 

• This server supports only circular CD-ROMs. Do not use noncircular CD-ROMs. Doing so may 
cause failures. If noncircular CD-ROMs are used and the drive fails, the warranty will be invalidated. 

• If commercially available CD-ROM cleaning disks are used, dust may get on the lens. Do not use 
CD-ROM cleaning disks. 

• Some copy control music CDs cannot be used. 
• This server supports CD-ROMs with the following logo. Do not use CD-ROMs without the logo. 

Doing so may cause failures.

For information about DVD-RAM drive, refer to the manual which comes with the internal DVD-RAM 
unit.
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Inserting the CD-ROM

1 Make sure the server is turned on and press the CD-ROM eject button.
The CD-ROM tray comes out a little.

2 Place the CD-ROM (label side up) onto the tray. 

3 Press the CD-ROM eject button.
The tray is inserted into the server and CD-ROM is set.

When CD-ROM is set, the CD-ROM access LED is lit. To do next operation, confirm that the
LED is off. 

Ejecting the CD-ROM 
To eject the CD-ROM, confirm that the CD-ROM access LED is off and then press the CD-ROM eject 
button. 

CD-ROM eject button

CD-ROM tray
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1.5 Workflow

To start the server operation, perform the following procedures. 

Installing the server

Refer to "Safety Precautions" and "Start Guide"  to install the server to a suitable place.

Preparing the server

- Install hardware options

- Set hardware

Refer to "2.1 Preparation on the server", "Chapter 7 Installing Internal Options" and 

"Chapter 8 Configuring Hardware and Utilities".

Selecting the  installation method

Refer to "2.2 Selecting the Installation Method" to decide what installation method to use.

ServerStart, a software that enables everything from OS installation/setup to the installation of high 

reliability tools to be performed in one operation, comes with this server. It is recommended that  

ServerStart is used to perform installation.

Checking precautions on installation

Before installing the OS check the precautions on installation by referring to "2.3 Precautions on Installation". 

Procedures before operation

Before operating the server, refer to "Chapter 5 Operations after OS installation". 

High reliability tools installation

Start operations

Installing internal options

Refer to "Chapter 7 Installing Internal Options" to install the internal options.

Using ServerStart

Refer to "Chapter 3 OS Installation Using 
ServerStart" to perform OS installation.

Manual installation

Refer to "Chapter 4 Manual OS 

Installation" to perform OS installation.

OS installation

When the OS is installed manually, it is necessary to install high reliability tools. ServerView requires 

settings before server operation. For installation method and details about each high reliability tool, refer 

to “Chapter 6 High Reliability Tools”.



41

Chapter 2

Checking before OS
Installation

This chapter explains the preparation on the 
server and cautions necessary before OS 
installation. Please read this chapter before 
starting installation. 

2.1 Preparation on the Server  . . . . . . . . . . . . . . . . . . . . . . . . 42
2.2 Selecting the Installation Method . . . . . . . . . . . . . . . . . . . 45
2.3 Precautions on Installation . . . . . . . . . . . . . . . . . . . . . . . . 47
2.4 Preparation for Using ServerStart on a Client Computer . . 52
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2.1 Preparation on the Server

Before starting installation, install internal options to the server and perform 
necessary hardware settings.

2.1.1 Installing Internal Options

Internal options are classified into those that must be installed before the OS installation and those that 
must be installed after the OS installation.
For installation procedures, refer to "Chapter 7 Installing Hardware Options" ( pg.177).

Options That Must be Installed before the OS Installation

• Memory modules
• Expansion cards

Options That Must be Installed after the OS Installation

• Optional SCSI devices
• Internal hard disk units where the OS is not installed 

If an internal option device that must be installed after the OS installation has been already installed, 
remove the device, install the OS, and then reinstall the device.

Installing Optional External Devices
When installing external hard disk drives and/or USB devices, turn off their power or unplug their 
connection cables from the server during the OS installation. Connect them after the OS installation.

Cautions for Installing an Expansion Card
When using an expansion card, read the notes on the expansion card.
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Cautions for Installing a Memory Module
This server supports up to 8GB of memory. However, the maximum installable size varies depending on 
the OS. Furthermore, since the server uses part of the memory as PCI resources, the maximum available 
size is limited. 
The following shows the maximum installable size and the maximum available size.

*1:0.5GB is used as PCI resources.
For Windows Server 2003, Standard Edition, available memory size can be same as the installed memory if 
Service Pack 1 is applied to and the following setting is configured using the BIOS Setup Utility.
1. Start the BIOS Setup Utility.
2. Select the [Advanced System Configuration] submenu from the [Advanced] menu.
3. Set [NX Memory Protection] to [Enabled].

LAN Cable
Be sure to connect the LAN cable when the server is not connected to the Internet.

Connecting to the Internet during setup can cause security problems. Do not connect to the Internet 
until the setup completes.

If the OS is installed or applications are automatically installed without connecting the LAN cable to the 
LAN card, an error may be recorded in the event viewer after setup completes.

2.1.2 Hardware Settings

Before starting installation, set necessary hardware, such as the BIOS Setup Utility.

BIOS Setup Utility
The BIOS Setup Utility must be set in the following cases. For details on how to set the BIOS Setup 
Utility, refer to "8.2 BIOS Setup Utility" ( pg.213).

Changing the Boot Drive

To change the boot drive, start up the BIOS Setup Utility, select [Boot Option], and set the boot drive. 
"8.2.4 Boot Options Submenu" (pg.218)

Performing Remote Installation

Before performing remote installation of ServerStart, use the following procedures to enable network 
startup (PXE). In addition, check the MAC address.

table: Maximum Installable Size and Maximum Available Size

OS Installed memory 
size Available memory size

Windows 2000 Server
Windows Server 2003 / R2
SBS 2003

3.5GB or smaller Same as the installed memory size

4.0GB or larger Installed memory size - (0.5GB) *1

Windows Server 2003 x64 / R2 x64 Installed memory size Same as the installed memory size
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1 Take the following steps in the BIOS Setup Utility.
1. Start the BIOS Setup Utility.

"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.213)
2. Select the [Peripheral Configuration] submenu from the [Advanced] menu and 

press the [Enter] key.
3. Set [LAN Remote Boot] to [PXE]. 
4. Select [Save Changes & Exit] from the [Exit] menu and exit BIOS Setup Utility.
5. Start the BIOS Setup Utility again.
6. Select the [Boot Option] submenu from the [Main] menu and press the [Enter] key.

The Boot Option submenu window appears. 
7. Change the [Boot Sequence] settings as shown below.

8. Exit the BIOS Setup Utility and turn off the server.

2 Check the MAC address.
Start up the server from the network.
The MAC address is displayed as shown below.

The MAC address is required for remote installation. Write it down.

You can turn the power on from a client (via a LAN) by utilizing the Wakeup On LAN (WOL) function. 
Refer to "5.5.5 Turning the Power On via a LAN" ( pg.159).

Be sure to install ServerView to control the power supply via a LAN.
Unless ServerView is installed, the server is not turned off automatically after shutting down the OS.

1 BootManage PXE, Slot 0A00
2 CD-ROM
3 Diskette
4 Hard Drive

CLIENT MAC ADDR: XX XX XX XX XX XX
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2.2 Selecting the Installation Method

When installing the OS for the first time, there are multiple installation methods. Refer 
to the following to decide on the method.

To set up multiple servers with the same model and configuration, refer to "3.5 Installation on Multiple 
(the Second and Subsequent) Servers" ( pg.107).

Installation Using ServerStart
When an OS is installed using ServerStart, the driver for the expansion card that is automatically 
recognized will be installed automatically. In addition, high reliability tools and array controller 
administrative tools are installed automatically. Installation using ServerStart is recommended because 
it helps install the OS without mistakes.
For features of ServerStart, refer to "1.2.1 Setup Support Tool - ServerStart" ( pg.16).

Installation While Maintaining the Established RAID Environment
In guided mode or preparation mode, select [Logical Drive View] at [Raid and Disk Configuration 
Wizard] (in the [Configuration for Disks and RAID Controllers] window) and install the OS.

Installation Using ServerStart While Maintaining the Existing 
Partitions

In expert mode of ServerStart, start up Disk Manager, format the installation partition, and install the 
OS.

Refer to "3.1 Guided Mode" and perform installation.

* If you follow the wizard, setup will be performed 

correctly.

Linux

Windows Server 2003 x64

Windows Server 2003 R2 

Installation is performed manually. 

Refer to "4.2 Starting Manual Installation" and

perform installation.

When setting setup information in advance on 

the client computer, refer to "3.2 Preparation  

Mode" and perform installation.

What OS will you use?

Will you use ServerStart?

No

Yes

For the use of Linux, refer to the Fujitsu PRIMERGY
website (http://primergy.fujitsu.com).

Windows Server 2003

Windows 2000 Server 

Windows Server 2003 R2 x64
SBS 2003
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To Configure the RAID 0+1 and Install the OS

The RAID 0+1 cannot be configured using ServerStart [RAID and Disk Wizard]. To configure the 
RAID 0+1 and install the OS, configure the RAID manually in advance and select [Logical Drive View] 
in guided mode or preparation mode.
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2.3 Precautions on Installation

Read the following notes before starting OS installation.

2.3.1 Installation Partition Size

For installation using ServerStart, the installation partition size can be set as follows, depending on the 
OS to be installed and format.

Notes

• When you want to set the OS and BOOT partitions in different partitions, specify the partition size 
directly.
(The BOOT partition is the partition for startup. Minimum information required for startup, such as 
"ntldr", is stored.
The OS partition is the partition for installing the OS.)

• In either of the following cases, specify a partition size less than 2TB.
• When the same partition is specified as the OS and BOOT partitions
• When different partitions are specified as the OS and BOOT partitions

• The OS cannot be installed in a partition larger than 2TB.
• For SBS 2003, ServerStart cannot be used to install the OS.

2.3.2 Notes on Configuring RAID 

RAID can be configured with hard disk units connected to the SAS controller on the baseboard.
Available RAID levels are different between the array configuration with the onboard array controller 
and the array configuration with the SAS array controller card.
Check the following notes before configuring the RAID.

Array Configuration with the Onboard Array Controller

Hardware Configuration

• Only internal hard disk units can be used. Although four internal hard disk units can be installed on 
this server, up to two hard disk units can be used when configuring RAID with the onboard array 
controller. 

• Be sure to use hard disk units of the same model and with the same capacity.

table: Installation Partition Size

 Available size Windows Server 2003
Windows Server 2003 x64 Windows 2000 Server

Minimum 2200MB 2048MB

Maximum 2TB 2TB
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Array Configuration

Only RAID 1 level can be configured. The array is configured for two internal hard disks on the server. 
For details, refer to "Integrated Mirroring SAS User’s Guide" in the Array Controller Document & Tool 
CD.

Array Configuration with the SAS Array Controller Card

Hardware Configuration

• Be sure to install the SAS array controller card (PG-140F). 
• Only internal hard disk units can be used. Up to four internal hard disk units can be installed on this 

server. 
• Be sure to use hard disk units of the same model and with the same capacity.
• The hot spare (standby disk) can be configured. For details and notes on the hot spare disk, refer to 

"MegaRAID SAS User’s Guide" in the Array Controller Document & Tool CD.

Array Configuration

The following RAID levels can be configured. The number of units that can be set varies according to 
the RAID level. For details, refer to the manual in the Document & Tool CD supplied with the SAS 
array controller card.

Notes

• When a RAID-configured disk is used
Hard disk units that have been used before may have unwanted partition information or array 
configuration information, which may cause unexpected problems. If you connect any hard disk units 
with usage history to this server, format them at low level on another system before connecting them 
to the server. For information on how to format the hard disk units, refer to the manual supplied with 
the system to be used.

• Number of disk units
If the number of actually installed units is smaller than the setting for the number of units (+1 when a 
hot spare is specified), installation using ServerStart is aborted because of an error.
When the number of installed disk units is greater than the setting, the disk units are set up according 
to the setting. Extra units will be configured as standby disk units. 
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2.3.3 Notes on a Multiple LAN Adapter Configuration

Using the OS installation wizard of ServerStart, you can configure multiple LAN adapters (network 
adapters) on the system. However, there are the following limitations.

Adapter Numbers

To configure multiple LAN cards, select the adapter numbers in order of Adapter 1 and Adapter 2, and 
enter settings for each adapter. Note that the order of adapter numbers is not necessarily the same as the 
order of slots for the installed LAN adapters. This means that the setting for Adapter 1 is not always 
applied to the onboard LAN. After installing the OS, check the LAN adapters to make sure that they are 
configured as intended.

2.3.4 Cautions for Using ServerStart

Operating ServerStart
Most ServerStart operations are performed with the mouse. Items may not be moved with the [Tab] key 
or cursor keys. Be sure to use the mouse when operating ServerStart.

Ejecting the CD-ROM
Do not eject the ServerStart CD-ROM while ServerStart is running. If the ServerStart CD-ROM is 
ejected and inserted again, ServerStart starts up in multiple windows, and settings you have made can be 
lost.

ServerStart CD-ROM
ServerStart supplied with this server contains Disc 1 and Disc 2. Disc 1 creates a configuration file and 
installs the OS. When required, insert Disc 2 during the installation.

Switching the Mode
When opening the configuration file and inputting information in the installation fields in the wizard, do 
not switch any other mode by manipulating the tree or by any other means (e.g. do not start up the 
Windows 2000 Server guided mode during Windows Server 2003 guided mode operation).
Before switching the mode while inputting information, you must save the configuration file. If you do 
not save the configuration file, clicking [Cancel] will delete any changes that have been made.

Installing Windows 2000 Server
To install Windows 2000 Server, you have to use Service Pack 4 integrated OS media or select 
"Windows 2000 Server Service Pack 4" at the "Application Wizard" menu.

Exiting ServerStart
After operation in guided or expert mode, exiting ServerStart restarts the system. Remove disks from the 
floppy disk and CD-ROM drives and click [OK]. When the display on the screen disappears, turn off the 
system.
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License for Use of System for ServerStart
"License for Use of System for ServerStart" linked from the ServerStart startup window is a license for 
use of Windows PE contained in the ServerStart CD-ROM. Windows PE for starting up ServerStart can 
be only used for installing Windows Server 2003 or Windows 2000 Server provided under a separate 
legal license.

Setting Up the Printer
ServerStart does not support setup of printers. Perform installation after setup is completed.

2.3.5 Expansion Cards Supported by ServerStart

ServerStart supports automatic driver installation for the following expansion cards.

2.3.6 Cautions for Manual Installation

Notes on Using an Array Controller Card 
Before the OS is installed, the array controller card must be configured and the system drive under the  
array controller card must be initialized. To check the array controller card settings, start up WebBIOS. 
For more details, refer to the manual which comes with the array controller card.

Installing Windows 2000 Server
To install Windows 2000 Server directly, you have to use Service pack 4 integrated OS media or install 
Service Pack 4 or newer Service Pack. 
And please install hotfix module named KB904374 after OS installation. 
Please find out hotfix module of your language version from the following folder on ServerStart CD. 
[CD-ROM drive]: \HOTFIX\W2K\

Free Space Required for Installation
The partition where the OS is installed must have enough free space for obtaining memory dump. For 
more details, refer to"5.1 Memory Dump/Paging File Setting" ( pg.136).

table: Automatic Expansion Card Driver Installation
Name Model Bus

Onboard FDD/IDE - -

Onboard LAN - PCI-E

Onboard VGA - PCI

SAS array controller card PG-140F PCI

LAN Card PG-1892 PCI

PG-2861 PCI-E

SCSI card PG-1281 PCI
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Cautions on Restarting
In the course of installation, a message appears to indicate that the setup program restarts. Wait until it 
restarts automatically. 
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2.4 Preparation for Using ServerStart 
on a Client Computer

When using the preparation mode for setting installation information in advance or 
when creating a driver disk using the FloppyBuilder function, install ServerStart on 
the client computer.

System Requirements for Client Computers
Client computers must satisfy the following requirements.

Using ServerStart on the server

ServerStart can be installed to the server where Windows 2000 Server or Windows Server 2003 is 
installed. Perform the procedure in "2.4.1 Installing ServerStart" ( pg.52) to install ServerStart.
Note that ServerStart cannot be installed to the server where Windows Server 2003 x64 is installed.

2.4.1 Installing ServerStart

If a different version of ServerStart has been installed, uninstall it. The FloppyBuilder function or 
installation wizard may not operate properly on a different version.
For details on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" ( pg.54).

Hardware Personal computers operated with Windows XP Professional, or Windows 2000 
Professional
(A CD-ROM drive and 10MB or more of free space are required.)

Software Microsoft® Internet Explorer 5.5 or later
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1 Insert the ServerStart CD-ROM Disc 1 into the client computer.
The [ServerStart Launcher] window appears. When the [ServerStart Launcher] window does not 
appear, execute "SeStSetup.exe" in the CD-ROM.

2 Check an only [Classic] and click [OK].
The Setup window appears.

3 Click [Next].
The [License Agreement] window appears.

4 Select [I accept the license agreement] and click [Next].
The [User Information] window appears.

5 Enter the user information of the software and click [Next].
The [Destination Folder] window appears.
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6 Specify the installation folder and click [Next]. To change the installation folder, 
click [Browse] and select the folder.
The [Ready to Install the Application] window appears.

7 Click [Next].
Installation is executed.

If a message prompts you to restart the system before or after installation, eject the CD-ROM 
and restart the system according to the message. When the system restarts, insert the Server-
Start CD-ROM and start installation again.
If the "This program does not respond." message appears during restart operation, click [Exit] 
to continue the restart operation.

When the installation is completed, the completion window appears.

8 Click [Exit].
ServerStart has been installed to the client computer.

2.4.2 Uninstalling ServerStart

Perform the following procedure to uninstall ServerStart from the client computer.

1 Click [Start] → [Programs] → [Fujitsu Siemens ServerStart] → [Uninstall 
ServerStart].

2 Click [OK].
When the uninstallation is executed successfully, Fujitsu ServerStart is deleted.
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2.4.3 Creating the ServerStart Floppy Disk 

When using a floppy disk (new disk) other than the ServerStart floppy disk in guided mode, create the 
ServerStart floppy disk in advance. If you use the floppy disk supplied with ServerStart, creating the 
ServerStart floppy disk is not required since the disk is already ServerStart floppy disk.

1 Start up ServerStart.
If ServerStart has already been started, it is not necessary to start it up again. If it has not, start it 
up according to the following procedures:

1. Click [Start] → [Programs] → [Fujitsu Siemens ServerStart] → [ServerStart(Start 
from CD)].
ServerStart starts up and the [Welcome to ServerStart] window appears.

2 Click [FloppyBuilder].
The [ServerStart FloppyBuilder] window appears.
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3 Click [ServerStart Status Diskette].
A message prompts you to insert the floppy disk.

4 Insert the floppy disk and click [OK].

Set the floppy disk in the write-enabled state.

Creation of a ServerStart floppy disk starts. When the creation is completed, the message "Floppy 
disk has been created." appears.

5 Click [OK].
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This chapter explains how to install the OS in the 
server using ServerStart.

3.1 Guided Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
3.2 Preparation Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
3.3 Expert Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
3.4 Remote Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
3.5 Installation on Multiple (the Second and Subsequent) Servers 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
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3.1 Guided Mode

In guided mode, follow the wizard to specify hardware configuration and the OS to be 
installed, save the information necessary for installation in a configuration file, and 
install the OS.

3.1.1 Starting Up the Guided Mode

Start up the guided mode.

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk supplied with the server. Make sure that 
"Removable media" and "A:" are selected and click [Create].

Set the ServerStart floppy disk in the write-enabled state.
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The network setting window for remote installation appears.

3 Click [OK].
The [Initialization of ServerStart core running] window appears and the ServerStart initialization 
process starts. Depending on the hardware configuration, this process may take a few minutes.
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When the process is completed, the [Create a ServerStart Floppy Disk] window appears.

4 Click [Build a ServerStart Floppy Disk].
Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy disk has 
been created" message appears.

5 Click [OK].
"Please Select your keyboard" Window appears.

6 Select your keyboard language from the drop-down list and click [OK].
The subsequent start procedure may take several minutes. The [Welcome to ServerStart] window 
appears.

7 Click [Click here to prepare and/or initiate an operating system installation].
The [Select the operating system to be installed] window appears.
Click [Special Hints on Operating System Installation] and read the contents. Important 
information such as limitations on disk configuration is described.

8 Click [MS Windows Operating Systems].
The [Microsoft Windows Operating System Installation] window appears.

9 Click the OS to install.
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10 Click [Prepare & initiate an unattended installation of (OS)].
The guided mode for the selected OS starts up.

Start up the wizards to set items in the following procedures.
Exiting the wizard returns the display to the guided mode window.

Make sure to open the menu of each wizard and confirm the settings.
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3.1.2 Opening/Creating a Configuration File

Open a configuration file. Or create a new one.

1 Click [Start here to create a complete configuration file].
The [Open ServerStart Configuration File] window appears.

Once a configuration file is opened, another file cannot be opened until you click [Close and
save Configuration File].

2 Select the configuration file and click [Create].
The [RAID and Disk Wizard] starts up automatically ( "3.1.3 RAID and Disk Wizard" (pg.63)).
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3.1.3 RAID and Disk Wizard

Configure RAID, and create and format hard disk partitions.

1 Click [RAID and Disk Wizard: RAID configuration and hard disk partitioning / 
formatting].
The [Configuration for Disks and RAID Controllers] window appears. 

Only array controllers already installed are displayed.

2 Select the method of RAID configuration.
To install the OS while maintaining the established RAID environment

Select [Logical Drive View], and add partitions as necessary. For more details, refer to "  
Installation While Maintaining the Established RAID Environment" ( pg.64).

To configure RAID
Select [Mass Storage Controller View], and add controllers as necessary. For more details, refer 
to "  Configuring RAID" ( pg.65).

The RAID 0+1 cannot be configured using ServerStart. To configure the RAID 0+1, configure
the RAID manually in advance and select [Logical Drive View] on the [Configuration for Disks
and RAID Controllers] window.

3 Set items and click [leave wizard].
The RAID and Disk wizard closes.
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Installation While Maintaining the Established RAID Environment

1 Select [Logical Drive View] on the [Configuration for Disks and RAID 
Controllers] window.

Add a partition
1. Click [Add Partition].

A partition is added.
Add required partitions.

2. Click [Details] and modify the settings as necessary.
The partition configuration is displayed. As the default values are configured, confirm the 
settings and modify them as necessary.

Partition size of the FAT file system
When "FAT" is selected in [File system] and a value equal to or more than 4090MB or "Auto-
matic setting" is specified in [Partition size], the size of created partitions will be 4090MB.
The following limits apply to the volume label length. A volume label longer than the limit may
be used. However, it can cause installation failure. Enter a volume label within the limit.
•FAT: Up to 11 characters
•NTFS: Up to 32 characters
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Configuring RAID

1 Select [Mass Storage Controller View] on the [Configuration for Disks and RAID 
Controllers] window.
Add partitions as necessary.

One hot spare (standby disk) can be configured. When the hot spare disk is set to "Yes", set
the number of disk units to the number of installed disk units minus 1. 
 E.g.: When four hard disk units are installed, set the [RAID Level] to "RAID 5", and when the
[Hotspare] is set to "Yes", set the [Number of Disks] to "3".
Set the [Number of Disks] to "0" when configuring the RAID with all installed hard disk units.

Add a partition
1. Click [Add Partition].

A partition is added.
Add required partitions.
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2. Click [Details] and modify the settings as necessary.
The partition configuration is displayed. As the default values are configured, confirm the 
settings and modify them as necessary.

3.1.4 OS Installation Wizard

Set computer information, user information, and the network protocol. 
ServerStart can configure multiple network patterns. When configuring a domain controller, refer to 
"Using ServerStart to Configure the Network".

The setup window differs depending on the OS to be installed. The following describes operations on 
Windows Server 2003 R2.
To install another OS, interpret Windows Server 2003 R2 as your OS.

1 Click [Operating System Wizard: Operating system parameters].
The [Windows Installation] window appears.

2 Enter the password in [Password for Administrator account] and [Please repeat 
Password] and click [Next].
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If the password differs between [Password for Administrator account] and [Please repeat
Password], an error dialog window appears. Enter the password correctly.

The [Computer Identification] window appears.

3 Set items and click [Next].

When using the CD-ROM applied Service Pack 1 on Windows Server 2003, select the [(OS)
including SP1] menu from the [Operating System Type] list.

The [Installation Directory and Time Zone] window appears.
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4 Set items and click [Next].
The [User Name] window appears.

5 Set items and click [Next].
The [Display Settings] window appears.

6 Set items and click [Next].
The [Network Protocol] window appears.
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7 Set items and click [Next].
The [Software Components] window appears.
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If Windows Server 2003 R2 is selected at the Computer Identification, R2 components are
always copied to the hard disk. To install the components, click [Properties] and check the
components to be installed.

8 Set items and click [Next].
The [Services] window appears.

SNMP Service is always installed. Click [Properties] to change the settings, if needed. 

9 Set items and click [leave wizard].
The OS installation wizard closes.
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3.1.5 Application Wizard

Specify installation of supplied applications such as high reliability tools.

1 Click [Application Wizard: Select additional software components].
The application wizard appears.

2 From the [Installable applications] list, select applications to be installed and 
click [>>].
Set all applications to be installed on the [Selected applications] list.

The following applications are always installed in guided mode. In expert mode, the selection
can be released.
•Broadcom Advanced Control Suite
•RAID Management Tool
•Fujitsu ServerView (for apache)
•Fujitsu ServerView (for IIS)

3 Click [leave wizard].
The application wizard closes.
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3.1.6 Closing/Saving the Configuration File

When settings in all wizards are completed, save the configuration file.

1 Click [Close and save Configuration File].
The [Save ServerStart Configuration File] window appears.

2 Click [Save As].
The configuration file is saved.

You can specify any name for the configuration file. However, OS installation is possible only
when it is saved as "SerStartBatch.ini". When installing the OS, make sure to save it as "Ser-
StartBatch.ini" on the ServerStart floppy disk.

3.1.7 Starting OS Installation

Install the OS to the server. 
During installation, do not use the mouse or keyboard unless it is necessary for installation operations. 
Otherwise, installation may fail.

1 Click [Click here, to Start the Installation of (OS)].
The [ServerStart Unattended Mode] window appears.
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2 Click [Start now].

Clicking [Start now] deletes all disk contents and starts installation. Click [Stop] when you do
not perform installation.

After 10 seconds, installation starts automatically.
1. When RAID has been configured, the system restarts.
2. If a message prompts you to insert the Array Controller Document & Tool CD, 

insert the CD-ROM and click [OK].
3. If a message prompts you to insert the ServerView CD-ROM, insert the 

PRIMERGY Document & Tool CD and click [OK].
4. If a message prompts you to insert the Service Pack CD-ROM, insert the CD-ROM 

and click [OK]. 
5. For Windows Server 2003 x64, a message prompts you to insert the ServerStart 

Disc 2 and restart the system. Insert the ServerStart Disc 2 and restart the system.

3 When a message prompts you to insert the OS CD-ROM, insert the CD-ROM 
and click [OK].

For Windows 2000 / Windows Server 2003 / Windows Server 2003 x64
1. Insert the OS CD-ROM (Installation CD-ROM).

The License Agreement window appears.
2. Click [I agree].

After files are copied, a message prompts you to eject the CD-ROM and floppy disk.
For Windows Server 2003 R2 / Windows Server 2003 R2 x64

1. Insert the OS CD-ROM (Installation CD-ROM) Disc 1. 
The License Agreement window appears.

2. Click [I agree].
Files are copied.

3. If a message prompts you to insert the Disc 2, eject the Disc 1 and insert the OS 
CD-ROM (Installation CD-ROM) Disc 2.
After files are copied, a message prompts you to eject the CD-ROM and floppy disk.

4 Eject the CD-ROM and floppy disk and click [OK].
Then the system is restarted.
The system continues the installation operation after restart. 
OS GUI setup, LAN utility installation, Service Pack installation, and Active Directory 
installation are performed automatically.

5 When a confirmation message to restart appears, click [Restart].
The system restarts and installs high reliability tools.

6 When a message on installation completion appears, press any key.

7 Restart the system.
Click [Start] → [Shutdown]. Select [Restart] and click [OK].
The system restarts.
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8 When the system restarts, log on to the server using the Administrator account 
for the local computer.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform necessary procedures 
before starting server operations.
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3.2 Preparation Mode

In preparation mode, set and save the information necessary for installation in a 
configuration file on a client computer (with a CD-ROM drive and 10MB or more of 
free space). Set the saved configuration file on the server for installation.

If ServerStart is not installed in the client computer where the preparation mode is executed, refer to 
"2.4 Preparation for Using ServerStart on a Client Computer" ( pg.52) to install ServerStart. If a 
different version of ServerStart has been installed, uninstall it and install the proper version. For details 
on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" ( pg.54).
Prepare the ServerStart floppy disk. When using a formatted new disk, create the ServerStart floppy 
disk in advance, referring to "2.4.3 Creating the ServerStart Floppy Disk" ( pg.55).

3.2.1 Starting Up the Preparation Mode

Start up the preparation mode.

1 Start up ServerStart.
If ServerStart has already been started, it is not necessary to start it up again. If it has not, start it 
up according to the following procedures:

1. Click [Start] → [Programs] → [Fujitsu Siemens ServerStart] → [ServerStart(Start 
from CD)].
ServerStart starts up and the [Welcome to ServerStart] window appears.

2 Click [Click here to prepare an operating system installation for a PRIMERGY 
Server].
The [Prepare the installation of an operating system for PRIMERGY Server] window appears.
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Click [Special on Hints on Operating System Installation] and read this section carefully before
starting the installation. This section describes the important information such as restrictions of
the disk configurations.

3 Click [Creation of ServerStart Configuration file for the installation of an 
Microsoft Windows Operating System].
The [Microsoft Windows Operating System Installation] window appears.

4 Select [Create a configuration file for the installation of (OS)].
The [Preparing the Installation of MS Windows Server 2003] window appears.
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3.2.2 Configuring Settings in Wizards

Click the wizards to set items in the following procedures. For setting procedures, refer to description on 
guided mode wizards ("3.1.2 Opening/Creating a Configuration File" ( pg.62) to "3.1.5 Application 
Wizard" ( pg.71)). 
 Exiting a wizard returns the display to the preparation mode window.

Make sure to open the menu of each wizard and confirm the settings.

3.2.3 Closing/Saving the Configuration File

When settings in all wizards are completed, save the configuration file.

1 Click [Close and save Configuration File].
The [Save ServerStart Configuration File] window appears.
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2 Click [Save As].
The [ServerStart Session IP Settings] window appears.

3 Set items when performing remote installation.

4 Click [Set].
The configuration file is saved.

You can specify any name for the configuration file. However, OS installation is possible only when it is 
saved as "SerStartBatch.ini". When installing the OS, make sure to save it as "SerStartBatch.ini" on 
the ServerStart floppy disk.
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3.2.4 Starting OS Installation

Install the OS to the server using the created configuration file.
During installation, do not use the mouse or keyboard unless it is necessary for installation operations. 
Otherwise, installation may fail.

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately.
A message prompts you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk containing the created configuration file and 
click [OK].

Set the ServerStart floppy disk in the write-enabled state. If it is write protected, installation will
fail.

The [Initializing ServerStart] window appears and the ServerStart initialization process starts. 
Depending on the hardware configuration, this process may take a few minutes. When 
initialization is completed, the [ServerStart Unattended Mode] window appears.

3 Click [Start].
A message appears.

4 Click [OK].
Installation starts.

1. When RAID has been configured, the system restarts.
2. If a message prompts you to insert the Array Controller Document & Tool CD, 

insert the CD-ROM and click [OK].
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3. If a message prompts you to insert the ServerView CD-ROM, insert the 
PRIMERGY Document & Tool CD and click [OK]. 
This message does not appear when the PRIMERGY Document & Tool CD has been 
inserted already.

4. If a message prompts you to insert the Service Pack CD-ROM, insert the CD-ROM 
and click [OK]. 
This message does not appear when Service Pack is not selected.

5. If a message prompts you to insert the ServerStart CD-ROM, insert the ServerStart 
Disc 1 CD-ROM and click [OK].

5 When a message prompts you to insert the OS CD-ROM, insert the CD-ROM 
and click [OK].

For Windows 2000 / Windows Server 2003 / Windows Server 2003 x64
1. Insert the OS CD-ROM (Installation CD-ROM).

The License Agreement window appears.
2. Click [I agree].

After files are copied, a message prompts you to eject the CD-ROM and floppy disk.
For Windows Server 2003 R2 / Windows Server 2003 R2 x64

1. Insert the OS CD-ROM (Installation CD-ROM) Disc 1. 
The License Agreement window appears.

2. Click [I agree].
Files are copied.

3. If a message prompts you to insert the Disc 2, eject the Disc 1 and insert the OS 
CD-ROM (Installation CD-ROM) Disc 2.
After files are copied, a message prompts you to eject the CD-ROM and floppy disk.

6 Eject the CD-ROM and floppy disk and click [OK].
The system restarts. The system continues the installation operation after restart. OS GUI setup, 
LAN utility installation, Service Pack installation, and Active Directory installation are 
performed automatically.

7 When a confirmation message appears on restart, click [Restart].
The system restarts and installs high reliability tools.

8 When a message on installation completion appears, press any key.

9 Restart the system.
Click [Start] → [Shutdown]. Select [Restart] and click [OK]. The system restarts.

10 When the system restarts, log on to the server using the Administrator account 
for the local computer.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform necessary procedures 
before starting server operations.
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3.3 Expert Mode

In expert mode, start up Disk Manager, format the installation partition, and install the 
OS. 
Use the expert mode only when you want to perform installation while maintaining the 
existing partitions. Use the guided mode for normal installation.

3.3.1 Starting Up the Expert Mode

Start up the expert mode.

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk supplied with the server. Make sure that 
"Removable media" and "A:" are selected and click [Create].
The network setting window for remote installation appears.

Set the ServerStart floppy disk in the write-enabled state.

3 Click [OK].
The [Initialization of ServerStart core running] window appears and the ServerStart initialization 
process starts. Depending on the hardware configuration, this process may take a few minutes.
When the process is completed, the [Create a ServerStart Floppy Disk] window appears.

4 Click [Build a ServerStart Floppy Disk].
Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy disk has 
been created." message appears.

5 Click [OK].
"Please Select your keyboard" window appears.

6 Select your keyboard language from the drop-down list and click [OK].
The subsequent start procedure may take several minutes. The [Welcome to ServerStart] window 
appears.

7 Click [Click here to prepare and/or initiate an operating system installation].
The [Select the operating system to be installed] window appears. 
Click [Special Hints on Operating System Installation] and read the contents. Important 
information such as limitations on disk configuration is described.

8 Click [MS Windows Operating Systems].
The [Microsoft Windows Operating System Installation] window appears. 
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9 Select the OS to install.

10 Click [Install MS Windows Server 2003 interactively (expertise required)].
The expert mode starts.

Start up the configuration tools to set items in the following procedures. Exiting a tool returns to 
the display to the expert mode window.

Make sure to open the menu of each wizard and confirm the settings.

OS installation wizard

Application wizard

Starting OS installation

Disk manager
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3.3.2 Disk Manager

Start up Disk Manager and format the installation partition.

1 Click [Use Disk Manager to partition and format your disk drives].
Disk Manager starts up.

2 Format the OS installation partition. Select the OS installation partition and click 
the [Partition] menu → [Format].
The [Format Partition] window appears.

Be sure to specify the active partition on drive C.
Partitions equal to or larger than 4096MB cannot be FAT formatted.

3 Set items and click [Format].
The partition is formatted.

4 When the formatting is completed, click the [File] menu → [Exit].
Disk Manager closes and the display returns to the expert mode window.
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3.3.3 OS Installation Wizard

Set computer information, user information, and the network protocol.
ServerStart can configure multiple network patterns. When configuring a domain controller, refer to 
"Using ServerStart to Configure the Network".

The setting window differs depending on the OS to be installed. The following describes operations on 
Windows Server 2003 R2.
To install another OS, interpret Windows Server 2003 R2 as your OS.

1 Click [Installation Wizard for MS Windows Server 2003].
A message prompts you to specify the configuration file.

2 Click [No].
The [Windows Server 2003 Installation] window appears.

3 Enter the password in [Password for Administrator account] and [Please repeat 
Password] and click [Next].

If the password differs between [Password for Administrator account] and [Please repeat
Password], an error dialog window appears. Enter the password correctly.

The [Computer Identification] window appears.

4 Set items and click [Next].
The [Installation Directory and Time Zone] window appears.

When using the CD-ROM applied Service Pack 1 on Windows Server 2003, select the [(OS)
including SP1] menu from the [Operating System Type] list.

5 Set items and click [Next].
The [User Name] window appears.

6 Set items and click [Next].
The [Display Settings] window appears.

7 Set items and click [Next].
The [Network Protocol] window appears.
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8 Set items and click [Next].
The [Software Components] window appears.

If Windows Server 2003 R2 is selected at the Computer Identification, R2 components are
always copied to the hard disk. To install the components, click [Properties] and check the
components to be installed.

9 Set items and click [Next].
The [Services] window appears.

Simple Network Management Protocol is always installed. Click [Properties] to change the set-
tings.

10 Set items and click [leave wizard].
The display returns to the expert mode window.

3.3.4 Application Wizard

Specify installation of supplied applications such as high reliability tools.
For details on the application wizard, refer to "3.1.5 Application Wizard" ( pg.71).

3.3.5 Starting OS Installation

Install the OS to the server.

Notes on the Installation
When the installation partition is not empty, a confirmation message appears. If it does not matter, click 
[OK] to continue the installation procedure.
If an incorrect setting (such as the CD key) is found during installation, an error window will appear. 
Enter the correct value in the window to continue the installation procedure. However, corrections 
made here are not reflected to the configuration file.

1 Click [Click here, to Start the Installation of (OS)].
A confirmation window asking whether you want to save the current settings appears.
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2 Click [Yes].
The following window appears.

3 Enter the file name and click [Save As].
Installation starts automatically.

1. If a message prompts you to insert the Array Controller Document & Tool CD, 
insert the CD-ROM and click [OK].

2. If a message prompts you to insert the ServerView CD-ROM, insert the 
PRIMERGY Document & Tool CD and click [OK].

3. If a message prompts you to insert the Service Pack CD-ROM, insert the CD-ROM 
and click [OK]. 

4. For Windows Server 2003 x64, a message prompts you to insert the ServerStart 
Disc 2 and restart the system. Insert the ServerStart Disc 2 and restart the system.
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4 When a message prompts you to insert the OS CD-ROM, insert the CD-ROM 
and click [OK].

For Windows 2000 / Windows Server 2003 / Windows Server 2003 x64
1. Insert the OS CD-ROM (Installation CD-ROM).

The License Agreement window appears.
2. Click [I agree].

After files are copied, a message prompts you to eject the CD-ROM and floppy disk.
For Windows Server 2003 R2 / Windows Server 2003 R2 x64

1. Insert the OS CD-ROM (Installation CD-ROM) Disc 1. 
The License Agreement window appears.

2. Click [I agree].
Files are copied.

3. If a message prompts you to insert the Disc 2, eject the Disc 1 and insert the OS 
CD-ROM (Installation CD-ROM) Disc 2.
After files are copied, a message prompts you to eject the CD-ROM and floppy disk.

5 Eject the CD-ROM and floppy disk and click [OK].
Then the system is restarted.
The system continues the installation operation after restart. 
OS GUI setup, LAN utility installation, Service Pack installation, and Active Directory 
installation are performed automatically.

6 When a confirmation message to restart appears, click [Restart].
The system restarts and installs high reliability tools.

7 When a message on installation completion appears, press any key.

8 Restart the system.
Click [Start] → [Shutdown]. Select [Restart] and click [OK].
The system restarts.

9 When the system restarts, log on to the server using the Administrator account 
for the local computer.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform necessary procedures 
before starting server operations.
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3.4 Remote Installation

ServerStart supports remote installation.

Before performing remote installation, be sure to read "Cautions for Remote Installation" in the online 
help.

3.4.1 Overview of Remote Installation

Remote installation is a method to save resources necessary for installation, such as the OS and Service 
Pack, in a different server on the network and install them via the network. 
If a remote resource server is configured, you can install the same resources to multiple servers. This 
method is useful in configuring multiple servers.

Target Server and Remote Resource Server/PXE Server

A server to which resources are installed is called a "target server". A server that stores resources 
necessary for remote installation is called a "remote resource server". A server that can start up a target 
server through network startup (PXE) is called a "PXE server".

Installation Method
Remote installation uses a PXE or a remote resource server.

Remote Installation Using a PXE Server

In remote installation using a PXE server, the network startup (PXE) function of the PXE server starts 
up the target server and performs installation in preparation mode. This method is used when the target 
server does not have a CD-ROM or floppy disk drive.

In addition to the PXE server, a "remote resource server" that stores remote resources and a "DHCP 
server" that performs the DHCP service are required for remote installation using a PXE server. When 
you have only one server, store remote resources on the PXE server to install the DHCP service. When 
you have multiple servers, select one for performing the DHCP service and another for storing remote 
resources.

Installation

using ServerStart

PXE serverTarget server

Activated by IP address,

boot image
1)

Request resources2)

3) Supply resources

- OS

- Service Pack

- Application  

 etc.
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Remote Installation Using a Remote Resource Server

In remote installation using a remote resource server, ServerStart starts up on the target server. 
Procedures for starting installation are the same as those in normal installation (preparation, guided, and 
expert modes). Once installation started, resources necessary for installation are provided from the 
remote resource server. Thus, procedures such as inserting a CR-ROM are not necessary.

3.4.2 System Requirements for Remote Resource/PXE 
Servers

Because remote installation is performed via a network, the environment must have at least one 
Windows server and a local area network. 
In addition, the following environment is required.

Remote Resource/PXE Server Requirements

Notes on the PXE server
Check that no other PXE server exists on the same LAN.
Servers installed with software with the PXE function such as SystemcastWizard/SystemcastWizard 
Professional, Quick Recovery Manager, or the Microsoft RIS function cannot be used as a PXE server.

Checking Server Free Space
Decide a server to use as a remote resource server / PXE server and check it for enough free space for 
storing resources.

table: System Requirements for Remote Resource/PXE Servers
PXE server Remote resource server

OS Windows 2000 Server SP2 to 4
Windows Server 2003

Windows Server 2003
Windows 2000 Server

Memory 256MB or more 256MB or more

Operating 
environment

• DHCP server function (required on the same 
network)

• File sharing function (required)

• File sharing function (required)

Target server Remote resource server

Active ServerStart 
and start installation 1) Request resources

Supply resources2)

- OS
- Service Pack
- Application
  etc.
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Checking the Number of Servers

• When you have only one server, use it as the remote resource server, PXE server, and DHCP service 
server. Check it for the required amount of free space.

• When you have multiple servers
• Check if a server performing the DHCP service exists. If not, decide a server for the DHCP 

service.
• When there are multiple resources, they can be divided and stored in multiple remote resource 

servers.

Checking Server Free Space

The following table shows the amount of free space required for each installation resource.

Calculate the total resource size. Check that the remote resource server / PXE server has enough free 
space (free space greater than the space required for the resources). When the amount of free space is 
insufficient, you must use more remote resource servers.

table: Free Space Required for Resources
Resource Required free space

ServerStart Disc 1 approx. 650MB

ServerStart Disc 2 approx. 450MB

Windows Server 2003 644MB

Windows 2000 Server 472MB

Windows Server 2003 Service Pack 1 389MB

Windows 2000 Service Pack 4 433MB

Windows Server 2003 R2, Standard Edition Disc 1 609MB

Windows Server 2003 R2, Standard Edition Disc 2 125MB

Windows Server 2003 R2, Enterprise Edition Disc 1 610MB

Windows Server 2003 R2, Enterprise Edition Disc 2 125MB

Windows Server 2003 R2, Standard x64 Edition Disc 1 629MB

Windows Server 2003 R2, Standard x64 Edition Disc 2 172MB

Windows Server 2003 R2, Enterprise x64 Edition Disc 1 631MB

Windows Server 2003 R2, Enterprise x64 Edition Disc 2 172MB
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3.4.3 Preparation of the PXE Server (When the PXE Server 
is Used)

When performing remote installation using a PXE server, preparatory procedures, such as installing 
ServerStart, are required. 
Perform the following procedures to prepare the PXE server.

Starting the DHCP Service
Check that the DHCP service is running on the same network. 
If the DHCP service function is not installed, perform the following procedures to install the DHCP 
service. The following procedures are examples for Windows Server 2003.

1 Click [Start] → [Control Panel] → [Add or Remove Applications].

2 Click [Add or Remove Windows Components]. Click the [Dynamic Host 
Configuration Protocol (DHCP)] service from [Network Services].
The DHCP service is installed.

3 Create and configure a DHCP scope so that the IP address can be distributed.

Starting the DHCP Service

Installing ServerStart

Checking Services

Setting TFTP

Preparation of Resources
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Installing ServerStart

1 Insert the ServerStart Disc 1 CD-ROM into the PXE server.
The [Fujitsu Siemens ServerStart Setup] window appears.
When the [Fujitsu Siemens ServerStart Setup] window does not appear, execute "SeStSetup.exe" 
in the CD-ROM.

2 Check [Classic+Remote Installation (OS)], [PXE Server] and [Data packages 
for Remote Installation (OS)], and click [OK].
For [Classic + Remote Installation (OS)] and [Data packages for Remote Installation (OS)], 
check the items of the corresponding OS.
The setup window appears.

3 Click [Next].
The [Destination Folder] window appears.

4 Select the installation folder and click [Next].
To change the installation folder, click [Browse] and select the folder. 
The [Selection of LAN card] window appears.
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5 Select the LAN controller to use and click [Next].
The [proxy DHCP Configuration] window appears.

6 Select [Yes] to run the DHCP service on the PXE server or select [No] to run 
the DHCP service on the other server on the network, and click [OK].
The [Ready to Install the Application] window appears.

7 Click [Install].
Installation starts. When the installation is completed, the [InstallShield Wizard Completed] 
window appears.

8 Click [finish].
The setup window appears.

9 Click [Next].
The [License Agreement] window appears.

10 Select [I accept the license agreement] and click [Next].
The [User Information] window appears.

11 Enter the user information of the software and click [Next].
The [Destination Folder] window appears.
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12 Select the installation folder, configure ServerStart image that is required for 
network booting (PXE), and click [Next].
To change the installation folder, click [Browse] and select the folder. 
The [Select Features] window appears.

Clicking [Disk Cost] displays the following window where you can check the amount of free 
space.
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13 Click [Next].
The [Useraccount for access to the ServerStart Data packages] window appears.

Clicking [Create New User] displays the [Create New User] window. Configure each item to 
create a new user.

14 Enter a user name and a password, and click [Next].
The [Ready to Install the Application] window appears.

15 Click [Install].
Installation starts. When the installation is completed, the [InstallShield Wizard Completed] 
window appears.

16 Click [finish].
The setup window appears.

17 Click [Next].
The [License Agreement] window appears.

18 Select [I accept the license agreement] and click [Next].
The [User Information] window appears.



96

Chapter 3  OS Installation Using ServerStart

19 Enter the user information of the software and click [Next].
The [Destination Folder] window appears.

20 Specify the installation folder and click [Next]. To change the installation folder, 
click [Browse] and select the folder.
The [Select Features] window appears. Clicking [Disk Cost] displays the following window 
where you can check the amount of free space.

21 Click [Next].
The [Ready to Install the Application] window appears.

22 Click [Next].
Installation is executed.

If a message prompting you to restart the system appears before or after installation, eject the 
CD-ROM and restart the system according to the message. When the system restarts, insert 
the ServerStart CD-ROM and start installation again.
If the "This program does not respond." message appears during restart operation, click [Exit] 
to continue the restart operation.

When the installation is completed, the completion window appears.

23 Click [Exit].
In case of Windows Server 2003 x64 installation, the [Browse for Folder] window appears. Insert 
the ServerStart Disc 2 CD-ROM and continue installation.
ServerStart has been installed to the client computer.

24 Click [Start] → [Shutdown]. Select [Restart] and click [OK].
The system restarts.
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Checking Services

Checking [PXE Services] and [TFTP Service]

1 Right-click the [My Computer] icon and click [Manage].

2 Select [Services] from [Services and Applications].
On the Services list, check that PXE Services and TFTP Service have been installed and started.

Checking the DHCP Service

Perform the following check only when the PXE server performs the DHCP service.

1 On the PXE server, click [Start] → [Programs] → [Administrative Tools] → 
[DHCP] to start up the DHCP administrative tool.

2 Click [Server Options] and check that the "060 ClassID" server option is added.
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Setting TFTP
TFTP is an FTP service function that requires no authentication. In remote installation, the TFTP service 
is used to distribute the boot image required for startup. For the TFTP path, set the appropriate access 
rights for the Guest account to obtain the image via network startup (PXE).

1 Click [Start] → [Programs] → [Accessories] → [Windows Explorer] and move to 
the TFTP path (the default is C:\Program Files\Fujitsu 
Siemens\DeploymentService\tftp).

2 Right-click the TFTP folder and click [Properties].

3 Click the [Security] tab, add the Guest account, and set the "Read and 
execute", "List Folder Contents", and "Read" access permissions.

The preparation of the PXE server has been completed. 
Then, perform "3.4.4 Preparation of Remote Resources" ( pg.99).
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3.4.4 Preparation of Remote Resources

Store resources to be installed on the remote resource server (PXE server) before starting installation.

For sharing resources, log on to the remote resource/PXE server with the Administrator account.

1 Prepare resources required for installation.
• CD-ROM for the OS to be installed
• Service Pack CD-ROM for the OS to be installed
• ServerStart floppy disk
• PRIMERGY Document & Tool CD (for installing ServerView)
• Array Controller Document & Tool CD (for RAID configuration)
• Others

2 Create a shared folder for storing resources.
Create a shared folder for each CD prepared in Step 1.
E.g.:E:\W2K3Sv for Windows Server 2003

3 Extract the resources.
Using Windows Explorer, copy the CD-ROM for the resource to the shared folder.

3.4.5 Starting Remote Installation Using a PXE Server

Perform remote installation using a PXE server in the following procedures.

Checking the Network Startup (PXE) Setting
Remote installation using a PXE server is performed via the onboard LAN. Enable the network startup 
(PXE) of the target server. 
For more details on network startup, refer to "2.1.2 Hardware Settings" ( pg.43).

Checking the Network Startup (PXE) Setting

Checking the MAC Address

Starting remote Installation

Creating a Configuration File
(Setting of remote installation)
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Checking the MAC Address of the Onboard LAN
In remote installation, target servers are identified according to the MAC address. MAC addresses are 
unique information to LAN cards. Check the MAC address on each target server. Write down the MAC 
address of the onboard LAN. For details on how to check the MAC address of an onboard LAN, refer to 
"2.1.2 Hardware Settings" ( pg.43).

Creating a Configuration File
You can create a configuration file on a client computer before starting installation. For the procedure, 
refer to "3.2.1 Starting Up the Preparation Mode" ( pg.75) and "3.2.2 Configuring Settings in Wizards" 
( pg.77). 
When creating a configuration file on the PXE server, start installation.

Specify the shared name prepared instead of the local CD-ROM as installation information.

Starting Installation

1 On the PXE server, start up ServerStart.
If ServerStart has already been started, you do not have to restart it. If it is not started, click 
[Start] → [Programs] → [Fujitsu Siemens ServerStart] → [ServerStart(start from HD)]. 
The [Welcome to ServerStart] window appears.

2 Click [Click here to prepare an operating system installation for a PRIMERGY 
Server].
The [Select an Operating System] window appears.

3 Click [Microsoft Windows Server Operating System -Preparing and/or initiating 
a Remote Installation].
The [Microsoft Windows Operating System Installation] window appears.
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4 Click the OS to install.
The [Preparing the Installation] window appears. 
If a configuration file has already been created, go to Step 6.

5 Set items in wizards to create a configuration file.
Refer to "3.2.2 Configuring Settings in Wizards" ( pg.77). Set items in wizards and save the 
configuration file. 
Exiting a wizard returns to the preparation mode window.

6 Click [Click here to initiate the Remote Installation Process].
The [Remote Installation Target Server] window appears.



102

Chapter 3  OS Installation Using ServerStart

7 Configure remote installation.

1. Enter the "MAC address of target system".
2. Select the "PRIMERGY model type".
3. Specify the "Configuration File" containing the installation settings.

8 Click [Start Installation].
Installation starts. All disk contents on the target server are deleted.
The [ServerStart Boot Manager] window appears. 
Check that the status is "Waiting for client".
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9 Turn on the target server.
It is started up via the network (PXE) and installation starts.
When the resources have been copied, the "Preparation for automatic OS installation has 
completed." message appears.
Subsequent installation is performed automatically.
When the installation is completed, an installation completion message appears on the target 
server.
For the RAID configuration, the system is restarted. When the message "Rebooting the System" 
appears and the system is restarted, set the Boot priority to give the highest priority to onboard 
LAN. For details about how to change the Boot priority, refer to "8.2.4 Boot Options Submenu" 
( pg.218).

10 Press any key on the target server.

11 Restart the system on the target server.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform necessary procedures 
before starting server operations.

3.4.6 Starting Remote Installation Using a Remote 
Resource Server

In remote installation using a remote resource server, installation is performed using shared resources on 
the remote resource server. 
Perform "3.4.4 Preparation of Remote Resources" ( pg.99) before starting installation.

Configuring a Remote Floppy
A remote floppy is a shared folder for storing and using a configuration file on the network, instead of 
loading it from the ServerStart floppy disk. When the server does not have a floppy disk drive and 
installation is performed in guided mode/expert mode, use a remote floppy.

A remote floppy cannot be used when installing Windows Server 2003 x64.

1 Create a new folder in the shared folder on the remote resource server.
E.g.: C:\export\ServerStart\Floppy

2 Create a "ServerStart Floppy Disk" tag file for the ServerStart floppy disk. Start 
up Command Prompt and enter the following command.

C:\>copy nul C:\export\ServerStart\Floppy\"ServerStart Floppy Disk"
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Checking Remote Resources
Check that the remote resource server is shared properly.

1 Start up "Command Prompt" on the remote resource server. Enter the following 
and press the [Enter] key.

prompt:>net share
Check that the created shared folder is displayed properly.
For the net command, refer to Windows Help.

Starting Installation
Start installation from the target server.

In Guided Mode/Expert Mode

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

2 Create a ServerStart floppy disk.
When the ServerStart floppy disk supplied with the server is used

1. Insert the ServerStart floppy disk supplied with the server. Make sure that 
"Removable media" and "A:" are selected and click [Create].
The network startup setting window for remote installation appears.

2. Click [OK].
The [Initialization of ServerStart core running] window appears and the ServerStart 
initialization process starts. Depending on the hardware configuration, this process may 
take a few minutes. When the process is completed, the [Create a ServerStart Floppy Disk] 
window appears.

3. Click [Build a ServerStart Floppy Disk].
Creation of a ServerStart floppy disk starts. When the creation is completed, the "Floppy 
disk has been created." message appears.

When the remote floppy is used
1. Select "Remote (media)" and click [OK].

The [Network Startup Setting] window for remote installation appears.

If the SCSI option device is installed and a message prompts you to insert the ServerStart
floppy disk, “Removable media“ is selected. Be sure to select “Remote (media)“. 

2. Click [OK].
The [Specify Drive] window appears.

3. Enter [Remote path], [User name], and [Password] and click [OK].
The [Initialization of ServerStart core running] window appears and the ServerStart 
initialization process starts. Depending on the hardware configuration, this process may 
take a few minutes. When the process is completed, the [Welcome to ServerStart] window 
appears.
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3 Click [Click here to prepare and/or initiate an operating system installation].
The [Select the operating system to be installed] window appears. 
Click [Special Hints on Operating System Installation] and read the contents. Important 
information such as limitations on disk configuration is described.

4 Click [MS Windows Operating Systems].
The [Install Microsoft Windows Operating System Installation] window appears.

5 Select the OS to install and the mode.

6 Set items in wizards and save the configuration file.
For settings in wizards, refer to "3.1 Guided Mode" ( pg.58) or "3.3 Expert Mode" ( pg.81). 
Set items in wizards and save the configuration file. When using the remote floppy, specify the 
path to the shared folder for the remote floppy as the configuration file saving location.

Specify the shared name of the prepared shared folder instead of the local CD-ROM as instal-
lation source information.

7 Click [Click here, to Start the Installation of (OS)].
Installation starts. At steps where the CD-ROM for resources such as the OS to be installed is 
necessary, the resource is automatically acquired from the resource server via the network.

8 Eject the CD-ROM and floppy disk and click [OK].
The system restarts. When the installation is completed, an installation completion message 
appears on the target server.

9 Press any key on the target server.

10 Restart the system on the target server.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform necessary procedures 
before starting server operations.
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In Preparation Mode

1 Create a configuration file.
For the creation procedure, refer to "3.2 Preparation Mode" ( pg.75).

Specify the shared name of the prepared shared folder instead of the local CD-ROM as instal-
lation source information.

2 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

3 Set the created configuration file and click [OK].
The [Initialization of ServerStart core running] window appears and the ServerStart initialization 
process starts. Depending on the hardware configuration, this process may take a few minutes. 
When the process is completed, the [ServerStart Unattended Mode] window appears.

4 Click [Start].
Installation starts. At steps where the CD-ROM for resources such as the OS to be installed is 
necessary, the resource is automatically acquired from the resource server via the network.

5 Eject the CD-ROM and floppy disk and click [OK].
The system restarts. When the installation is completed, an installation completion message 
appears on the target server.

6 Press any key on the target server.

7 Restart the system on the target server.

The server setup and OS installation have been completed. 
Refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform necessary procedures 
before starting server operations.
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3.5 Installation on Multiple (the 
Second and Subsequent) Servers

This chapter explains how to perform installation on multiple servers using 
ServerStart. 
By editing the configuration file created for installation on the first server, you can use 
it for installation on other servers of the same model and configuration. This reduces 
the setup time. However, installation on the first server must be performed using 
ServerStart in guided or preparation mode.

Check that ServerStart supplied with the first server is of the same version as that supplied with the 
other servers. If the version is different, this installation method will not work.

3.5.1 Preparation for Installation

Required Software
The following software is required for installation on the second and subsequent servers. Be sure to have 
these items close at hand.
• CD-ROM for the OS to be installed
• ServerStart CD-ROM
• ServerStart floppy disk

A: ServerStart floppy disk containing the configuration file used for installation on the first server
B: ServerStart floppy disks supplied with the ServerStart CD-ROMs for the second and subsequent 
servers
If ServerStart floppy disks are not supplied, prepare as many floppy disks as there are servers.

• PRIMERGY Document & Tool CD (for installing ServerView)
• Array Controller Document & Tool CD (for RAID configuration)
• Service Pack CD-ROM for the installed OS

Preparatory Procedure
Perform the following procedure before installation. 
Using Explorer or Command Prompt, copy the ServerStart floppy disk (A) to the ServerStart floppy disk 
(B).
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3.5.2 Installation in Guided Mode

Edit the configuration file and perform installation in guided mode.

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately after 
that.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

2 Insert the ServerStart floppy disk copied in the preparatory procedure into the 
floppy disk drive and click [Create].
The network setting window for remote installation appears.

3 Click [OK].
The [Initialization of ServerStart core running] window appears and the ServerStart initialization 
process starts. Depending on the hardware configuration, this process may take a few minutes. 
When the process is completed, the [Create a ServerStart Floppy Disk] window appears.

4 Click [or insert a Server Start Floppy Disk to Start Server Start].
The [Welcome to ServerStart] window appears.

5 Click [Click here to prepare and/or initiate an operation system installation].
The [Select the operating system to be installed] window appears.

6 Click [MS Windows Operating Systems].
The [Microsoft Windows Operating System Installation] window appears.

7 Click the OS to install.

8 Click [Prepare & initiate an unattended installation of (OS)].
The guided mode starts.

9 Click [Start here to create a complete configuration file].
The [Open ServerStart Configuration File] window appears.

10 Specify "SerStartBatch.ini" on drive A and click [Create].
The display returns to the guided mode window.
For procedures from setting wizards to completion of installation, refer to "3.1 Guided Mode" 
( pg.58). 
When performing remote installation, refer to "3.4 Remote Installation" ( pg.88).
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Settings values in wizards
Setting items in wizards are set to the values set on the first server. For installation on subse-
quent servers, you must change the following items in the “OS installation wizard”. For other
items, change the settings as necessary. You do not need to start up wizards where no set-
tings will be changed.

If the settings for the first server are not reflected to wizards, perform the procedure over again
from copying the floppy disk.

3.5.3 Installation in Preparation Mode

Edit the configuration file and perform installation in preparation mode.
If ServerStart is not installed in the client computer where the preparation mode is executed, refer to "2.4 
Preparation for Using ServerStart on a Client Computer" ( pg.52) to install ServerStart. If a different 
version of ServerStart has been installed, uninstall it and install the proper version. For details on how to 
uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" ( pg.54).

ServerStart starts up when it is installed. However, be sure to follow these installation procedures. 
Performing the procedure in "3.2.1 Starting Up the Preparation Mode" ( pg.75) deletes the contents 
of the ServerStart floppy disk, making the disk unavailable for installation on multiple servers.

1 Start up ServerStart.
If ServerStart has already been started, you do not have to restart it. If it is not started, perform 
the following startup procedures.

1. Insert the ServerStart Disc 1 CD-ROM into the client computer.
2. Click [Start] → [Programs] → [Fujitsu Siemens ServerStart] → [ServerStart(Start 

from CD)].
ServerStart starts up and the [Welcome to ServerStart] window appears.

2 Select the OS to be installed.
The preparation mode starts up.

3 Insert the ServerStart floppy disk copied in the preparatory procedure into the 
floppy disk drive and click [Start here to configuration file].
The [Open ServerStart Configuration File] window appears.

table: Settings to be Changed for Installation on Subsequent Servers
Window 
name Setting item name Remarks 

User 
Information

Computer name The setting must be changed when the second 
and subsequent servers are on the same 
network as the first server.

Product ID/CD key The setting must be changed.

Network 
Protocol

IP address The setting must be changed when the second 
and subsequent servers are on the same 
network as the first server.
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4 Specify "SerStartBatch.ini" on drive A and click [Create].
The display returns to the preparation mode window.
For procedures from setting wizards to completion of installation, refer to "3.2 Preparation 
Mode" ( pg.75). 
When performing remote installation, refer to "3.4 Remote Installation" ( pg.88).

Settings values in wizards
Setting items in wizards are set to the values set on the first server. For installation on subse-
quent servers, you must change the following items in the “OS installation wizard”. For other
items, change the settings as necessary. You do not need to start up wizards where no set-
tings will be changed.

If the settings for the first server are not reflected to wizards, perform the procedures from
copying the floppy disk over again.

table: Settings to be Changed for Installation on Subsequent Servers
Window 
name Setting item name Remarks 

User 
Information

Computer name The setting must be changed when the second 
and subsequent servers are on the same 
network as the first server.

Product ID/CD key The setting must be changed.

Network 
Protocol

IP address The setting must be changed when the second 
and subsequent servers are on the same 
network as the first server.
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This chapter explains how to install the OS 
without using ServerStart.

4.1 Creating Driver Disks  . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
4.2 Starting Manual Installation  . . . . . . . . . . . . . . . . . . . . . . . 117
4.3 Installing the LAN Driver  . . . . . . . . . . . . . . . . . . . . . . . . . 128
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4.1 Creating Driver Disks

When installing the OS manually, it is necessary to create driver installation disks 
beforehand. Also, driver disks must be created when you add an expansion card 
during server operation.

4.1.1 Required Driver Disks

Prepare for the floppy disks in advance to create the driver disks. A floppy disk is necessary for each 
driver.
The driver disks to be created differ depending on the OS to be installed.

Standard driver provided with the OS is installed automatically at the OS installation.
You need a Server Start Disc 1 CD-ROM to install the driver provided with the Server Start CD-ROM. 
Prepare for it in advance.

For Windows Server 2003 x64

*1: Created by the ServerStart FloppyBuilder function

table: Drivers Required for Installing Windows Server 2003 x64
Expansion card / onboard controller Driver

Chipset Driver provided with the Server Start CD-ROM

Graphic controller Driver provided with the Server Start CD-ROM

Onboard SAS controller Integrated Mirroring SAS Driver Windows 2003 for x64 
Edition Drivers Disk V1.21.13L10 *1

SAS array controller card (PG-140F) MegaRAID SAS Driver Windows 2003 for x64 Edition 
Drivers Disk V1.18L10 *1

Onboard LAN TX150 S5 Onboard LAN Driver Windows 2003 x64 Drivers 
Disk Ver9.25.0.0 *1

LAN card (PG-1892) PG-185x/186x/188x/189x LAN Driver Windows 2003 for x64 
Edition Drivers Disk Ver10.3 *1

LAN card (PG-2861) PG-286x LAN Driver Windows 2003 for x64 Edition Drivers 
Disk Ver10.3 *1

SCSI card (PG-1281) Standard driver provided with the OS

Other expansion cards Driver supplied with the expansion card
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For Windows Server 2003 / SBS 2003

*1: Created by the ServerStart FloppyBuilder function

For Windows 2000 Server

*1: Created by the ServerStart FloppyBuilder function

table: Drivers Required for Installing Windows Server 2003 / SBS 2003
Expansion card / onboard controller Driver

Chipset Driver provided with the Server Start CD-ROM

Graphic controller Standard driver provided with the OS

Onboard SAS controller Integrated Mirroring SAS Driver Windows 2000/2003 Drivers 
Disk V1.21.13L10 *1

SAS array controller card (PG-140F) MegaRAID SAS Driver Windows 2000/2003 Drivers Disk 
V1.20L10 *1

Onboard LAN TX150 S5 Onboard LAN Driver Windows 2003 Drivers Disk 
Ver9.25.0.0 *1

LAN card (PG-1892) PG-185x/186x/188x/189x LAN Driver Windows 2000/2003   
Drivers Disk Ver10.3 *1

LAN card (PG-2861) PG-286x LAN Driver Windows 2000/2003 Drivers Disk 
Ver10.3 *1

SCSI card (PG-1281) Standard driver provided with the OS

Other expansion cards Driver supplied with the expansion card

table: Drivers Required for Installing Windows 2000 Server
Expansion card / onboard controller Driver

Chipset Driver provided with the Server Start CD-ROM

Graphic controller Driver provided with the Server Start CD-ROM

Onboard SAS controller Integrated Mirroring SAS Driver Windows 2000/2003 Drivers 
Disk V1.21.13L10 *1

SAS array controller (PG-140F) MegaRAID SAS Driver Windows 2000/2003 Drivers Disk 
V1.20L10 *1

Onboard LAN TX150 S5 Onboard LAN Driver Windows 200 Drivers Disk 
Ver9.25.0.0 *1

LAN card (PG-1892) PG-185x/186x/188x/189x LAN Driver Windows 2000/2003   
Drivers Disk Ver10.3 *1

LAN card (PG-2861) PG-286x LAN Driver Windows 2000/2003 Drivers Disk 
Ver10.3 *1

SCSI card (PG-1281) Standard driver provided with the OS

Other expansion cards Driver supplied with the expansion card
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4.1.2 How to Create Driver Disks [FloppyBuilder function]

Driver disks are created from the ServerStart CD-ROM using the ServerStart FloppyBuilder function.
The FloppyBuilder function is available in the following environments.
• Starting up the ServerStart system on a client computer (Recommended)
• Starting up the system from the ServerStart CD-ROM on the server

When creating driver disks on a client computer, it is necessary to install ServerStart on the client 
computer beforehand. Install it according to "2.4 Preparation for Using ServerStart on a Client 
Computer" ( pg.52).
If a different version of ServerStart has been installed, uninstall it and install the proper version. For 
details on how to uninstall ServerStart, refer to "2.4.2 Uninstalling ServerStart" ( pg.54).

Starting ServerStart
If ServerStart has already been started, you do not have to restart it. If it is not started, perform the 
following startup procedures.

For Creation on a Client Computer

1 Insert the ServerStart Disc 1 CD-ROM into the client computer.

2 Click [Start] → [Programs] → [Fujitsu Siemens ServerStart] → 
[ServerStart(start from CD)].
ServerStart starts up and the [Welcome to ServerStart] window appears.

For Creation on the Server

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

2 Insert the attached [ServerStart floppy disk] into the server's floppy disk drive. 
Then make sure "Removable media" and "A:" are selected and click [Create].
A network setup window for remote installation appears.
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If a configuration file already exists in the ServerStart floppy disk and [OK] is clicked without
clicking [Create], the [ServerStart Unattended Mode] window appears. Make sure to click
[Exit]. The [Welcome to ServerStart] window appears.
If [Start] is clicked in the [ServerStart Unattended Mode] window, the installation of the server
will start and all disk contents will be deleted.

3 Click [OK].
The [Initializing ServerStart] window appears and the ServerStart initialization process starts. 
Depending on the hardware configuration, this process may take a few minutes. When the 
process is completed, the [Create a ServerStart Floppy Disk] window appears.

4 Click [or Insert a ServerStart Floppy Disk to Start ServerStart].
The [Welcome to ServerStart] window appears.

5 Eject the ServerStart floppy disk.
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Creating Driver Disks
Start up ServerStart and confirm that the [Welcome to ServerStart] window is displayed.

1 Click [FloppyBuilder].
The [ServerStart FloppyBuilder] window appears.

2 Select the Drivers Diskettes for Windows Server 2003 / Windows 2000 Server 
or Windows Server 2003 x64.
The [FloppyBuilder Driver Disk] window appears.

3 Click the type of the driver you want to create.

4 Click the driver disk you want to create.
Follow the message and insert a floppy disk.

5 Perform the procedures following the messages on the window.
The floppy disk will be formatted automatically and file copying will start. 
The driver disk is automatically created. When a message appears indicating that creating the 
disk is completed, click [OK] and eject the floppy disk.
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4.2 Starting Manual Installation

This section explains the procedures for installing the OS manually.

The Microsoft package products shipped after July 2003 and the volume-licensed Windows 2000 
Server CD-ROM are already applied to Service Pack 4. However, the volume license also provides 
Windows 2000 Server CD-ROM not applied to Service Pack 4.
You can confirm whether Service Pack 4 or later is applied by checking the label of your Windows 
2000 Server CD-ROM.

4.2.1 Installing Windows Server 2003 x64

For details on the OS settings, refer to the following URL.
http://www.microsoft.com/technet/prodtechnol/exchange/2003/Library/default.mspx

1 Create driver disks.
Prepare necessary drivers before installing Windows Server 2003 x64.
Some drivers are created from the ServerStart CD-ROM.
For how to create driver disks, refer to "4.1 Creating Driver Disks" ( pg.112).

2 Turned on the server and configure RAID. If RAID is not required to be 
configured, proceed to step 3.
Turn off the server after configuring the array system.

To configure the array system with onboard SAS array controller
Turn on the server to display the following message and press the [Ctrl] + [C] key to start up the 
BIOS Utility.

Configure the array system using the BIOS Utility. For more details, refer to "Integrated 
Mirroring SAS User’s Guide" in the Array Controller Document & Tool CD.

To configure the array system with the array controller card (PG-140F)
Turn on the server to display the following message and press the [Ctrl] + [H] key to start up the 
WebBIOS.

Configure the array system using WebBIOS. For more details, refer to "MegaRAID SAS User’s 
Guide" in the Array Controller Document & Tool CD.

Press Ctrl C to start LSI Logic Configuration Utility

Press <Ctrl><H> for WebBIOS

http://www.microsoft.com/technet/prodtechnol/exchange/2003/Library/default.mspx
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3 Prepare the Windows Server 2003 x64 CD-ROM.
Turn on the server and insert the Windows Server 2003 x64 CD-ROM immediately into the CD-
ROM drive. Confirm that the floppy drive is empty. When the active area is specified on the hard 
disk, the following message appears.

Pressing any key while this message is displayed boots the system from the CD-ROM.

4 The [Windows Server 2003 x64 Setup] window appears.
Immediately, the following message appears at the bottom of the window. Press the [F6] key.

This message will be displayed for a short time after the setup window (blue screen) appears.
Press the [F6] key immediately after the window turns blue.

5 Install the Drivers for the array controller manually.
1. When the following message appears, press the [S] key.

2. When the "Please insert the disk labeled Manufacturer-supplied hardware support 
disk into Drive A:" message appears, insert the driver disk created from the driver’s 
CD and press the [Enter] key.
The following message appears.

3. Select either of the followings according to your controller and press the [Enter] 
key.
• For onboard SAS array controller

• For SAS array controller card (PG-140F)

Press any key to boot from CD....

Press F6 if you need to install a third party SCSI or RAID 
driver ...

To specify additional SCSI adapters, CD-ROM drives, or 
special disk controllers for use with Windows, including 
those for which you have a devicesupport disk from a mass 
storage device manufacturer, press S.

You have chosen to configure a SCSI Adapter for use with 
Windows, using a device support disk provided by an 
adapter manufacturer.
Select the SCSI Adapter you want from the following list, 
or press ESC to return to the 
previous screen.

LSI Logic Fusion-MPT SAS Driver (Server 2003 x64)

LSI Logic MegaRAID SAS RAID Controller Driver (Server 
2003 for x64)
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4. When the following message appears, press the [S] key.

5. Follow the instructions in the window to perform installation
The message which prompts you to set the floppy disk appears during the installation, set 
the driver disk and push the [Enter] key.

6 Follow the instructions from the setup program to continue the installation 
procedure.
If a message indicating that the driver has not passed Windows Logo testing to verify its 
compatibility with Windows appears, select [Yes] to continue the installation procedure.

7 Install the LAN driver.
Install the LAN driver using the driver disk created from the ServerStart CD-ROM. For more 
details, refer to "4.3 Installing the LAN Driver" ( pg.128).

8 Install the ChipSet driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Execute the following command on the CD-ROM.

[CD-ROM drive] :\DRIVERS\ChipSet\Intel\Intel3000\infinst_autol.exe
The installation wizard starts up.

3. Click [Next]. Follow the instructions in the window to perform installation.
4. When the "InstallShieled(R) wizard has completed" message appears, eject the 

ServerStart CD-ROM from the CD-ROM drive and click [Finish] to restart the 
system.

9 Install the Display driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Execute the following command on the CD-ROM.

[CD-ROM drive] :\DRIVERS\VIDEO\MATROX\w2k3x64\setup.bat
The installation wizard starts up.

3. Click [Next]. Follow the instructions in the window to perform installation.
4. When the installation is completed, eject the ServerStart CD-ROM from the CD-

ROM drive and click [Finish] to restart the system.

10 Installing high reliability tools.
To ensure stable server operation, refer to "Chapter 6 High Reliability Tools" ( pg.171) and 
install high reliability tools. Please install the RAID Management Tool when you configure 
RAID.

The installation of Windows Server 2003 x64 has completed.

The driver you provided seems to be newer than the Windows 
default driver. Windows already has a driver that you can 
use for "MEGARAID SCSI 320-0X RAID Controller Driver" 
Unless the device on the floppy disk, you should use the 
driver in Windows.
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Before Starting Operation

After OS installation, refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform the 
necessary procedures.

4.2.2 Installing Windows Server 2003 / SBS 2003

For details on the OS settings, refer to the following URL.
http://www.microsoft.com/technet/prodtechnol/exchange/2003/Library/default.mspx

To install SBS 2003
In the installation of SBS 2003, install the operating system and the server tools / the application in this 
order. It is necessary to connect the local network adaptor of the server that SBS 2003 is installed with 
hub. Confirm it before the installation begins. 

1 Create driver disks.
Prepare necessary drivers before installing Windows Server 2003.
Some drivers are created from the ServerStart CD-ROM.
For how to create driver disks, refer to "4.1 Creating Driver Disks" ( pg.112).

2 Turned on the server and configure RAID. If RAID is not required to be 
configured, proceed to step 3.
Turn off the server after configuring the array system.

To configure the array system with onboard SAS array controller
Turn on the server to display the following message and press the [Ctrl] + [C] key to start up the 
BIOS Utility.

Configure the array system using the BIOS Utility. For more details, refer to "Integrated 
Mirroring SAS User’s Guide" in the Array Controller Document & Tool CD.

To configure the array system with the array controller card (PG-140F)
Turn on the server to display the following message and press the [Ctrl] + [H] key to start up the 
WebBIOS.

Configure the array system using WebBIOS. For more details, refer to "MegaRAID SAS User’s 
Guide" in the Array Controller Document & Tool CD.

Press Ctrl C to start LSI Logic Configuration Utility

Press <Ctrl><H> for WebBIOS

http://www.microsoft.com/technet/prodtechnol/exchange/2003/Library/default.mspx
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3 Prepare the Windows Server 2003 CD-ROM.
Turn on the server and insert the Windows Server 2003 CD-ROM or CD-ROM Disk1 for SBS 
2003 immediately into the CD-ROM drive. Confirm that the floppy drive is empty. When the 
active area is specified on the hard disk, the following message appears.

Pressing any key while this message is displayed boots the system from the CD-ROM.

4 The Windows Server 2003 setup window appears.
Immediately, the following message appears at the bottom of the window. Press the [F6] key.

This message will be displayed for a short time after the setup window (blue screen) appears.
Press the [F6] key immediately after the window turns blue.

5 Install the Drivers for the array controller manually.
1. When the following message appears, press the [S] key.

2. When the "Please insert the disk labeled Manufacturer-supplied hardware support 
disk into Drive A:" message appears, insert the driver disk created and press the 
[Enter] key.
The following message appears.

3. Select either of the followings according to your controller and press the [Enter] 
key.
• For onboard SAS array controller

• For SAS array controller card (PG-140F)

Press any key to boot from CD....

Press F6 if you need to install a third party SCSI or RAID 
driver ...

To specify additional SCSI adapters, CD-ROM drives, or 
special disk controllers for use with Windows, including 
those for which you have a devicesupport disk from a mass 
storage device manufacturer, press S.

You have chosen to configure a SCSI Adapter for use with 
Windows, using a device support disk provided by an 
adapter manufacturer.
Select the SCSI Adapter you want from the following list, 
or press ESC to return to the 
previous screen.

LSI Logic Fusion-MPT SAS Driver (Server 2003 32-bit)

LSI Logic MegaRAID SAS RAID Controller Driver (Server 
2003 32-bit)
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4. When the following message appears, press the [S] key.

5. Follow the instructions in the window to perform installation
The message which prompts you to set the floppy disk appears during the installation, set 
the driver disk and push the [Enter] key.

6 Follow the instructions from the setup program to continue the installation 
procedure.
If a message indicating that the driver has not passed Windows Logo testing to verify its 
compatibility with Windows appears, select [Yes] to continue the installation procedure.

For SBS 2003
The server is restarted after installing the operating system.

1. After restarting the server, log on to the server with the Administrator account.
The installation of server tools and the application is started, and the following window 
appears.

2. Click [Cancel] to cancel the installation.

7 Install the LAN driver.
Install the LAN driver using the driver disk created from the ServerStart CD-ROM. For more 
details, refer to "4.3 Installing the LAN Driver" ( pg.128).

8 Install the ChipSet driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Execute the following command on the CD-ROM.

[CD-ROM drive] :\DRIVERS\ChipSet\Intel\Intel3000\infinst_autol.exe
The installation wizard starts up.

The driver you provided seems to be newer than the Windows 
default driver. Windows already has a driver that you can 
use for "LSI MEGARAID Products for Windows 2003(x86)"(or 
"LSI Logic PCI SCSI/FC MPI Miniport Driver(Server 2003 
32bit)) Unless the device on the floppy disk, you should 
use the driver in Windows.
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3. Click [Next]. Follow the instructions in the window to perform installation.
4. When the "InstallShieled(R) wizard has completed" message appears, eject the 

ServerStart CD-ROM from the CD-ROM drive and click [Finish] to restart the 
system.

9 Install the Display driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Execute the following command on the CD-ROM.

[CD-ROM drive] :\DRIVERS\VIDEO\MATROX\w2k_w2k3\setup.bat
The installation wizard starts up.

3. Click [Next]. Follow the instructions in the window to perform installation.
4. When the installation is completed, eject the ServerStart CD-ROM from the CD-

ROM drive and click [Finish] to restart the system.

10 For SBS 2003, double-click the [Continue Setup] icon on the desktop.
When the "Microsoft Windows Small Business Server Setup" window appears, click [Next] and 
follow the instructions in the window to perform installation. 

"Component Message" appears when there are errors or messages that relate to the installed
component. Perform installation again after check and solve problems.

11 Apply Windows Server 2003 Service Pack.
For details, refer to the description in the window.

12 Installing high reliability tools.
To ensure stable server operation, refer to "Chapter 6 High Reliability Tools" ( pg.171) and 
install high reliability tools. Please install the RAID Management Tool when you configure 
RAID.

Before Starting Operation

After OS installation, refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform the 
necessary procedures.

4.2.3 Installing Windows 2000 Server

1 Create driver disks.
Prepare necessary drivers before installing Windows 2000 Server.
Some drivers used with Windows 2000 Server are created from the ServerStart CD-ROM. For 
how to create driver disks, refer to "4.1 Creating Driver Disks" ( pg.112).

2 Turned on the server and configure RAID. If RAID is not required to be 
configured, proceed to step 3.
Turn off the server after configuring the array system.
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To configure the array system with onboard SAS array controller
Turn on the server to display the following message and press the [Ctrl] + [C] key to start up the 
BIOS Utility.

Configure the array system using the BIOS Utility. For more details, refer to "Integrated 
Mirroring SAS User’s Guide" in the Array Controller Document & Tool CD.

To configure the array system with the array controller card (PG-140F)
Turn on the server to display the following message and press the [Ctrl] + [H] key to start up the 
WebBIOS.

Configure the array system using WebBIOS. For more details, refer to "MegaRAID SAS User’s 
Guide" in the Array Controller Document & Tool CD.

3 Prepare the Windows 2000 Server CD-ROM.
Turn on the server and insert the Windows 2000 Server CD-ROM immediately into the CD-
ROM drive. Check there are no floppy disks in the floppy disk drive. When the active area is 
specified on the hard disk, the following message appears.

Pressing any key while this message is displayed boots the system from the CD-ROM.

4 The [Windows 2000 Server Setup] window appears.
Immediately, the following message appears at the bottom of the window. Press the [F6] key. 

This message will be displayed for a short time after the setup window (blue screen) appears.
Press the [F6] key immediately after the window turns blue.

5 Install the Drivers for the array controller manually.
1. When the following message appears, press the [S] key.

Press Ctrl C to start LSI Logic Configuration Utility

Press <Ctrl><H> for WebBIOS

Press any key to boot from CD....

Press F6 if you need to install a third party SCSI or RAID 
driver ...

To specify additional SCSI adapters, CD-ROM drives, or 
special disk controllers for use with Windows 2000, 
including those for which you have a device support disk 
from a mass storage device manufacturer, press S.
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2. When the "Please insert the disk labeled Manufacturer-supplied hardware support 
disk into Drive A:" message appears, insert the driver disk created and press the 
[Enter] key.
The following message appears.

3. Select either of the followings according to your controller and press the [Enter] 
key.
• For onboard SAS array controller

• For SAS array controller card (PG-140F)

4. When the following message appears, press the [S] key.

5. Follow the instructions in the window to perform installation
The message which prompts you to set the floppy disk appears during the installation, set 
the driver disk and push the [Enter] key.

6 Follow the instructions from the setup program to continue the installation 
procedures.

Cautions on Restarting
In the course of installation, a message appears to indicate that the setup program restarts.
Wait until it restarts automatically.

7 Install the LAN driver.
Install the LAN driver using the driver disk created from the ServerStart CD-ROM. For more 
details, refer to "4.3 Installing the LAN Driver" ( pg.128).

8 Install the ChipSet driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Execute the following command on the CD-ROM.

[CD-ROM drive] :\DRIVERS\ChipSet\Intel\Intel3000\infinst_autol.exe
The installation wizard starts up.

You have chosen to configure a SCSI Adapter for use with 
Windows 2000, using a device support disk provided by an 
adapter manufacturer.
Select the SCSI Adapter you want from the following list, 
or press ESC to return to the 
previous screen.

LSI Logic Fusion-MPT Driver for SAS1068 (Windows 2000)

LSI Logic MegaRAID SAS RAID Controller Driver (Windows 
2000)

The driver you provided seems to be newer than the Windows 
default driver. Windows already has a driver that you can 
use for "LSI MEGARAID Products for Windows 2000"(or "LSI 
Logic PCI SCSI/FC MPI Miniport Driver) Unless the device 
on the floppy disk, you should use the driver in Windows.
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3. Click [Next]. Follow the instructions in the window to perform installation.
4. When the "InstallShieled(R) wizard has completed" message appears, eject the 

ServerStart CD-ROM from the CD-ROM drive and click [Finish] to restart the 
system.

9 Install the Display driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Execute the following command on the CD-ROM.

[CD-ROM drive] :\DRIVERS\VIDEO\MATROX\w2k_w2k3\setup.bat
The installation wizard starts up.

3. Click [Next]. Follow the instructions in the window to perform installation.
4. When the installation is completed, eject the ServerStart CD-ROM from the CD-

ROM drive and click [Finish] to restart the system.

10 Install the USB 2.0 driver.
1. Insert the ServerStart Disc 1 CD-ROM into the drive of the server.

When the ServerStart window appears, exit ServerStart.
2. Right-click the [My Computer] icon on the desktop and click [Manage] from the 

displayed menu.
3. Click [Device Manager] from the displayed list.
4. Double-click [USB 2.0 Root Hub] under [Universal Serial Bus (USB) controller].

The properties window appears.
5. Click the [Driver] tab and click [Update Driver]. 

The "Device Driver Upgrade Wizard" window appears.
6. Click [Next].
7. Select [Find an optimum driver (Recommended)] and click [Next].
8. Select only [CD-ROM drive] in [Search location options] and click [Next].
9. Select [Install another driver] and click [Next].

10. Select [USB 2.0 Root Hub] and click [Next].
Installation starts. When it is completed, a completion message appears.

11. Click [Finish].
12. Click [Close] to close the properties window.

11 Installing high reliability tools.
To ensure stable server operation, refer to "Chapter 6 High Reliability Tools" ( pg.171) and 
install high reliability tools. Please install the RAID Management Tool when you configure 
RAID.

The installation of Windows 2000 Server has completed.

Before Starting Operation

After OS installation, refer to "Chapter 5 Operations after OS Installation" ( pg.135) and perform the 
necessary procedures.
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4.2.4 Installing Linux

For the use of Linux, refer to the Fujitsu PRIMERGY website (http://primergy.fujitsu.com).

http://primergy.fujitsu.com
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4.3 Installing the LAN Driver

This section explains the procedure for installing the driver.
In addition to the case where the OS is installed manually, the driver must be 
installed when a LAN card is added.

Checking the LAN device after OS installation
For Windows Server 2003 x64, Windows Server 2003, and SBS 2003, the LAN driver installation 
procedure differs depending on whether the network adapter was recognized during the OS installation. 
Check whether or not a recognized network adapter is present by the following procedures in advance.

1 Click [Start] → [Administrative Tools] → [Computer Management].

2 Click [Device Manager].
On the Device Manager list, check if a recognized network adapter is present.
(Window example)

When a recognized network adapter is present, [Network adapters] appears.

When a recognized network adapter is present

Perform "  Updating LAN Drivers" ( pg.131) on the LAN device name under [Network adapters], 

then "  Installing the LAN Driver" ( pg.131) on [Ethernet controller] under [Other devices].

When a recognized network adapter is not present

Perform "  Installing the LAN Driver" ( pg.131) on [Ethernet controller] under [Other devices].

Recognized 
network adapter

Unrecognized 
network adapter
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When the LAN driver is installed to [Other devices] before updating the driver for the network
adapter recognized immediately after the OS installation

When driver installation starts, the following window appears.

Clicking [Finish] displays the [Help and Support Center] window. Click [X] to close the window.
After installation, the "!" mark is displayed at the LAN device name in Device Manager. Device names 
are displayed properly when all LAN drivers are installed and the system is restarted.

4.3.1 Installing the LAN Driver (Windows Server 2003 x64)

LAN cards except PG-2861 are recognized as the network adapters when the OS is installed. 
Perform "  Updating the LAN Cards" ( pg.129) on all LAN device names under [Network adapters], 

and then perform "  Installing the LAN Driver" ( pg.130) on the Ethernet controllers under [Other 
devices].

For the following LAN cards, the network adapters are recognized when the cards are mounted during 
OS installation.
• PG-1892

Updating the LAN Cards
Perform the following procedures on all LAN device names under [Network adapters] in [Device 
Manager].

1 Click [Start] → [Administrative Tools] → [Computer Manager].

2 Click [Device Manager].

3 Double-click a LAN device name under [Network adapters].
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Names of the LAN devices are displayed as follows.

4 Insert the driver disk created from the ServerStart CD-ROM into the server.

5 Click [Update Driver] in the [Driver] tab window.
The "Welcome to the Hardware Update Wizard" window appears.

6 Check [No, not this time] and click [Next].

7 Select [Install the software automatically (Recommended)] and click [Next].
The driver will be installed. 

8 Click [Finish].

9 Click [Close] to close the properties window.

Installing the LAN Driver
Perform the following procedures on each [Ethernet controller] under [Other devices] in [Device 
Manager].

1 Insert the driver disk created from the ServerStart CD-ROM into the server. 

2 Double-click [Ethernet controller] under [Other devices].
The properties window for the Ethernet controller appears.

3 Click [Reinstall Driver] in the [General] tab window.
The [Welcome to the Hardware Update Wizard] window appears.

4 Check [No, not this time] and click [Next].

5 Select [Install the software automatically (Recommended)] and click [Next].
The driver will be installed. 

6 Click [Finish].

7 Click [Close] to close the properties window.

8 Remove the driver disk and restart the system.

table: LAN device name
LAN cards LAN device name

Onboard LAN (1000BASE-T) Broadcom NetXtreme Gigabit Ethernet

PG-1892 Intel(R) PRO/1000 MT Server Adapter
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After LAN driver installation, names of the LAN devices are displayed as follows.

4.3.2 Installing the LAN Driver (Windows Server 2003 / 
SBS 2003)

The LAN driver installation procedure differs depending on whether the network adapter was 
recognized during the OS installation.

Updating LAN Drivers
Perform the following procedures on all LAN device names under [Network adapters] in [Device 
Manager].

1 Double-click a LAN device name under [Network adapters].

2 Insert the driver disk created from the ServerStart CD-ROM into the server.

3 Click [Update Driver] in the [Driver] tab window.
The "Welcome to the Hardware Update Wizard" window appears.

4 Select [Install the software automatically (Recommended)] and click [Next].
The driver will be installed. 

5 Click [Finish].

6 Click [Close].

Installing the LAN Driver
Perform the following procedures on each [Ethernet controller] under [Other devices] in [Device 
Manager].

1 Insert the driver disk created from the ServerStart CD-ROM into the server. 
For the onboard LAN, insert the ServerStart CD-ROM.

2 Double-click [Ethernet controller] under [Other devices].
The properties window for the Ethernet controller appears.

table: LAN device name
LAN cards LAN device name

Onboard LAN (1000BASE-T) Broadcom NetXtreme Gigabit Ethernet

PG-1892 Intel(R) PRO/1000 MT Server Adapter

PG-2861 Intel(R) PRO1000 PT Dual Port Server Adapter
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3 Click [Reinstall Driver] in the [General] tab window.
The [Welcome to the Hardware Update Wizard] window appears.

4 Select [Install the software automatically (Recommended)] and click [Next].
The driver will be installed. 

5 Click [Finish].

6 Click [Close] to close the properties window.

7 Remove the driver disk and restart the system.

After LAN driver installation, names of the LAN devices are displayed as follows.

4.3.3 Installing the LAN Driver (Windows 2000 Server)

1 Insert the driver disk created from the ServerStart CD-ROM into the server.

2 Right-click the [My Computer] icon on the desktop and select [Manage] from 
the displayed menu.

3 Click [Device Manager].
As many [Ethernet controller] items as the installed LAN ports are displayed under [Other 
devices].
Double-click each [Ethernet controller] item and perform the following Steps 4 to 11 on all LAN 
ports.

4 Double-click [Ethernet controller] under [Other devices].
The properties window for the Ethernet controller appears.

5 Click [Reinstall Driver] in the [General] tab window.
The [Device Driver Upgrade Wizard] window appears.

6 Click [Next].

7 Select [Search for a suitable driver for my device (Recommended)] and click 
[Next].
The [Identify Driver File] window appears.

table: LAN device name
LAN cards LAN device name

Onboard LAN (1000BASE-T) Broadcom NetXtreme Gigabit Ethernet

PG-1892 Intel(R) PRO/1000 MT Server Adapter

PG-2861 Intel(R) PRO1000 PT Dual Port Server Adapter
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8 Select [Floppy disk drive] in [Search location options] and click [Next].
Detected drivers are displayed.

9 Click [Next].
Driver installation starts. When it is completed, a completion window appears.

10 Click [Finish].

11 Click [Close] to close the properties window.

When [Ethernet controller] items are displayed under [Other devices], perform the above Steps
4 to 11 on all [Ethernet controller] items.

12 Remove the driver disk and restart the system.

When a LAN card is added, the following window may appear at system startup after addition
of a LAN card. Perform the appropriate procedure according to the displayed window.
•When the "New Hardware Detection Wizard" window appears

Insert the driver disk created from the ServerStart CD-ROM and perform Step 6 and
subsequent steps in "Updating LAN Drivers"

•When the [Insert Disk] window prompts you to insert the "Intel PRO Adapter CD-ROM or
floppy disk" or "Intel® PRO/1000 Disk Driver"

Insert the driver disk created from the ServerStart CD-ROM and install the driver.

After LAN driver installation, names of the LAN devices are displayed as follows.

4.3.4 Latest Drivers

For the latest drivers, refer to the Fujitsu PRIMERGY website (http://primergy.fujitsu.com).

table: LAN device name
LAN cards LAN device name

Onboard LAN (1000BASE-T) Broadcom NetXtreme Gigabit Ethernet

PG-1892 Intel(R) PRO/1000 MT Server Adapter

PG-2861 Intel(R) PRO1000 PT Dual Port Server Adapter

http://primergy.fujitsu.com
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Chapter 5

Operations after OS
Installation

This chapter explains the operations to be 
performed after OS installation. Be sure to 
perform these operations before operating the 
server.

5.1 Memory Dump/Paging File Setting . . . . . . . . . . . . . . . . . . 136
5.2 Creating a Disk for System Recovery . . . . . . . . . . . . . . . . 146
5.3 Storing the System Configuration Information . . . . . . . . . . 148
5.4 Creating Maintenance Tools  . . . . . . . . . . . . . . . . . . . . . . 152
5.5 Notes before Operating the Server  . . . . . . . . . . . . . . . . . 157
5.6 LAN Driver Advanced Setup [BACS]  . . . . . . . . . . . . . . . . 161
5.7 LAN Driver Advanced Setup [Intel® PROSet] . . . . . . . . . . 166
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5.1 Memory Dump/Paging File Setting

Before starting operating this server, configure the setting for obtaining memory 
dump.

Memory Dump

If memory dump is set, debugging information will be automatically saved when a STOP error (fatal 
system error) occurs in the system. Using the saved memory dump, error cause can be analyzed. 
If the amount of installed memory is large, pay special attention when setting the memory dump file. 
The settings for obtaining memory dump should be configured after installing the files to be used for 
operations (OS, applications, etc.).

5.1.1 How to Obtain Memory Dump for 
Windows Server 2003 and Windows Server 2003 x64

Check the following settings before starting configuration to obtain memory dump.

Checking Hard Disk Free Space
To obtain memory dump, sufficient hard disk capacity is required for creating paging files and memory 
dump files.
The obtainable dump types and required hard disk capacity are as follows: 

Complete Memory (Full) Dump (recommended)

When the system unexpectedly stops, contents of the whole system memory are recorded. The file is 
stored in the directory displayed in the [Dump file] box.
• Paging file: Installed physical memory + 11MB (Recommended: Installed physical memory x 1.5)
• Memory dump file: Same amount as installed physical memory

Complete memory dump cannot be used on the computer in which the 2GB or more memory is 
installed.
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Kernel Memory Dump

Information of only kernel memory space is recorded. The file is stored in the directory displayed in the 
[Dump file] box. Capacity required for kernel memory dump is as follows:
• Paging file: Depending on installed physical memory amount

For memory of 256 to 1,373MB - Installed physical memory x 1.5
For memory of 1,374MB or more - 32-bit system: 2GB + 16MB, 64-bit system: Installed physical 
memory + 128MB

• Memory dump file: Depending on the used amount of kernel-mode address space during STOP

Small Memory Dump

Minimum amount of useful information for problem identification is recorded. If this option is specified, 
a new file is created each time the system unexpectedly stops.
History of such files is stored in the directory displayed in [Small dump directory]. 
• Paging file: 2MB or more
• Memory dump file: 64KB or 128KB

Memory Dump File Setting
Set up the memory dump file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the memory dump file is to be stored. 
Check the required amount of free space according to "  Checking Hard Disk Free Space" 
( pg.136).
If the drive has no free space, refer to "  Cannot Collect the Memory Dump" ( pg.248). 

3 Click [Start] → [Control Panel] → [System].
The [System Properties] window appears. 
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4 Click the [Advanced] tab and click [Settings] in [Startup and Recovery].
The [Startup and Recovery] window appears. 

5 Set as follows:
1. In the [Write debugging information] section, select the memory dump file type. 

• Complete memory dump (Recommended)
The whole system memory information is recorded to the memory dump file.

• Kernel memory dump
Only kernel memory is recorded to the memory dump file.

• Small memory dump (64KB)
Minimum information is recorded to the memory dump file. 
Each time a fatal error occurs, a new file is created in the directory specified in [Small 
dump directory].

2. In [Dump file] or [Small dump directory], specify the directory to save the memory 
dump file, with its full path.
In case of kernel memory dump or complete memory dump, if [Overwrite any existing file] 
is checked, debugging information is overwritten to the specified file every time.

6 Click [OK] to close the [Startup and Recovery] window. 

7 Click [OK] to close the [System Properties] window. 

8 Restart the system.
The setting is enabled after the system is restarted.
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Paging File Setting
Set up the paging file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the system is installed. 
Check the required amount of free space according to "  Checking Hard Disk Free Space" 
( pg.136).
If the drive has no free space, refer to "  Cannot Collect the Memory Dump" ( pg.248). 

3 Click [Start] → [Control Panel] → [System].
The [System Properties] window appears. 

4 Click the [Advanced] tab and click [Settings] in [Performance].
The [Performance Options] window appears. 

5 Click the [Advanced] tab.
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6 Click [Change] in the [Virtual memory] section. 
The [Virtual Memory] window appears. 

7 Specify the drive where the paging file is to be created.
In [Drive], select the drive where the system is installed.
The selected drive is displayed in [Drive] in [Paging file size for selected drive].

8 Select [Custom size] and enter a value in [Initial size]. 
The value depends on the type of the set dump file. 
Specify a value larger than the value shown in [Recommended] in [Total paging file size for all 
drives]. 

When a smaller value is specified for the paging file size, performance may be affected. For
maximum system efficiency, be sure to set [Initial size] with a value larger than the [Recom-
mended] size described in [Total paging file size for all drives]. The recommended size is total
memory installed in the system x 1.5. However, if a program consuming a large amount of
memory is regularly used, set a larger size as required.

9 Enter a value in [Maximum size]. 
Specify a value larger than the [Initial size]. 

10 Save the settings.
Click [Set] in the [Paging file size for selected drive] section.
The settings are saved, and the value specified is displayed in [Paging File Size] of [Drive].

11 Click [OK] to close the [Virtual Memory] window. 

12 Click [OK] to close the [Performance Options] window. 

13 Click [OK] to close the [System Properties] window. 
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14 Restart the system.
The setting is enabled after the system is restarted.

5.1.2 How to Obtain Memory Dump for 
Windows 2000 Server

Check the following settings before starting configuration to obtain memory dump.

Checking Hard Disk Free Space
Once memory dump is obtained, a file containing contents of the whole physical memory installed in the 
system is created. Before storing the dump file, confirm that there is sufficient free space in the hard 
disk.
The obtainable dump types and required hard disk capacity are as follows: 

Complete Memory (Full) Dump (recommended)

When the system unexpectedly stops, contents of the whole system memory are recorded. If this option 
is selected, space to retain the paging file as large as the whole physical memory × 1.3 is required in the 
boot volume.
• Included information

Common header, all virtual address pages that are not paged out during STOP
• Required size

Installed physical memory × 1.3

Complete memory dump cannot be used on the computer in which the 2GB or more RAM is installed.

Kernel Memory Dump

Information of only kernel memory space is recorded. When the system unexpectedly stops, the process 
that records information to the log file is speeded up. According to the amount of memory installed in 
the server, available area of 50 to 800MB is required for the paging file in the boot volume.
• Included information

Common header, summary dump header (complete memory dump) - (user process space page) - 
(cache region page) - (unused pool region page)

• Required size
Depending on the used amount of kernel-mode address space during STOP
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Small Memory Dump

Minimum amount of useful information for problem identification is recorded. In this option, a paging 
file of at least 2MB is required in the boot volume. Also, a new file is created each time the system 
unexpectedly stops.
History of such files is stored in the directory displayed in [Small dump directory] (usually, 
C:\winnt\minidump).
• Included information

Common header, minidump header, kernel module, memory information, processor information, 
process information, threads information, stuck page, unloaded module information

• Required size
2MB or more

Memory Dump File Setting
Set up the memory dump file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the memory dump file is to be stored. 
Check the required amount of free space according to "  Checking Hard Disk Free Space" 
( pg.141).
If the drive has no free space, refer to "  Cannot Collect the Memory Dump" ( pg.248). 

3 Click [Start] → [Settings] → [Control Panel].

4 Double-click the [System] icon.
The [System Properties] window appears. 

5 Click the [Advanced] tab and click [Startup and Recovery].
The [Startup and Recovery] window appears. 



143

PRIMERGY TX150 S5 User’s Guide

5

O
perations after O

S
 Installation

6 Set as follows:
1. In the [Write debugging information] section, select the memory dump file type. 

• Complete memory dump (Recommended)
The whole system memory information is recorded to the memory dump file.

• Kernel memory dump
Only kernel memory is recorded to the memory dump file.

• Small memory dump (2MB or more)
Minimum information is recorded to the memory dump file. 
Each time a fatal error occurs, a new file is created in the directory specified in [Small 
dump directory].

2. In [Dump File] or [Small dump directory], specify the directory to save the memory 
dump file, with its full path.
In case of kernel memory dump or complete memory dump, if [Overwrite any existing file] 
is checked, debugging information is overwritten to the specified file every time.

7 Click [OK] to close the [Startup and Recovery] window. 

8 Click [OK] to close the [System Properties] window. 

9 Restart the system.
The setting is enabled after the system is restarted.
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Paging File Setting
Set up the paging file according to the following procedures:

1 Log on to the server with administrator privileges.

2 Check free space of the drive where the system is installed. 
Check the required amount of free space according to "  Checking Hard Disk Free Space" 

( pg.141). If the drive has no free space, refer to "  Cannot Collect the Memory Dump" 
( pg.248). 

3 Click [Start] → [Settings] → [Control Panel].

4 Double-click the [System] icon.
The [System Properties] window appears. 

5 Click the [Advanced] tab and click [Performance Options].
The [Performance Options] window appears. 
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6 Click [Change] in the [Virtual memory] section. 
The [Virtual Memory] window appears. 

7 Specify the drive where the paging file is to be created.
In [Drive], select the drive where the system is installed.
The selected drive is displayed in [Drive] in [Paging file size for selected drive].

8 Specify the [Initial size].
The value depends on the type of the set dump file. 
Specify a value larger than the value shown in [Recommended] in [Total paging file size for all 
drives].

When a smaller value is specified for the paging file size, performance may be affected. We
recommend to specify the paging file size larger than the recommended value.

9 Specify the [Maximum size].
Specify a value larger than the [Initial size]. 

10 Save the settings.
Click [Set] in the [Paging file size for selected drive] section.
The settings are saved, and the value specified is displayed in [Paging File Size] of [Drive].

11 Click [OK] to close the [Virtual Memory] window. 

12 Click [OK] to close the [Performance Options] window. 

13 Click [OK] to close the [System Properties] window. 

14 Restart the system.
The setting is enabled after the system is restarted.
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5.2 Creating a Disk for System 
Recovery

If the installation of the OS was performed manually, create a system recovery disk.

If the system file, system configuration or environment setting change at startup, etc., is damaged, 
such data can be reconstructed using the recovery information stored in the created system recovery 
disk.
To create a recovery disk, you need an unused formatted floppy disk. Prepare it in advance.

5.2.1 Creating the Automated System Recovery (ASR) Set
for Windows Server 2003 and Windows Server 2003 
x64

After setting up Windows Server 2003, create a system recovery set. To do this, you need an unused 
formatted floppy disk and a medium to store back up files.

1 Click [Start] → [All Programs] → [Accessories] → [System Tool] → [Backup].
The [Backup or Recovery Wizard] window appears.

2 Click [Next].
The [Backup or Recovery] window appears.

3 Select [Create a backup of files and settings], and then click [Next].
The [Items to Create Backups] window appears

4 Select [All the information in this computer], and then click [Next].
The [Backup Type, Destination and Name of the Backup File] window appears.

5 Specify name and destination of the backup file, and then click [Next].
The [Backup or Recovery Wizard Complete] window appears.

6 Click [Finish].
Backup process starts.

7 If a message prompts you to insert a floppy disk, insert the floppy disk and click 
[OK].
Automated system recovery disk is created.
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8 When the process is completed, a message appears. Eject the floppy disk 
according to the message and put a label on it.
Label Example: "Windows Automated System Recovery Disk: Backup.bkf, Created at 12:00 04/
01/2003"

9 Click [OK] to exit [Backup Utility].

10 Click [Close] to close the [Backup Progress] window.
An automated system recovery set has been created.
Store the automated system recovery set just created in a secure location.

5.2.2 Creating a System Recovery Disk
for Windows 2000 Server

After setting up Windows 2000 Server, create a system recovery disk. To do this, you need an unused 
formatted floppy disk.

1 Put a label showing "Windows 2000 system recovery disk" onto a floppy disk 
and insert it into the floppy disk drive.

2 Click [Start] → [Programs] → [Accessories] → [System Tools] → [Backup].
The backup window appears.

3 Click the [Wizard] tab and click [System Recovery Disk].
Create a system recovery disk by following the window instructions.
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5.3 Storing the System Configuration 
Information

Before starting operations and when changing the system configuration information, 
store the configuration information. By storing this information, the system can be 
recovered with the stored information in case of a system failure (such as when the 
baseboard fails). Use Server Management Tools for storing and recovering the 
system configuration information.

Since the system configuration information is significant in maintaining the server, be sure to store the 
configuration information after the following operations:
• When the information is changed with the BIOS Setup Utility
• When the hardware configuration of this server is changed (e.g. CPU, memory, baseboard or 

expansion card is added/removed or changed)
• When the Remote Management Controller information is changed
As the stored system configuration information will be used for maintenance operation.

Cautions

• "Server Management Tools" disk is exclusively for this server. Do not use it on other systems. 
Otherwise, the systems may be damaged.

• Only the information that is configured with the BIOS Setup Utility and the configuration 
information of the Remote Management Controller can be stored/recovered. However, a user account 
for the Remote Management Controller and the license information of the Remote Management 
Controller Upgrade Kit cannot be stored.

• Make sure to perform this operation only when the server is started with the "Server Management 
Tools" disk. Do not run Server Management Tools on the server started from the hard disk or by the 
other floppy disk. Otherwise, the system may be damaged.

• Do not eject a floppy disk while the floppy disk access LED is on. Such an action may lead not only 
to corruption of the floppy disk data but also an unstable state of the system.

• If an error message appears while running Server Management Tools, respond to the message 
according to "  Server Management Tools Error Messages" ( pg.244).
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5.3.1 Storing the BIOS Information and the Remote 
Management Controller Information

Store the BIOS information and the Remote Management Controller information according to the 
following procedures.

Before starting the operation, if the "OS Boot Monitoring" function of ServerView is enabled, disable it 
(it is disabled by default).
 If you start up the system while the "OS Boot Monitoring" function remains effective, the operation of 
the server may become unpredictable at such times as an abrupt power interruption or restart.
If it is necessary to operate the server with the "OS Boot Monitoring" function enabled, enable the 
function after storing the BIOS/Remote Management Controller information. 
For details of ServerView, refer to "ServerView User’s Guide".

1 Turn on the server and insert the "Server Management Tools" disk into the 
floppy disk drive.
The window for selecting a keyboard appears.

2 Select a keyboard.
Select [1] for Japanese keyboard or select [2] for English keyboard. Japanese keyboard is 
selected by default.

3 When the DOS prompt window appears, enter the following command and 
press the [Enter] key.

A:\ SMT\>biossave.bat

4 If the BIOS information or the Remote Management Controller information is 
stored correctly, the following message appears.

5 Confirm that the stored information files are created.
Enter the following command to display the stored information files which are created.
A:\SMT>dir
The BIOS information has been stored. The server can now be turned off safely.

Please select:
   1 = JP Keyboard
   2 = US Keyboard
Your selection

NORMAL END
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5.3.2 Recovering the BIOS Information 

If the information configured with the BIOS Setup Utility was deleted due to a drain of the built-in 
server battery, etc., restore the BIOS information according to the following procedures. 

Do not turn off the server while a program is running.
Before starting up the system, check that the "OS Boot Monitoring" function of ServerView is disabled 
(it is disabled by default).
If you start up the system while the "OS Boot Monitoring" function remains effective, the operation of 
the server may become unpredictable at such times as an abrupt power interruption or restart. If the 
server is operated with the "OS Boot Monitoring" function enabled, enable the function again before 
resuming operation. For details of ServerView, refer to "ServerView User’s Guide".

1 Turn on the server and insert the "Server Management Tools" disk into the 
floppy disk drive.
The window for selecting a keyboard appears.

2 Select a keyboard.
Select [1] for Japanese keyboard or select [2] for English keyboard. Japanese keyboard is 
selected by default.

3 When the DOS prompt window appears, confirm that the BIOS stored 
information files are in the floppy disk.
Enter the following command to confirm that the stored information files are in the floppy disk.
A:\SMT>dir

4 Enter the following command and press the [Enter] key
A:\SMT>biosrest.bat

5 If the BIOS information is restored correctly, the following message appears.

6 The BIOS information will be enabled after the next system restart. Restart the 
server.
Perform Step 1 to display the DOS prompt window.
 The restoration procedure has been completed. The server can now be turned off safely.

Please select:
   1 = JP Keyboard
   2 = US Keyboard
Your selection

NORMAL EBD
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5.3.3 Recovering the Remote Management Controller 
Information 

If the Remote Management Controller information is changed to the default setting due to a baseboard 
failure, etc., restore the information according to the following procedures. 

Do not turn off the server while a program is running.
Before starting up the system, check that the "OS Boot Monitoring" function of ServerView is disabled 
(it is disabled by default).
If you start up the system while the "OS Boot Monitoring" function remains effective, the operation of 
the server may become unpredictable at such times as an abrupt power interruption or restart. If the 
server is operated with the "OS Boot Monitoring" function enabled, enable the function again before 
resuming operation. For details of ServerView, refer to "ServerView User’s Guide".

1 Turn on the server and insert the "Server Management Tools" disk into the 
floppy disk drive.
The window for selecting a keyboard appears.

2 Select a keyboard.
Select [1] for Japanese keyboard or select [2] for English keyboard. Japanese keyboard is 
selected by default.

3 When the DOS prompt window appears, confirm that the Remote Management 
Controller stored information files are in the floppy disk.
Enter the following command to confirm that the files are created.
A:\SMT>dir

4 Enter the following command and press the [Enter] key
A:\SMT>irmcrest.bat

5 If the Remote Management Controller information is restored correctly, the 
following message appears.

6 Turn off the server, unplug the power cable, reconnect it after 10 seconds or 
more, and then turn on the server for restored Remote Management Controller 
information to be enabled.

Please select:
   1 = JP Keyboard
   2 = US Keyboard
Your selection

NORMAL EBD
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5.4 Creating Maintenance Tools

This section explains how to create tools for maintaining the server.
Maintenance tools are created with the FloppyBuilder function of ServerStart.

With the FloppyBuilder function of ServerStart, you can create the following tool:
• Hardware Configuration Tool
• DOS Diskette

The FloppyBuilder can be used under environments such as:
• the ServerStart system started on a client computer (recommended)
• the system started on the server using the ServerStart CD-ROM

When creating the tools on a client computer, it is necessary to install ServerStart on the client 
computer beforehand. Install it according to "2.4 Preparation for Using ServerStart on a Client 
Computer" ( pg.52).
If ServerStart of a different version is installed in the computer, make sure to uninstall the ServerStart. 
Then perform installation again. For details on how to uninstall ServerStart, refer to "2.4.2 Uninstalling 
ServerStart" ( pg.54).

5.4.1 Creating a Hardware Configuration Tool

This section explains how to create a Hardware Configuration Tool from the ServerStart CD-ROM.
Prepare floppy disks as many as the tools you want to create beforehand.
Types of a Hardware Configuration Tool vary by model.
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Starting ServerStart

For Creation on a Client Computer

1 Insert the ServerStart Disc 1 CD-ROM into the client computer's CD-ROM 
drive.

2 Click [Start] → [Programs] → [Fujitsu ServerStart] → [ServerStart].
ServerStart starts up and the [Welcome to ServerStart] window appears.

For Creation on the Server

1 Turn on the server and insert the ServerStart Disc 1 CD-ROM immediately after 
that.
ServerStart starts up and a message prompts you to insert the ServerStart floppy disk.

2 Insert the attached "ServerStart floppy disk" into the server's floppy disk drive. 
Then make sure "Removable media" and "A:" are selected and click [Create].
A network setup window for remote installation appears.

If a configuration file already exists in the ServerStart floppy disk and [OK] is clicked without
clicking [Create], the [ServerStart Unattended Mode] window appears. Make sure to click
[Exit]. The [Welcome to ServerStart] window appears.
If [Start] is clicked in the [ServerStart Unattended Mode] window, the installation of the server
will start and all disk contents will be deleted.
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3 Click [OK].
The [Initializing ServerStart] window appears and the ServerStart initialization process starts. 
Depending on the hardware configuration, this process may take a few minutes. When the 
process is completed, the [Create a ServerStart Floppy Disk] window appears.

4 Click [or Insert a ServerStart Floppy Disk to Start ServerStart].
The [Welcome to ServerStart] window appears.

5 Eject the ServerStart floppy disk.
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Creating a Hardware Configuration Tool
Start up ServerStart and confirm that the [Welcome to ServerStart] window is displayed.

1 Start up ServerStart and click [FloppyBuilder].
The [ServerStart FloppyBuilder] window appears. 

2 Click [Hardware Configuration Tools].

3 Click the tool you want to create.
Insert the prepared floppy disk by following the message.

4 Perform the subsequent operations according to the messages on the window.
The floppy disk will be formatted automatically and file copying will start.
The respective tools will be created automatically. When a message appears indicating that the 
disk is created, click [OK] and eject the disk.
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5.4.2 Creating a DOS Diskette

For DOS data stored into the floppy disk, refer to the file in the following folder of the ServerStart Disc 
1 CD-ROM. 
[CD-ROM drive] :\FreeDOS
To create a DOS diskette, you need an unused floppy disk. Prepare it in advance.

1 Start up ServerStart and Click [FloppyBuilder].
For details on procedures for starting up ServerStart, refer to "  Starting ServerStart" ( pg.153).

2 Click [DOS Diskette].
Insert the prepared floppy disk by following the message.

3 Perform the subsequent operations according to the messages on the window.
The floppy disk will be formatted automatically and file copying will start.
The DOS diskette will be created automatically.
When a message appears indicating that the disk is created, click [OK] and eject the disk.
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5.5 Notes before Operating the 
Server

This section explains the settings required before starting to operate the server.
For details on the settings, refer to the following URL.
http://www.microsoft.com/technet/prodtechnol/exchange/2003/Library/default.mspx

• If a LAN card was added, install a driver according to "4.3 Installing the LAN Driver" ( pg.128).
• When connecting a SCSI optional device (such as a DAT), connect it according to "Chapter 7 

Installing Hardware Options" ( pg.177).
• For the settings for the installed applications supplied with the product, refer to the manuals of each 

application.

5.5.1 Applying the Hotfix

A hotfix needs to be applied in order to operate the server. For the hotfix, use the "ServerStart Disc 1 
CD-ROM" supplied with the server. 

Installing Windows 2000 Server
To install Windows 2000 Server directly, you have to use Service pack 4 integrated OS media or install 
Service Pack 4 or newer Service Pack. 
And please install hotfix module named KB904374 after OS installation. 
Please find out hotfix module of your language version from the following folder on ServerStart CD. 
[CD-ROM drive]: \HOTFIX\W2K\

http://www.microsoft.com/technet/prodtechnol/exchange/2003/Library/default.mspx
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5.5.2 Auto-run Function from CD-ROM Drives

Perform the following procedures to change the settings of the auto-run function from the CD-ROM 
drives after server installation:

1 Make the registry editable, and change the value of AutoRun of the following 
registry key:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\CDRom
Set the value of Autorun to "1" to enable auto-run, and set the value to "0" to disable auto-run.

2 Restart the system.
The setting is enabled after the system is restarted.

5.5.3 Drive Letter Assignment in Expert Mode

In expert mode, you cannot specify a drive letter to a particular partition arbitrarily. Drive letters 
specified with Disk Manager in expert mode will be sequentially assigned from the first partition with 
"C, D, E..." when installation is completed, and an unused drive letter will be assigned to the CD-ROM 
drive.
To change the drive letter, perform the following procedures after installation.

You cannot change the drive letters for the system and boot drive.

For Windows Server 2003

1 Click [Start] → [Administrative Tools] → [Computer Management].

2 Click [Disk Management].

3 Right-click the partition to change the letter and click [Change Drive Letter and 
Path].
The [Change Drive Letter and Path] window appears.

4 Click [Edit].
The [Change Drive Letter or Path] window appears.

5 Change the drive letter.

For Windows 2000 Server

1 Right-click [My Computer] icon on the desktop and select [Manage].

2 Click [Disk Management].
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3 Right-click the partition to change the letter and select [Change Drive Letter 
and Path].
The [Change Drive Letter and Path] window appears.

4 Click [Edit].
The [Change Drive Letter or Path] window appears.

5 Change the drive letter.

5.5.4 Notes on Advanced Uninterruptible Power Supply 
(UPS)

Note the following points when using an advanced uninterruptible power supply (referred to as UPS 
afterward).

UPS Shutdown Time Setting
Specify enough time for the UPS power-off time (time from the shutdown direction to the actual power-
off). If this time is set insufficiently, the power will be cut off before system shutdown, which may result 
in destruction of data. For more details, refer to the manuals for UPS and UPS management software.

Power Supply Control by UPS
Change the BIOS Settings to turn on the server automatically at power recovery or during scheduled 
operation using the UPS management software (PowerChute Network Shutdown, PowerChute Business 
Edition). 

1 Start the BIOS Setup Utility.
"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.213)

2 Select the [Power On/Off] submenu from the [Advanced] menu, and press the 
[Enter] key.
The [Power On/Off] submenu window appears.

3 Set [Power Failure Recovery] to [Always On].

4 Save changes and exit the BIOS Setup Utility.

5.5.5 Turning the Power On via a LAN

You can turn the power on the server from a client (via a LAN) by utilizing the Wakeup on LAN (WOL) 
function.

Be sure to install ServerView to control the power supply via a LAN.
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When the power cable is disconnected from the server or the server is powered off due to power 
interruption, restart the server. Unless the server is restarted, the WOL function will be disabled.
Only the onboard LAN supports the WOL function on this server. To control power supply via a LAN, 
make sure you connect the onboard LAN and set the onboard LAN adapter bind to "1".

BIOS Setup Utility Setting
When power management is performed via a LAN, configure the settings as follows using the BIOS 
Setup Utility. This is set to "Enabled" by default.

1 Start the BIOS Setup Utility.
"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.213)

2 Select the [Power On/Off] submenu from the [Advanced] menu, and press the 
[Enter] key.
The [Power On/Off] submenu window appears.

3 Set [Power On Source:LAN] to [Enabled]. 

4 Save changes and exit the BIOS Setup Utility.

To start up the server via a LAN, refer to "  Performing Remote Installation" ( pg.43).

5.5.6 Other Notes on Operation

Unnecessary Files
After OS installation is completed, folders named Runonce and Runonce 2 may be left in the drive 
where the OS is installed. Delete these folders since you do not need them for the system operation.

Notes on 24-hour Operation

Automated System Operation

To provide an extra margin of safety against unintentional damage, introduce disaster-prevention 
measures in the office and keep disaster prevention personnel (such as a security guard or janitor) in the 
building.

Unintentional Power-off Prevention

We recommend the installation of a special power supply device (such as a distribution board) to 
prevent unplanned power shut-offs.
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5.6 LAN Driver Advanced Setup 
[BACS]

BACS is an integrated GUI application consisting of programs such as BASP 
(Broadcom Advanced Server Program) that provides the load balancing feature, etc., 
by teaming up multiple adapters. BACS is used in the following situations:
• Setup a VLAN using the onboard LAN
• Perform the other advanced setups of the onboard LAN

Use of Intel® PROSet

Use Intel® PROSet ( pg.166) to perform the following advanced setups of a LAN card:
• Use the Teaming function between LAN cards or between a LAN card and the onboard LAN
• Setup a VLAN using a LAN card
• Perform the other advanced setups of a LAN card

5.6.1 BACS Installation

If [Broadcom Control Suite 2] is not displayed in the [Control Panel], install BACS according to the 
following installation procedures:

For Windows Server 2003 x64

1 Execute the following file contained in the ServerStart Disc 1 CD-ROM.
[CD-ROM drive]: \PROGRAMS\GENERAL\Broadcom\MgmtApps_x64\setup.exe
The installer starts up.
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2 Click [Next].
License agreement window appears.

3 Click [I accept the terms in the license agreement] and click [Next].
Custom Set up window appears.

4 Click [Next].
Proceed the installation by following the window instruction.
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For Windows Server 2003, Windows 2000 Server

If the OS is installed using ServerStart, "BACS" is already installed with the driver. If the OS is installed 
manually, BACS will not be installed.

1 Execute the following file contained in the ServerStart Disc 1 CD-ROM.
[CD-ROM drive]: \PROGRAMS\GENERAL\Broadcom\MgmtApps\setup.exe
The installer starts up.

2 Proceed the installation by following the window instructions.
When the window below appears during the installation procedure, check [BASP] and click 
[Next].

5.6.2 VLAN Setup Procedure

1 Start up BACS. The procedure differs depending on the OS being used.
For Windows Server 2003 / Windows Server 2003 x64

1. Click [Start] → [Control Panel] → [Broadcom Control Suite 2].
For Windows 2000 Server

1. Click [Start] → [Settings] → [Control Panel].
The [Control Panel] window appears.

2. Start up "Broadcom Control Suite 2".

2 Right-click a LAN adapter or the Team name of a teamed up adapter and click 
[Create a VLAN] or [Add VLAN] from the displayed menu.

A LAN adapter is displayed with a  mark.
The Team name of a Teamed Up adapter is displayed with a  mark.
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3 Click [Expert Mode] on the [Broadcom Teaming Wizard].

4 Specify [Team Name], [VLAN ID], and [VLAN Name] in the [Create New VLAN] 
window.
The [Team Name] is not displayed when the [Add VLAN] window appears.
The [VLAN ID] should be identical with the switch setting.
The [VLAN Name] does not need to be identical with the switch setting.

You cannot use a "VLAN ID" or "VLAN Name" that has already been used. Enter another set
value.

5 When the setting for the team is completed, click [OK].

6 Click [Apply] to apply the settings.
After the network is temporarily disconnected, a window is displayed. Click [Yes (Y)].
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5.6.3 Cautions for Onboard LAN Driver Ver9.25.0.0

Event Log
Once a Team and VLAN are setup, multiple logs that start with the following log may be stored in the 
system log file of the event viewer at system start-up.

Since such event logs will be stored even if the Teaming function and VLAN function are operated 
normally, ignore them.

Source Blfm 

ID 8

Type Error

Description  Could not bind to adapter \DEVICE\{(adapter name)}.
  * (adapter name) varies depending on the OS or hardware 
configuration. 
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5.7 LAN Driver Advanced Setup 
[Intel® PROSet]

"Intel® PROSet" is a tool for configuring details on the LAN driver. This is used in the 
following cases.
• Use the Teaming function between LAN cards or between a LAN card and the 

onboard LAN
• Setup a VLAN using a LAN card
• Perform the other advanced setups of a LAN card

Use of BACS

Use BACS ( pg.161) to perform the following advanced setups of the onboard LAN:
• Setup a VLAN using the onboard LAN
• Perform the other advanced setups of the onboard LAN

5.7.1 Intel® PROSet Installation

If the tabs such as [Link], [Teaming] and [VLANs] are not displayed in the property of LAN adapters 

which can be selected from the [Device Manager], install Intel® PROSet according to the following 
installation procedures:

1 Execute the following file contained in the ServerStart Disc 1 CD-ROM.
For Windows Server 2003 x64

[CD-ROM drive]:\Tools\GENERAL\Intel\ProSet\Ws03_32e\InstPROSet.EXE
For Windows Server 2003 / Windows 2000 Server

[CD-ROM drive]:\Tools\GENERAL\Intel\ProSet\Ws03xp2k\InstPROSet.EXE

2 Click [Next].

3 Click [Accept].

4 Select [complete] for [Setup type] and click [Next].

5 Click [Install].

6 Click [Finish].



167

PRIMERGY TX150 S5 User’s Guide

5

O
perations after O

S
 Installation

5.7.2 Cautions for PG-185x/186x/188x/189x/286x LAN 
Driver V10.3

Event Log
Once a Team is setup, multiple identical logs from the same source that starts with the following log 
may be stored in the system log file of the event viewer at system start-up.

Since such event logs will be stored even if the Teaming function is operated normally, ignore them.

5.7.3 Teaming Function

Notes
When using the Teaming function, note the following points.
• You require Service Pack 2 or later for Windows 2000 Server.
• For AFT/ALB/Static link type, you can incorporate up to four LAN ports into one team and two ports 

for a SFT type team.
• Once a Team is created, virtual adapters (Team:(Team Name)) will be created in the [Device 

Manager] and/or [Network and Dial-up Connections] of the system. Do not disable or delete this 
virtual adapter from the [Device Manager] or [Network and Dial-up Connections]. When deleting a 

virtual adapter, make sure to use "Intel® PROSet".
• When the Teaming function is being used, you can only use the following protocols:

• For AFT/SFT/Static link type: IP, NetBEUI, IPX (NCP), IPX (NetBIOS)
• For ALB type: IP, IPX (NCP)

• When the Teaming function is being used, you cannot use the hardware assist function of IPSEC. Do 
not use this function even if the function is installed in all cards in the team.

• When the Teaming function is being used, you cannot use Windows Load Balancing Service 
(WLBS) and Network Load Balancing (NLB).

• If Static link type is selected, you can only use the switch for link aggregation.
• When adding/deleting a Static link type member, perform such operation under a linked down state.
• If the onboard LAN is set to RemoteControlService and Team is configured on the onboard LAN, 

remote control function with RemoteControlService does not work properly.

Source iANSMiniport

ID 11

Type Warning

Description The following adapter link is not connected: (adapter name)
 * (adapter name) varies depending on the OS or hardware configuration.
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• The team with the Intel® PROSet Broadcom onboard LAN and the Intel LAN card can be 
configured, but note the following points.
• The team cannot be configured with only Broadcom onboard LANs. It is necessary to incorporate 

in Intel LAN card more than one port. 
• Make sure to set any port of the Intel LAN card as [Set Primary]. To configure it, click the 

[Settings] tab and [Modify Team...], select the LAN card, and click [Set Primary].

Only a link down error between a LAN card (onboard LAN) and the switch it connects with, and the 
equivalent errors lead to switching of the route. Therefore, if only the switch or LAN card (onboard 
LAN) is partially damaged and the route being used is sound at the link level, the route will not be 
switched in the team, but the communication with the Team may become an error.

Teaming Configuration Procedure

1 Start up Intel® PROSet. The procedure differs depending on the OS being 
used.

For Windows Server 2003
Click [Start] → [Administrative Tools] → [Computer Management].

For Windows 2000 Server
Click [Start] → [Programs] → [Administrative Tools] → [Computer Management].

2 Click [Device Manager] and double-click a LAN adapter to incorporate in a 
Team.

3 Click the [Teaming] tab, select [Team with other adapters] and click [New 
Team].

4 Enter a team name and click [Next].

5 Check the LAN adapter to incorporate in the Team and click [Next].

Do not check an onboard LAN (do not incorporate it in a Team) if the onboard LAN is con-
trolled remotely by RemoteControlService. 

6 Select a Teaming type with which you want to create a Team.
Select the following depending on the Teaming type selected accordingly:
• AFT type: "Adapter fault tolerance"
• ALB type: "Adaptive load balancing"
• SFT type: "Switch fault tolerance"
• Static link type: "Static link aggregation"

7 Click [Finish].

8 Click [OK] to close the property window for created Teaming adapter.
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9 Click [OK] to close the property window for the LAN adapter.
When the Teaming setting is completed, the following virtual adapter will be created.
• "Team:(Team Name)"
Upper protocols will be bound with the main virtual adapter.
You cannot bind them with the LAN card consisting of a Team.
The IP address can be set in the main virtual adapter.

5.7.4 VLAN

Notes
When using a VLAN, note the following points.
• You can only have "NetBIOS over TCP/IP" enabled for up to four VLANs in the whole system.
• On a VLAN, do not use protocols other than TCP/IP.
• You can only set ten or less VLANs to a LAN port.
• When adding or deleting a VLAN, always use "Intel(R) PROSet". Do not disable or delete a VLAN 

from the [Device Manager] or [Network and Dial-up Connections].

VLAN Configuration Procedure

1 Start up Intel® PROSet. The procedure differs depending on the OS being 
used.

For Windows Server 2003
Click [Start] → [Administrative Tools] → [Computer Management].

For Windows 2000 Server
Click [Start] → [Programs] → [Administrative Tools] → [Computer Management].

2 Click [Device Manager] and double-click a LAN card to setup a VLAN.

3 Double-click the [VLANs] tab, and click [New...].

4 Specify [VLAN ID] and [VLAN Name]. Then click [OK].
The [VLAN ID] should be identical with the switch setting. 1 to 4094 can be specified. Any 
name can be specified as the [VLAN Name].

5 Click [OK] to close the property window for the LAN adapter.
When setup of the VLAN is completed, the following virtual adapter will be created.
• "(LAN Adapter Name)-VLAN:(VLAN Name)"

Upper protocols will be bound with the main virtual adapter. You cannot bind them with the 
LAN card consisting a VLAN. The IP address should be specified in the main virtual adapter.
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Chapter 6

High Reliability Tools

For stable PRIMERGY server operations, we 
recommend that high reliability tools be installed. 
This chapter explains the installation and 
necessary settings of high reliability tools.

6.1 RAID Management Tool  . . . . . . . . . . . . . . . . . . . . . . . . . 172
6.2 Server Monitoring Tool [ServerView]  . . . . . . . . . . . . . . . . 173
6.3 Solving Problems Early [DSNAP] . . . . . . . . . . . . . . . . . . . 175
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6.1 RAID Management Tool

RAID Management Tool is software that performs array configuration, disk 
initialization and disk array monitoring. For more details, refer to the manual in Array 
Controller Document & Tool CD.

OS installation using ServerStart

If the OS is installed using ServerStart, RAID Management Tool is installed with the OS and other high 
reliability tools. 

6.1.1 Installing RAID Management Tool 

To install RAID Management Tool individually using the standard installer, follow the procedures below.

Before installing RAID Management Tool, check that TCP/IP is installed and works properly.

1 Log on to the server with administrator privileges.

Exit all programs before starting installation.
Installation will fail if “Event Viewer” or “Computer Management” is run.

2 Insert the Array Controller Document & Tool CD. Click [Start] → [Run...].

3 Enter a name in the [Open:] field as follows and click [OK].
[CD-ROM drive]:\RAIDTOOL\SVRAID\Windows\install.bat

Installation starts and the wizard window appears.
For subsequent procedures, refer to Array Controller Document & Tool CD. 
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6.2 Server Monitoring Tool [ServerView]

ServerView constantly monitors the status of the servers' hardware in the network 
and provides a console with which the administrator can check the status of all the 
servers at a glance. When using ServerView, the server hardware is monitored all the 
time. If an error that could cause trouble is detected, the administrator is notified in 
real-time. This allows the server administrator to remove a system error early and 
avoid trouble. 

Importance of Monitoring the Server with ServerView
For safe operation of PRIMERGY, always monitor the server using ServerView. Even if the server is 
operated in the redundancy configuration, overlooking or neglecting errors could result in a system stop 
or data loss. As soon as one constituent part of the redundancy configuration fails, the corresponding 
countermeasures must be taken. For that reason, monitoring the server with ServerView is necessary.
If ServerView is not applied, the following very serious problems may occur.

RAID Error Monitoring
ServerView notifies of the RAID errors. In an environment where ServerView is not applied, the 
administrator is not notified of the RAID errors. Leaving the RAID error unattended may lead to a 
system stop with multiple dead drives.

Memory Monitoring
ServerView monitors the memory. In an environment where ServerView is not applied, a memory 
single-bit error cannot be detected during operation. In order to detect the error, the server must reboot to 
run the BIOS Setup Utility or the Server Management Tools. Leaving this error unattended may lead to 
multiple-bit errors and a system stop.

Fan Monitoring
ServerView monitors the fan. In an environment where ServerView is not applied, fan irregularities 
(failure/stop) cannot be detected during operation. In order to detect the problem, the server must reboot 
to run the BIOS Setup Utility or the Server Management Tools. Leaving the fan problem unattended 
may lead to overheating inside the server and a system stop.

Temperature Monitoring
ServerView monitors the temperature. In an environment where ServerView is not applied, the 
increased temperature inside the server, due to the fan problem described above, cannot be detected and 
the system stop cannot be prevented. In order to detect the problem, the server must reboot to run the 
BIOS Setup Utility or the Server Management Tools.

Voltage Monitoring
ServerView monitors the voltage. In an environment where ServerView is not applied, voltage 
irregularities cannot be detected during operation. In order to detect the problem, the server must reboot 
to run the BIOS Setup Utility or the Server Management Tools. As leaving the voltage surges, the server 
may malfunction or data loss may occur.
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Power Supply Monitoring
ServerView monitors the power supply. In an environment where ServerView is not applied, power 
supply irregularities cannot be detected during operation. In order to detect the problem, the server must 
reboot to run the BIOS Setup Utility or the Server Management Tools. System stops due to power 
supply failures cannot be prevented.

6.2.1 Installing ServerView

When Installed Using ServerStart

If the OS is installed using ServerStart, ServerView will be installed at once with the OS and other high 
reliability tools.

When Installed Manually (SBS 2003 / Linux)

ServerView cannot be installed using ServerStart. To install ServerView manually into a Linux system, 
refer to "Installing" in "ServerView User’s Guide".

Be sure to install SNMP service before installing ServerView.

When an error screen appears after ServerView installation 
(Windows Server 2003 only)

If Windows Server 2003 Service Pack 1 is applied, the following message may appear on restarting after 
installing/uninstalling ServerView.

There is no problem with operations. Click [Close Message] to close the message.

6.2.2 Setting Required after Installation

Perform necessary operations after ServerView installation referring to "2.4 Checking after Installation" 
in "ServerView User’s Guide".

Boot Monitoring Setting
We recommend enabling the "Boot Monitoring" function after ServerView is installed. For setting 
procedures and explanation on the function, refer to "[Restart Settings] Tab" of "3.4 Serious Error 
Handling (ASR)" in "ServerView User’s Guide".

In order to protect the computer, this program is terminated by 
Windows.
Name: SNMP Service
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6.3 Solving Problems Early [DSNAP]

DSNAP is a tool for collectively acquiring failure investigation information such as 
server environment information. 

OS installation using ServerStart

If the OS is installed using ServerStart, DSNAP is installed with the OS and other high reliability tools. 

6.3.1 Installing DSNAP

For Windows Server 2003 x64

Copy the following file stored in the ServerStart Disc 1 CD-ROM into the server's hard disk.
[CD-ROM drive]: \PROGRAMS\Japanese\DSNAPx64\DSNAPx64.EXE

For Windows Server 2003, SBS 2003, Windows 2000 Server

When installing DSNAP separately, copy the following file stored in the ServerStart Disc 1 CD-ROM 
into the server's hard disk.
[CD-ROM drive]: \PROGRAMS\Japanese\DSNAP\DSNAP.EXE

6.3.2 How to Use

For Windows Server 2003 x64

Refer to the following file stored in the ServerStart Disc 1 CD-ROM. Use a text editor to open it.
[CD-ROM drive]: \PROGRAMS\Japanese\DSNAPx64\README.TXT

For Windows Server 2003, SBS 2003, Windows 2000 Server

Refer to the following file stored in the ServerStart Disc 1 CD-ROM. Use a text editor to open it.
[CD-ROM drive]: \PROGRAMS\Japanese\DSNAP\README.TXT
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Chapter 7

Installing Hardware
Options

This chapter explains how to install and remove 
the various hardware options.

7.1 Before Installing Hardware Options  . . . . . . . . . . . . . . . . . 178
7.2 Removing and Attaching Covers  . . . . . . . . . . . . . . . . . . . 180
7.3 Installing Memory Modules  . . . . . . . . . . . . . . . . . . . . . . . 185
7.4 Installing Expansion Cards  . . . . . . . . . . . . . . . . . . . . . . . 189
7.5 Installing Internal Hard Disk Units  . . . . . . . . . . . . . . . . . . 192
7.6 Installing 5-inch Internal Options  . . . . . . . . . . . . . . . . . . . 198
7.7 Installing a Parallel Port Option  . . . . . . . . . . . . . . . . . . . . 204
7.8 Installing a Serial Port  . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
7.9 Connecting External SCSI Devices  . . . . . . . . . . . . . . . . . 210
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7.1 Before Installing Hardware 
Options

The following types of hardware options can be installed in this server. 

If the optional devices listed below are purchased, refer to the following to check the packaged items 
before installing.
• Memory "B.1 Memory" (pg.269)
• Internal Hard Disk Units "B.2 Internal Hard Disk Units" (pg.270)
• Parallel port option "B.3 Parallel Port Option" (pg.270)
• Serial port "B.4 Serial Port" (pg.271)
When installing and removing options, make sure to use the removed screws on the same devices that 
were last installed or removed. Failure to do so can damage the device.
The types of optional devices listed in this manual are liable to be updated without any notice. Please 
be forewarned.
When installing optional products (such as internal/external options and USB equipments), be sure to 
use the products in a system configuration diagram for stable PRIMERGY server operations. Fujitsu 
does not warrant that the server related products will operate properly if you use the unauthorized third 
party options. 

3.5 inch internal option

5 inch internal option

Expansion card

Memory

[Front][Rear]



179

PRIMERGY TX150 S5 User’s Guide
Installing hardw

are options

7

• Before installing/removing internal options to/from the server, turn off the 
server, all peripheral devices, and any other connected devices. Also unplug 
all power cables from the outlet. Failure to do so can cause electric shock 
("1.4.4 Turning Off the Server" ( pg.34)).

• Do not disassemble the PSU. Doing so can cause electric shock.

• Use our genuine internal options only. Failure to do so may cause a device 
failure, fire, or electric shock.

• Do not damage or modify internal cables or devices. Doing so may cause a 
device failure, fire, or electric shock.

• Devices inside the server remain hot after shutdown. Wait for approximately 
10 minutes after shutdown before installing or removing internal options.

• The circuit boards and soldered parts of internal options are exposed. They 
can be damaged by static electricity.
Before handling them, first touch a metal part of the server to discharge static
electricity.

• Do not touch the circuitry on boards and soldered parts. Hold the metallic 
areas or the edge of the circuit boards.

• When installing a 5-inch internal device, make sure to avoid pinching cables.
• If devices are installed or disassembled by other methods than those outlined 

in this chapter, the warranty will be invalidated.
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7.2 Removing and Attaching Covers

Remove covers to install peripheral devices. Perform the following procedures to 
remove covers. 

7.2.1 Removing Covers

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the hard disk cover.
Tilt the hard disk cover toward you and pull it up to remove.

• Before removing or attaching covers, turn off the server, all peripheral devices, 
and any other connected devices. Also unplug all power cables from the 
outlet. Failure to do so can cause electric shock ("1.4.4 Turning Off the Server" 
( pg.34)).
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3 Remove the side cover.
1. Remove the screws on the rear side.

Do not lose the screws.

2. Slowly slide the side cover to the rear side, and then tilt it toward you to remove it 
from the server.
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4 Remove the front cover.
The front cover is fastened with five tabs. Pull the left tabs first, and then remove the front cover 
while pressing the right tabs.

Remove the front cover as necessary, e.g., when you install a 5-inch internal device.

When removing the front cover, if the latches on the back of the front cover are hard to release from 
the frame, insert a long stick-shaped object inside the server, press the latch on the back of the front 
cover in the direction of the arrow (1), and release it (2), as shown in the figure below. The latch of the 
front cover may break if you try to release it by force.

Installing Covers
To attach covers, simply reverse the removal procedures.

• Before turning on the server, make sure that all covers are in place. 

• Check to make sure no tools or unnecessary components are left inside the 
server before attaching the side cover back into place.

Right tabs

Left tabs

Front cover

Latch
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7.2.2 Removing the Top Cover of the Rackmount Type

When the Rackmount Conversion kit (optional) is used, remove the top cover. The top cover of the 
rackmount type corresponds to the side cover of the tower type.

1 Open the rack door.
"1.4.2 Opening the Rack Door" (pg.31)

2 Remove all cables connected to the server. 

3 Remove the retaining screws used to fasten the server to the rack.

4 Slide the server.
Hold the handles from inside and pull the server out toward you until it clicks, so that it locks in 
place on the rails on both sides.

5 Remove the top cover. 
The procedures for removing the top cover is the same as that for removing the side cover. 
Remove the screws on the rear side. Slowly slide the top cover to the rear side, and then remove 
it from the server.

Locks

Handles
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Attaching the Top Cover
To attach the top cover, simply reverse the removal procedures. 

• Before turning on the server, make sure that all covers are in place. 

• Check to make sure no tools or unnecessary components are left inside the 
server before attaching the side cover back into place. 
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7.3 Installing Memory Modules

Additional memory will help increase the amount of data that can be read at a time 
and improve the server processing capability.

• When installing or removing memory, turn off the server, all peripheral 
devices, and any other connected devices. Also unplug all power cables from 
the outlet.
Failure to do so can cause electric shock.

• Use our genuine memory modules only.
Failure to do so may cause a device failure, fire, or electric shock.

• Wait for a sufficient period of time after server shutdown before installing or 
removing memory.
Failure to do so can cause burns.

injury • When installing or removing memory, make sure to remove the screws at the 
specified locations only. There is a risk of injury if screws other than those at 
the specified locations are removed. This could also damage the server.

• Touch only the specified part of the printed circuit board.
Failure to do so could cause injury or damage the server.

• Memory modules are made of delicate components that are extremely 
sensitive to static electricity, and they can be destroyed by static electricity 
from your clothes or body. Before handling them, first touch some metallic 
object to discharge static electricity.

• Do not insert and remove memory modules repeatedly. This could damage 
the server.

• Hold the edges of the memory module, as shown in the figure below. Do not 
touch the gold contacts and memory chip.

Do not touch this part.

Memory module

Memory chip
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7.3.1 Where to Install the Memory Module

Install memory modules to the memory slots in the server.

• DIMM1A: For basic RAM modules or memory modules that can be installed with the basic RAM 
module conversion kit.

• DIMM2A, DIMM1B, DIMM2B: For add-on RAM modules. 

7.3.2 Installable Memory Modules and Notes

Installable Memory Modules
The following memory module types can be used in this server. 

Order of Memory module Installation 

Install memory modules in the order of  DIMM1A, DIMM1B, DIMM2A and  DIMM2B.

table: List of Installable Memory Modules
Model Remarks 

Memory Module-512MB (PG-RM51BE) 512MB (512MB-DIMM x 1)

Memory Module-1GB (PG-RM1BE) 1GB (1GB-DIMM x 1)

Memory Module-2GB (PG-RM2BE) 2GB (2GB-DIMM x 1)

DIMM 2A
DIMM 1B
DIMM 2B

DIMM 1A



187

PRIMERGY TX150 S5 User’s Guide
Installing hardw

are options

7

7.3.3 How to Install Memory Module

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the side cover. 
"7.2 Removing and Attaching Covers" (pg.180)

3 Touch a metal part of the server to discharge static electricity. 

4 To replace the memory module, open outward the retention clips on both sides 
of the slot. 

5 Open the retention clips on both sides of the slot and insert the memory 
module. 
Align a notch of the memory module to correspond with the memory slot and insert the module 
perpendicularly to the slot.
When the module is correctly inserted, the retention clips on both sides will close. Then, check 
that they secure the memory module.
If the retention clips are not securely closed, push them with your fingers to close. 

6 Attach the side cover.

• Make sure not to open the clips outward too quickly because the 
memory module may pop up, which could cause damage. 

• An improperly engaged memory module could cause a fire. Do not 
insert the memory module on the wrong side. 
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7.3.4 Defective Memory Disconnection Function

This server is equipped with the defective memory disconnection function.
This function disconnects the memory judged to be defective (abnormal) during Power On Self Test 
(POST) to start the server. If the memory capacity is discovered to be smaller than the capacity of the 
memory installed during POST, there is a possibility of memory defect.
You can check the slot whose memory is defective from the system event log. 
Replace the defective memory, if discovered, and then restart the server. 

Replacing the Defective Memory 

1 Check the slot whose memory is defective from the system event log. 
"9.3 System Event Log" (pg.252)

2 Replace the defective memory with a new one according to "7.3.3 How to 
Install Memory Module" ( pg.187).

3 Start the BIOS Setup Utility.
"8.2.1 Starting and Exiting the BIOS Setup Utility" (pg.213)

4 Select the [Memory Status] submenu from the [Server] menu and check that  
replaced memory module is set to [Enabled].
If the item is set to [Failed], change the setting to [Enabled].
"  Memory Status Submenu" ( pg.230)

If it is not set to [Enabled], the server will start with the memory module recognized as being
defective and constantly disconnected. To use a new memory module, set the item to
[Enabled] for releasing the failed memory status at the next startup. 
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7.4 Installing Expansion Cards

This section explains the types of expansion card, notes and installation procedures.

7.4.1 Where to Install an Expansion Card

The server has five PCI slots to accommodate up to five expansion cards.
The specification is different according to the PCI slot number. 

• When installing or removing an expansion card, turn off the server, all 
peripheral devices, and any other connected devices. Also unplug all power 
cables from the outlet.
Failure to do so can cause electric shock.

• Install our genuine expansion cards only.
Failure to do so may cause a device failure, fire, or electric shock.

• Wait for a sufficient period of time after server shutdown before installing or 
removing expansion cards.
Failure to do so can cause burns.

injury • When installing or removing expansion cards, make sure to remove the screws 
at the specified locations only.
There is a risk of injury if screws other than those at the specified locations are
removed. This could also damage the server.

• Touch only the specified part of the printed circuit board.
Failure to do so could cause injury and also damage the server.

• Do not touch metal fixings of the main board on the rear side of the server. 
This could cause injury. This could also damage the server.

• Expansion cards are made of delicate components that are extremely 
sensitive to static electricity, and they can be destroyed by static electricity 
from your clothes or body. Before handling them, first touch some metallic 
object to discharge static electricity.

PCI slot 1 (PCI 32bit 33MHz)

PCI slot 2 (PCI-X 64bit 66MHz)

PCI slot 3 (PCI-X 64bit 66MHz) 

PCI slot 6 (PCI-Express x4)

PCI slot 7 (PCI-Express x1)
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7.4.2 Installable Expansion Cards and Notes

Installable Expansion Cards

Order of Expansion Card Installation
Install expansion cards into the slots in accordance with the priority indicated in the following table.

Follow the "Installation order" shown in the table when installing the cards and drivers. If you turn on 
the power after installing multiple expansion cards simultaneously or in a wrong order, they will not 
function properly.

Notes on Installing Expansion Cards

• Install installable expansion cards only.
• Before installing an expansion card, refer to the manual supplied with the options.

7.4.3 How to Install Expansion Cards

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the side cover. 
"7.2 Removing and Attaching Covers" (pg.180)

3 Touch a metal part of the server to discharge static electricity. 

table: List of Installable Expansion Cards 

Installable card (Model name) Number 
of cards Remarks 

SAS array controller card (PG-140F) 1 For an array card type, this is installed by 
default.

SCSI card (PG-1281) 2 For external/internal options (Ultra 160 SCSI)

LAN card (PG-2861) 1 PCI-Express 1000BASE-T

LAN card (PG-1892) 3 1000BASE-T

table: Expansion Card Installation Order and Slots

Installable expansion card (Model name)
PCI slot Installation 

order1 2 3 6 7

SAS array controller card (PG-140F) - 1 - - - 1

SCSI card (PG-1281) 1 - 2 - - 2

LAN card (PG-2861) - - - 1 - 3

LAN card (PG-1892) 3 2 1 - - 4
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4 Remove the screw that fixes the slot cover (1), and remove the slot cover (2).

Be sure to keep the removed slot cover for later use.
If operating the server with no expansion card, attach the slot cover to keep dust away. 

5 Firmly press the expansion card into the connector of the PCI slot.

6 Fix the expansion card with the screw. 

7 Attach the side cover.

Removing the Expansion Card
To remove the expansion card, simply reverse the installation procedures. 

Face down the surface

for installing components.
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7.5 Installing Internal Hard Disk Units

This section explains how to install internal hard disk units.

Before adding an internal hard disk unit, install the OS and turn off the server.

7.5.1 Where to Install Internal Hard Disk Units

Install internal hard disk units in 3.5-inch storage bay.

• When installing or removing internal hard disk units, turn off the server, all 
peripheral devices, and any other connected devices. Also unplug all power 
cables from the outlet.
However, when the array system is configured (except for RAID 0), the defect
hard disk unit can be replacing without turning off the server.

• Install our genuine internal hard disk units only. Failure to do so may cause a 
device failure, fire, or electric shock. 

• When installing or removing hardware options, make sure to remove the 
screws on the specified points only. 
There is a chance of injury if screws other than those on the specified points
are removed. This could also damage the server.

• Touch only the specified part of the printed circuit board. 
Failure to do so could cause injury and also damage the server.

3.5 inch storage bay 4

3.5 inch storage bay 3

3.5 inch storage bay 2

3.5 inch storage bay 1
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7.5.2 Installable Internal Hard Disk Units and Notes

Before installing an internal hard disk unit, check the following points. 

Installable Internal Hard Disk Units
The following types of SAS hard disks can be installed in this server. 

Notes 
Note the following points to avoid failures: 
• Inside the hard disk unit, the disk for storing data is rotating at high speed to read and write data. 

Because this server is very delicate, do not move, strike, or shake it when it is turned on. 
• Do not use or store the device in a location affected by extreme temperature changes. 
• Keep the device away from direct sunlight and from radiators or other heat source. 
• Use or store the device on a shock-and-vibration free surface. 
• Do not use or store the device in a humid or dusty place. 
• Do not use or store the device near magnets or devices that generate magnetic fields. 
• Do not disassemble or take the device apart. 
• Keep the disk away from condensation or water droplets. 

Mishandling could result in destruction of the data stored in the disk. Make sure to keep a backup of 
important data. 
Even if the hard disk is of the same type, there could be a slight difference in storage capacity. We 
recommend backing up data on the basis of files or sectors rather than hard disks. 

Array Configuration and Maximum Number of Installable Hard Disk 
Units

When Not Configuring the Array System

Up to four internal hard disk units can be installed. Install them in the order of Bay 1, Bay 2, Bay 3 and  
Bay 4.

When Configuring the Array System with an Onboard SAS Array Controller

Up to two internal hard disk units can be installed. Install hard disk units of the same model in Bay 1 and 
Bay 2.

table: Installable Internal Hard Disk Units
Product name Model number Overview

Internal hard disk unit -73 GB PG-HDB75A 73.4 GB, 15,000 rpm, SAS
3.5 inch, hot-pluggable 

Internal hard disk unit -147 GB PG-HDB45A 146.8 GB, 15,000 rpm, SAS
3.5 inch, hot-pluggable
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When Configuring the Array System with a SAS Array Controller Card

Up to four internal hard disk units can be installed. Install them in the order of Bay 1, Bay 2, Bay 3 and 
Bay 4. The SAS array controller card (PG-140F) needs to be installed in PCI slot 2.

Slot Number

The slot numbers which are displayed on the software such as RAID Management tool correspond  to 
the hard disk bay numbers as follows.

Replacing the Failed Internal Hard Disk Unit
When the hard disk is failed, it can be replaced and repaired without turning off the server and peripheral 
devices (hot-swappable/hot-pluggable). 
For details about the array system and replacing the failed hard disk unit, refer to "MegaRAID SAS 
User’s Guide" or "Integrated Mirroring SAS User’s Guide" in the Array Controller Document & Tool 
CD.

7.5.3 How to Install the Internal Hard Disk Unit

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the hard disk cover.
"7.2 Removing and Attaching Covers" (pg.180)

3 Touch a metal part of the server to discharge static electricity. 

Bay Number 1 2 3 4

Slot Number 0 1 2 3
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4 Remove the dummy unit from the bay to accommodate an internal hard disk 
unit. 
Pull the dummy unit out towards you with its tabs being pressed inward.
Be sure to keep the removed dummy units for later use.

5 Install the internal hard disk unit into the server unit. 
Push the unit into the bay with the handle up and pull down the handle to secure.

6 Attach the hard disk cover.

Tabs

Handle
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7.5.4 How to Remove the Internal Hard Disk Unit

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the hard disk cover.
"7.2 Removing and Attaching Covers" (pg.180)

3 Touch a metal part of the server to discharge static electricity. 

4 Remove the internal hard disk unit.
With pressing the front tab of the internal hard disk unit to remove, turn the handle upward and 
pull the hard disk unit towards you. To remove the internal hard disk unit, use both hands to pull 
it out. 

5 Install a dummy unit or a new hard disk unit. 

6 Attach the hard disk cover.

Handle
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7.5.5 Replacing the Failed Internal Hard Disk Unit (in the 
array configuration only)

When an array system (except for RAID 0) is configured with this server, a failed hard disk unit can be 
replaced and repaired without turning off the server and peripheral devices (hot-swappable/hot-
pluggable).
For replacing procedures, refer to the manual in the Array Controller Document & Tool CD.
Follow the procedure below to insert and remove the hard disk unit.

1 Open the hard disk cover.

2 Touch a metal part of the server to discharge static electricity. 

3 Pull the handle while pressing the tab on the front of the failed hard disk unit, 
pull out the unit by only 1 to 3 cm, and disconnect it from the SAS connector.

Do not pull out the hard disk unit fully from the server.

4 Wait more than one minute (until the hard disk stops rotating) and pull out the 
failed hard disk unit. 

5 Remove faulty hard disk.

6 Insert a new hard disk unit. 
Insert it to the bay with the handle of the hard disk unit raised, and then bring down the handle to 
fix it.

7 Confirm the status by using the RAID Management tool.
For details, refer to the manual in the Array Controller Document & Tool CD.
For an onboard array controller, execute Rebuild using the RAID Management tool.

8 Attach the hard disk cover.
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7.6 Installing 5-inch Internal Options 

This section explains how to install a 5-inch internal device. Unlike external devices, 
internal device does not need to be connected to the outlet because its power is 
supplied from the server. In addition, it offers the advantage of space saving. 

Before adding a 5-inch internal device, install the OS and turn off the server once.

7.6.1 Where to Install 5-inch Internal Devices

Install 5-inch internal devices in 5-inch storage bays.

• When installing or removing internal devices, turn off the server, all peripheral 
devices, and any other connected devices. Also unplug all power cables from 
the outlet.
Failure to do so can cause electric shock.

• Install our genuine internal devices only. 
Failure to do so may cause a device failure, fire, or electric shock. 

• When installing or removing hardware options, make sure to remove the 
screws on the specified points only. 
There is a chance of injury if screws other than those on the specified points
are removed. This could also damage the server.

• Touch only the specified part of the printed circuit board. 
Failure to do so could cause injury and also damage the server.

Preinstalled CD-ROM drive

5 inch storage bay 1

5 inch storage bay 2

5 inch storage bay 3
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7.6.2 Installable 5-inch Internal Devices and Notes

This section explains installable 5-inch internal devices, SCSI-IDs, and connections. Check this section 
before installing. 

Installable 5-inch Internal Devices and SCSI-IDs
The following types of 5-inch internal devices can be installed in this server. For the combination of 
additional internal 5-inch options and their SCSI IDs, refer to the following table:

Install the SCSI card (PG-1281) in advance when installing an internal VXA2 unit or an internal LTO2 
unit.

7.6.3 How to Install the 5-inch Internal Device

To install DVD-RAM unit

Before installing a DVD-RAM unit, remove the preinstalled CD-ROM drive unit. For details on how to 
install a DVD-RAM unit, refer to "7.6.4 How to Install a DVD-RAM Unit" ( pg.202)

Perform the following procedures to install a 5-inch internal device.

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the side and front covers. 
"7.2 Removing and Attaching Covers" (pg.180)

3 Install the SCSI card (PG-1281) for an internal VXA2 unit or an internal LTO2 
unit.

"7.4.3 How to Install Expansion Cards" (pg.190)

table: Installable 5-inch Internal Devices

Product name Model
number of 
installed 
devices

maximum Available 
bay SCSI ID

Internal DVD-RAM drive unit PG-DVA102D 1 1 Bay 1 -

Internal DAT72 unit PG-DT5041 1 2 Bay 2
 or 

Bay 3

-

Internal VXA2 unit PG-VX201 1 Bay 2=ID5
Bay 3=ID6Internal LTO2 unit PG-LT201 1
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4 Remove the dummy unit.
Pull the dummy unit out slowly towards you, keeping the tabs on the 5-inch storage bay rails (on 
both sides) pressed inward.

Be sure to keep the removed dummy units for later use.

5 Detach the 5-inch storage bay rails from the removed dummy unit. 
Remove eight screws that fix the 5-inch storage bay rails to detach. 

6 Attach the removed 5-inch storage bay rails to the internal device to be added. 
Use the supplied screws if the screws are supplied with the internal option.
If these are not supplied,  use four screws which were removed when the 5-inch storage bay rails 
were detached.

Tabs
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7 Install the internal device to the 5-inch storage bay. 

8 Connect a USB cable or a SCSI cable to the internal devices.
The cables differ according to the internal options.

For internal DAT72 unit
Connect a USB cable that is in the server. Remove the cap before connecting the cable.

For internal VXA2 unit or internal LTO2 unit
Connect a SCSI cable to the internal options. Use port A for one internal option. To connect two 
internal options, use port A for the internal option installed in the bay 3 and use port B for the 
internal option installed in the Bay 2.

USB 

connector

USB cable

Remove the cap.

Power supply 
connector

[Rear side]

Terminal resistorConnects to SCSI card

Line of 1st pin
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9 Connect the power cable to the 5-inch internal devices. 
When the option is installed in the Bay 2, connect the power cable P3. When the option is 
installed in the Bay 3, connect the power cable P2. 

10 Attach the front and side covers.

11 Setup SCSI-ID.
Use the utility supplied with the SCSI card. 
For details on how to use the utility, refer to the manual of SCSI card.
For SCSI-ID of each option, refer to "  Installable 5-inch Internal Devices and SCSI-IDs" 
( pg.199)

7.6.4 How to Install a DVD-RAM Unit

Before installing a DVD-RAM unit, remove the preinstalled CD-ROM drive unit. Perform the following 
procedures to install a DVD-RAM unit.

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the side and front covers. 
"7.2 Removing and Attaching Covers" (pg.180)

3 Remove the IDE cable and power cable from the CD-ROM drive unit.

4 Remove the CD-ROM drive unit.
Pull the CD-ROM drive unit out slowly towards you, keeping the tabs on the 5-inch storage bay 
rails (on both sides) pressed inward.

Tabs
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5 Detach the 5-inch storage bay rails from the removed CD-ROM drive unit. 
Remove four screws that fix the 5-inch storage bay rails to detach. 

6 Attach the removed 5-inch storage bay rails to the DVD-RAM drive unit. 

7 Install the DVD-RAM drive unit. 

8 Connect the IDE cable and power cable to the DVD-RAM drive unit. 
Connect the power cable to the conversion cable that is supplied with the DVD-RAM drive unit, 
and connect it to the power connector of the DVD-RAM drive unit. 

9 Attach the front and side covers.

rear side

IDE cable

Power cable

(1)

(2)

Conversion cable
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7.7 Installing a Parallel Port Option　

When a parallel port is necessary, install a parallel port option.

For the parallel port location, refer to "1.3.2 Server (Rear View)" ( pg.25).

7.7.1 How to Install a Parallel Port

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the side cover. 
"7.2 Removing and Attaching Covers" (pg.180)

3 Touch a metal part of the server to discharge static electricity.

• When installing or removing a parallel port, turn off the server, all peripheral 
devices, and any other connected devices. Also unplug all power cables from 
the outlet.
Failure to do so can cause electric shock.

• Touch only the specified part of the printed circuit board. 
Failure to do so could cause injury and also damage the server.

• Be careful not to be injured when handling the parallel port connector panel 
that is removed from the rear of the server.
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4 Remove the system fan.
Remove the system fan cable and lift the system fan to remove it. 

5 Remove the parallel port connector panel from the rear side.
Insert a flat blade screwdriver into the hole at the center of the panel. Move the screwdriver to the 
right and left and pull the panel off. 

Fan

System fan cable

[Rear side]
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6 Connect a parallel cable to the onboard parallel connector and attach the 
connector of the cable to the rear panel.

7 Secure the connector using screws from the rear side.

Connector

[Rear side]
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8 Attach the system fan. 
Connect a system fan cable to the system fan connector to attach the system fan.

9 Attach the side cover.

Fan

System fan 
connector

System fan 
cable
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7.8 Installing a Serial Port

When a serial port is necessary, install an optional serial port.

7.8.1 Where to Install a Serial Port

Install a serial port in the PCI slot 5 and connect a serial cable to the serial cable connector.

7.8.2 How to Install a Serial Port

1 Turn off the server and connected devices, and unplug all power cables from 
the outlet. 

2 Remove the side cover. 
"7.2 Removing and Attaching Covers" (pg.180)

3 Touch a metal part of the server to discharge static electricity.

• When installing or removing a serial port, turn off the server, all peripheral 
devices, and any other connected devices. Also unplug all power cables from 
the outlet.
Failure to do so can cause electric shock.

• Touch only the specified part of the printed circuit board. 
Failure to do so could cause injury and also damage the server.

Serial cable connector.

PCI slot 5
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4 Remove the screw that fixes the slot cover (1), and remove the slot cover (2).

Be sure to keep the removed slot cover for later use.
When a serial port is removed, attach the slot cover to keep dust away. 

5 Install a serial port, and connect a serial cable to the serial cable connector.

6 Fix the serial port with the screw. 

7 Attach the side cover.
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7.9 Connecting External SCSI 
Devices

This section explains connection of external SCSI devices.

Connectable External SCSI Devices
The following external SCSI devices can be connected to this server.

Connecting Backup Cabinet
To connect backup cabinet, install SCSI card (PG-1281) to this server.

Notes on Connecting External SCSI Devices

Settings for SCSI-ID

Be sure to set up each device with no overlaps.

Daisy Chain Connection

Daisy chain connection is not available for PRIMERGY SX10.

table: Connectable External SCSI Devices
Product name Model

PRIMERGY SX10 PG-R1BC4
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Configuring Hardware
and Utilities

This chapter explains how to make the 
environment settings necessary to operate the 
server and how to use each utility. 

8.1 Jumper Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
8.2 BIOS Setup Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
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8.1 Jumper Settings

The BIOS password setting can be deleted through the jumper settings. 

Do not change the jumper settings except when deleting the BIOS password. 

8.1.1 Jumper Location and Settings

Jumper Location
The jumper of the server is located on the baseboard as shown below.

Jumper Settings
To delete password setting, set the jumper as follows:

Jumper

at the normal operation to delete password
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8.2 BIOS Setup Utility

This section explains settings for the BIOS Setup Utility and items regarding each 
setting. 

8.2.1 Starting and Exiting the BIOS Setup Utility

The following explains how to start and exit the BIOS Setup Utility. 

How to Start the BIOS Setup Utility

1 Turn the server on.

2 During POST, press the [F2] key while the message "<F2>BIOS Setup / <F12> 
BOOT Menu" is displayed on the screen. 
The [Main menu] window appears when the POST completes.

When the [Main menu] window does not appear
When the [Main menu] window does not appear because the [F2] is pressed at wrong timing,
press the [Ctrl] + [Alt] + [Delete] keys at the same time to restart the system, then start the
BIOS Setup Utility.

Item Specific Help

Change Values

Enter F10

Select Item

Select Menu Select     Sub-Menu

-/+F1

Esc

Help

Exit
F9 Setup Defaults

Save and Exit
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While the message "<F2> BIOS Setup / <F12> BOOT Menu" is displayed, pressing the [F12] key 
causes the Boot Menu screen to appear when POST completes.

Key Operations in the BIOS Setup Utility

The roles of the keys used for setting the BIOS Setup Utility are as follows:

How to Exit the BIOS Setup Utility

1 Use the [←] [→] keys to display the [Exit] menu.

table: List of Key Operations on the BIOS Setup Utility Window 
Key Description

[F1] Displays the system information. Press the [Esc] key to close it.

[Esc] Ends a submenu and returns to the previous menu. Or displays the Exit menu.

[↑][↓] Scrolls through the menu option list.

[←][→] Switches between menus.

[-][+] Changes the value of an item.

[Enter] Selects an item. In items in which  is displayed the sub menu appears.

[F9] Sets each item to its initial (default) value.

[F10] Saves the value of each item and exits the BIOS Setup Utility.

Boot Menu

1.   CD-ROM Drive

2.   +Diskette

3.   +Hard Drive

4.   Legacy LAN Card

 

<       > Select  <Enter> Confirm

Item Specific Help

Change Values-/+ F9

Advanced Security Server ExitMain
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Help

Exit F10

Setup Defaults

Save and ExitExecute Command
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2 Use the [↑] [↓] keys to select the exit mode. 
To save configuration changes before exiting: 

Move the cursor to [Save Changes & Exit] and press the [Enter] key.
The message "Save configuration changes and exit now?" is displayed. 

To exit without saving configuration changes:
Move the cursor to [Discard Changes & Exit] and press the [Enter] key.
When the settings are changed, the "Configuration has not been saved Save before exiting?" 
message is displayed.

3 Use the [←] [→] keys to move the cursor to [Yes] or [No], and press the [Enter] 
key.

If you selected [Save Changes & Exit] from the [Exit] menu:
• Select [Yes] to exit.

After saving changes to settings, the BIOS Setup Utility closes and the server restarts. 
• Select [No] not to exit.

The display returns to the BIOS Setup Utility window. 
If you selected [Discard Changes & Exit] from the [Exit] menu:

• Select [Yes] to save changes before exit.
The BIOS Setup Utility closes and the server restarts. 

• Select [No] when not saving the settings.
The BIOS Setup Utility closes and the OS starts. 
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8.2.2 Main Menu

The [Main] menu is initially displayed when you start the BIOS Setup Utility.
Settings for time and date and for the drives are configured on the [Main] menu.

table: Items on the Main Menu
Item Setting Description

System Time Present time The system time is set in "hours:minutes:seconds" 
format. The hours should be based on a 24-hour clock.
For example, 6:30:00 P.M. is set as "18", "30", "00". 
If a highly precise system time is necessary, install a 
network synchronized time system (NTP, etc.). 

System Date Present date The system date is set in "month:day:year" format. 
For example, September 20, 2005 is set as "09", "20", 
"2005". 

Diskette A 1.4M (Unchangeable) Sets the type of Floppy Disk Drive A (recording 
density and drive size).

Standard IDE Sets the type and operating mode for connected IDE devices.
Press the [Enter] key to display the "8.2.3 Standard IDE Submenu" ( pg.217) 
window

Boot Options Sets system startup options. Press the [Enter] key to display the "8.2.4 Boot 
Options Submenu" ( pg.218) window.

Base Memory A usable base memory size of less than 1MB appears.

Extended Memory A memory size of more than 1MB appears.

Item Specific Help

Change Values

Enter F10
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Select Menu Select     Sub-Menu

-/+F1

Esc

Help

Exit
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8.2.3 Standard IDE Submenu

Use this submenu to set the type and operating mode for connected IDE devices. When the drives are 
installed to Standard IDE Master or Standard IDE Slave, each menu is displayed. Displayed items differ 
from drive to drive.

table: Items on the Standard IDE Submenu
Item Setting Description

PIO Mode PIO 4 Displays the current PIO (Programmed I/O)  
transfer mode. The fastest PIO transfer mode 
among connected IDE devices is automatically set.

DMA Mode UDMA 2 Displays the current DMA (Direct Memory Access)  
data transfer mode. The fastest DMA transfer mode 
among connected IDE devices is automatically set.

Firmware Displays the version of the firmware.

Item Specific HelpStandard IDE:      [******]

Select     Sub-MenuEnter

F9Select Item

Select Menu

Change Values-/+F1

Esc

Help

Exit F10

Setup Defaults

Save and Exit

Advanced Security Server ExitMain

PIO Mode:                          PIO 4
DMA Mode:                         UDMA 2
Firmware:                            ****
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8.2.4 Boot Options Submenu

Use this submenu to set system startup options. 

table: Items on the Boot Options Submenu
Item Setting Description

POST Errors Halt On All Errors 
(Unchangeable)

Sets whether or not to stop the boot process and shut down 
the system, in case a POST (Power On Self Test) error is 
detected. 

Keyboard Check • Disabled
• Enabled (Initial value)

Sets whether or not to check keyboard connection during 
POST. 

SM Error Halt • Disabled
• Enabled (Initial value)

Sets the procedure in case an error occurs regarding the fan 
or temperature sensor. 

Fast Boot Disabled (Unchangeable) Sets whether or not to reduce the scope of POST and thereby 
speed up system startup. 

Quiet Boot Disabled (Unchangeable) Sets whether or not to display the logo screen instead of 
POST information. 

Boot Menu Enabled (Unchangeable) Sets whether or not to display the boot drive selection 
window after POST.
By selecting the boot drive from the [Boot Menu] window, 
startup can be done from the selected boot drive regardless of 
the [Boot Sequence] setting.

NumLock Auto (Unchangeable) The state of the NumLock during activation.

MultiBoot for HDs Enabled (Unchangeable) Sets whether or not it is possible to specify the order of hard 
disks to boot the operating system (OS) when multiple hard 
disk units are installed. 
To perform a PXE boot, set to [Enabled].

Item Specific HelpBoot Options

Change Values-/+ F9Select Item

Select Menu Select     Sub-MenuEnter

F1

Esc

Help

Exit F10

Setup Defaults

Save and Exit

Advanced Security Server ExitMain

[Halt On All Errors]
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[Auto]
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Keyboard Check:
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MultiBoot for HDs:
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8.2.5 Advanced Menu

The [Advanced] menu sets the peripheral device and PCI device options.

Boot Sequence • CD-ROM Drive
• Diskette
• Hard Drive
• Legacy LAN Card
• Boot Manage PXE, 

Slot 0A00 (displayed 
when LAN Remote 
Boot is set to PXE)

The order of reading the OS is set by pressing [Enter]. 
Use the [+] [-] keys to change the order of priority for the 
selected device. Booting from a selected device can be 
disabled with the [Space] key. (The mark "!" is displayed by 
the name of the disabled device.) If a non-existing device is 
displayed, delete it from the list by pressing the [*] key. 

table: Items on the Advanced Menu
Item Setting Description

Peripheral Configuration Configures the serial port, parallel port, etc. Press the [Enter] key to display the 
"8.2.6 Peripheral Configuration Submenu" ( pg.220) window.

PCI Configuration Configures the PCI device. Press the [Enter] key to display the "8.2.7 PCI 
Configuration Submenu" ( pg.222) window.

Advanced System 
Configuration

Configures additional settings. Press the [Enter] key to display the "8.2.8 
Advanced System Configuration Submenu" ( pg.223) window.

Power On/Off Configures power On/Off settings. Press the [Enter] key to display the "8.2.9 
Power On/Off Submenu" ( pg.224) window.

IPMI Configures server management settings. Press the [Enter] key to display the 
"8.2.10 IPMI Submenu" ( pg.225) window.

Reset Configuration Data • Yes
• No (Initial value)

Sets whether or not to initialize the Extended System 
Configuration Data (ESCD) where the system resources 
are recorded. 

table: Items on the Boot Options Submenu
Item Setting Description

Item Specific Help

Change Values-/+ F9Select Item

Select Menu Select     Sub-MenuEnter

F1

Esc

Help

Exit F10

Setup Defaults

Save and Exit
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Peripheral Configuration

PCI Configuration

Advanced System Configuration

Power On/Off

IPMI

Reset configuration Data: [No]

Setting items on this menu to incorrect values

may cause your system to malfunction.

Setup Warning
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8.2.6 Peripheral Configuration Submenu

Use this submenu to set the serial port, parallel port, etc. 
The items not listed in the figure below can be displayed using the scroll bar.

table: Items on the Peripheral Configuration Submenu
Item Setting Description

Serial 1 • Disabled
• Enabled
• Auto (Initial value)
• OS Controlled

Sets whether to enable or disable the serial port.  Set 
this to "Disabled" when used as a server 
management port.
Note: 

When [Serial Multiplexer] is changed to 
"iRMC", set this item to "Disabled".

Serial 1 Address 3F8h (Unchangeable) Appears when "Enabled" is selected for [Serial 1].

Serial Multiplexer • System (Initial value)
• iRMC

Switches the function of serial port 1.
• System

Uses this port as a serial port. (Setting at the time 
of UPS connection)

• iRMC
Uses this port as a server management port. In 
this case, set [Serial 1] to "Disabled".

Serial 2 • Disabled
• Enabled
• Auto (Initial value)
• OS Controlled

Sets whether to enable or to disable the serial port.

Serial 2 Address 2F8h, IRQ 3 (Unchangeable) Appears when "Enabled" is selected for [Serial 2].

Parallel Auto (Unchangeable) Sets whether to enable or to disable the parallel 
port.

Parallel Mode Bidirection (Unchangeable) Sets the data transfer mode of the parallel port. 

USB Enable Ports All (Unchangeable) Sets whether or not to use the USB port.

USB 2.0 Host Controller Enabled (Unchangeable) Sets whether or not to enable the USB controller 
(2.0 standard).

Item Specific Help

Change Values

Enter

F9Select Item

Select Menu Select     Sub-Menu

-/+F1

Esc

Help

Exit F10
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Save and Exit
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ATA Controller Config

Diskette Controller:
Mouse Controller:
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[Bidirection]
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[Auto]
[0 s]

[Enabled]
[Auto Detect]
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USB BIOS Supported 
Devices

Auto (Unchangeable) Sets whether the USB device can be used on the OS 
that does not support USB.

USB Boot Delay Os (Unchangeable) Sets the delay time by the second for initializing 
USB mass storage device during the POST.

ATA Controller Config Press the [Enter] key to display the [ATA Controller Config] submenu. These items 
cannot be changed.

S-ATA Mode Native (Unchangeable) Sets the serial ATA operation mode.

P-ATA Maps To Secondary (Unchangeable) Sets the parallel ATA mapping.
This item is displayed when "S-ATA" is set to 
"Compatible".

Primary IDE Channel Enabled (Unchangeable) Sets whether or not to enable primary IDE channel.

Tertiary IDE Channel Enabled (Unchangeable) Sets whether or not to enable IDE channel.

Quaternary IDE 
Channel

Enabled (Unchangeable) Sets whether or not to enable IDE channel.

Diskette Controller Enabled (Unchangeable) Configures the floppy disk controller. 

Mouse Controller Auto Detect (Initial value) Sets whether or not to use the mouse connected to 
the mouse port. 

LAN Controller Enabled (Unchangeable) Sets whether to enable or disable the onboard LAN 
controller.

LAN Remote Boot • Disabled (Initial value)
• Enabled 

Sets whether or not to perform a network boot. 
This function allows booting the server via the 
network. It is used for remote installation of the OS, 
etc. 
You can set this item only when [LAN Controller] 
is set to [Enabled].

Management LAN Enabled (Unchangeable) Sets whether to enable or disable the port for the 
Remote Management Controller. 

SAS Controller Enabled (Unchangeable) Sets whether to enable or disable the onboard SAS 
controller. 

SAS Option ROM Scan Enabled (Unchangeable) Sets whether or not to initialize the extended ROM. 

table: Items on the Peripheral Configuration Submenu
Item Setting Description
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8.2.7 PCI Configuration Submenu

Use this submenu to set the PCI device. 

table: Items on the PCI Configuration Submenu
Item Setting Description

PCI SLOTS Configuration Configures the PCI slots. Press the [Enter] key to display the [PCI SLOTS 
Configuration] submenu window. 

PCI Slot 1 Configuration 
Option ROM SCAN

• Enabled 
• Disabled (Initial value)

Sets whether or not to initialize the extended ROM in 
each PCI slot. 

PCI Slot 2 Configuration 
Option ROM SCAN

• Enabled (Initial value)
• Disabled 

PCI Slot 3 Configuration 
Option ROM SCAN

• Enabled
• Disabled (Initial value)

PCI-E Slot 6 
Configuration Option 
ROM SCAN

• Enabled
• Disabled (Initial value)

PCI-E Slot 7 
Configuration Option 
ROM SCAN

• Enabled
• Disabled (Initial value)

PCI IRQ Configuration Sets PCI IRQs for the PCI slots. Press the [Enter] key to display the [PCI IRQ 
Configuration] submenu window.

PCI IRQ Line 1–8 Auto  (Unchangeable) Sets the PCI IRQ. 

Item Specific Help
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8.2.8 Advanced System Configuration Submenu

Use this menu to configure the settings which are related to CPU, memory and USB. 

table: Items on the Advanced System Configuration Submenu
Item Setting Description

ECC Memory Checking Enabled (Unchangeable) Sets whether to enable or disable to check ECC 
error of memory.

PCI Bus Parity Checking Enabled (Unchangeable) Sets whether to enable or disable the PCI bus parity 
checking. 

BIOS Work Space Location Expansion ROM Area
(Unchangeable)

Sets the location on the memory to assign the data 
area that BIOS uses.

Limit CPUID functions Disabled (Unchangeable) Sets whether or not to limit CPUID expanded 
function. If the OS does not support expanded 
function, the system may not start.

CPU Mismatch Detection Enabled (Unchangeable) Sets whether to enable or disable checking the CPU 
type and frequency. 

CPU Thermal Management Enhanced (Unchangeable) Configures the CPU internal setting. 

CPU Halt Mode Enhanced (Unchangeable)

NX Memory Protection • Disabled (Initial value)
• Enabled

Sets whether to enable or disable "execute disable 
bit function" of processor.

Virtualization Technology • Disabled (Initial value)
• Enabled

Sets whether to enable or disable Virtualization 
Technology.

Hardware Prefetch Enabled (Unchangeable) Configures the CPU internal setting. 

Adjacent Sector Prefetch Enabled (Unchangeable)

CPU Timeout Counter Disabled (Unchangeable)

Enhanced SpeedStep • Disabled (Initial value)
• Enabled

Sets whether to enable or disable the power saving 
function.

CPU MC Status Clear Next Boot 
(Unchangeable)

Configures the CPU internal setting. 

Item Specific Help
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Select Menu Select     Sub-MenuEnter
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8.2.9 Power On/Off Submenu

Use this submenu to configure power On/Off settings. 

Discard Timer Mode 1024 clocks 
(Unchangeable)

Configures the delayed transfer of PCI bus burst 
transfer.

SMART Device Monitoring Enabled (Unchangeable) Sets whether or not to monitor SMART device.

High Precision Event Timer Disabled (Unchangeable) Sets whether or not to use the high precision timer 
of the chipset. 

table: Items on the Power On/Off Submenu
Item Setting Description

Power On Source BIOS Controlled 
(Unchangeable)

Configures the power-on setting. 

Remote • Disabled (Initial value)
• Enabled

Sets whether or not the power is turned on when 
the modem (connected to the serial port) receives 
a ring signal. 

LAN • Disabled
• Enabled (Initial value)

Sets whether or not to enable the power to be 
turned on via LAN. 

Wake Up Timer Disabled (Unchangeable) Sets whether or not the power is turned on at a 
certain time or after a certain time has passed. A 
separate program is necessary for setting startup 
time.
Sets the following items if [Wake Up Timer] is 
set to [Enabled].

Wake Up Time Sets the startup time when using [Wake Up Timer]. 

Wake Up Mode Daily (Unchangeable) Sets the startup mode when using [Wake Up 
Timer].

table: Items on the Advanced System Configuration Submenu
Item Setting Description

Item Specific Help
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8.2.10 IPMI Submenu

Use this submenu to configure server management settings. 

Power Off Source

Software Enabled (Unchangeable) Sets whether or not to enable the power to be 
turned off using a program or the operating 
system. 

Power Button Enabled (Unchangeable) Sets whether or not to allow the use of the power 
switch for turning the power off, when the ACPI 
function is disabled. 

Power Failure Recovery • Always On
• Always Off
• Previous State (Initial 

value)

Sets whether to turn the power on or off after a 
temporary main power outage due to power 
interruption, etc.
Note: 

For UPS scheduled operation, set to 
[Always On]. Otherwise, the power may 
not be turned on at the specified time. 

table: Items on the IPMI Submenu
Item Setting Description

SEL Load Displays the usage of event log space as a percentage. 

Clear System Event Log Disabled (Unchangeable) Sets whether or not to clear the event log. 

Event Log Full Mode Overwrite 
(Unchangeable)

Sets whether or not to overwrite the event log when 
space available for it becomes full. 
Note: 

Changing this setting deletes the existing 
event log. Before making changes, refer to 
"9.3.1 How to Use Server Management Tools" 
( pg.252) for saving the event log.

table: Items on the Power On/Off Submenu
Item Setting Description

Item Specific Help

Change Values
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LAN Settings Submenu
Use this submenu to configure LAN settings when performing the remote operation using 
RemoteControlService.

iRMC Time Sync Enabled (Unchangeable) Synchronizes the internal clock of the Baseboard 
Management Controller (BMC) with the system 
time. 

System Event Log Displays the system event logs. Press the [Enter] key to display the system event 
log window. Display previous and subsequent entries using [+] [-] keys.

SDRR Browser Displays sensor information. The SDRR Browser is displayed by pressing [Enter].

LAN Setting Configures the LAN settings of the Remote Management Controller port. This 
setting is required when performing the remote operation using 
RemoteControlService. Press the [Enter] key to display the "  LAN Settings 
Submenu" ( pg.226) window. 

Reset Configuration DATE • Yes
• No (Initial value)

Sets whether or not to reset plug and play 
information which is saved in ESCD (Extended 
System Configuration Data) at the booting.

table: Items on the LAN Settings Submenu
Item Setting Description

DHCP • Disabled (Initial value)
• Enabled

Sets whether or not to obtain LAN IP address of the 
Remote Management Controller port from the DHCP 
server. 

Local IP address Enter an IP address for the Remote Management Controller port.
Note: 

Set an IP address different from that in OS settings.

Subnet mask Sets the subnet mask of the Remote Management Controller port that is specified 
for "Local IP address". 

Gateway address Sets the gateway address of the Remote Management Controller port that is 
specified for "Local IP address". 

table: Items on the IPMI Submenu
Item Setting Description
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8.2.11 Security Menu

The [Security] menu sets the security options.

table: Items on the Security Menu
Item Setting Description

Setup Password Displays the setting of a password (setup password) that is used for security of 
BIOS setup. 
• Not Installed: A password has not been set. 
• Installed: A password has been set. 

System Password Displays the setting of a password (system password) that is used for security of 
system start-up. 
• Not Installed: A password has not been set. 
• Installed: A password has been set. 

Set Setup Password Sets a setup password. 
Setting a setup password makes it necessary to enter the password in order to start 
the BIOS Setup Utility. 
Press the [Enter] key to display the password entry screen. Enter the setup 
password. For more details, refer to "9.4.2 Security against Unauthorized Use" 
( pg.256).

Setup Password Lock • Standard (Initial value)
• Extended

Keyboard can be locked while initializing 
expansion card. When the expansion card that can 
execute the setup during system start-up is installed, 
the setting of the expansion card can be protected 
by locking the keyboard. 
You can set this item only when [Setup Password] 
is specified. 

Set System Password Sets a system password. 
Setting a system password makes it necessary to enter the password in order to 
access this server. 
[Setup Password] must be specified. 
Press the [Enter] key to display the password input window. Enter the setup 
password. For more details, refer to "9.4.2 Security against Unauthorized Use" 
( pg.256).

Item Specific Help

Select     Sub-MenuEnter F10
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Select Menu
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228

Chapter 8  Configuring Hardware and Utilities

System Password Mode • System (Initial value)
• Keyboard

Sets the password entering for system start-up. You 
can set this item only when [System Password] is 
specified.
• System

The password entry screen is displayed when the 
system is started. You can unlock the system 
with the password.

• Keyboard
A password is not required. Keyboard and mouse 
are locked to prevent the operation. You can 
unlock the system by entering the password on 
the keyboard and pressing the [Enter] key.

System Password Lock • Standard 
• WOL Skip (Initial value)

Sets whether or not to skip entering the password 
when the system is started with Wakeup on LAN.
You can set this item only when [System Password 
Mode] is set to [System].

System Load • Standard (Initial value)
• Diskette/CDROM Lock

Sets whether to enable or disable system startup 
from a floppy disk or CD-ROM. 

Setup Prompt • Disabled
• Enabled (Initial value)

Sets whether or not to display a setup message 
"<F2>BIOS Setup/<F12>BOOT Menu" on the 
[POST] window during system startup.

Virus Warning Disabled  (Unchangeable) Sets whether or not to check the boot sector of the 
hard disk drive after the previous system startup. If 
the boot sector is changed without a clear reason, it 
is necessary to scan the system for computer viruses 
with a virus detection program. 

Diskette Write • Disabled
• Enabled (Initial value)

Sets whether or not to allow writing on a floppy 
disk. 

Flash Write • Disabled
• Enabled (Initial value)

Sets whether or not to allow writing on the BIOS 
Flash ROM. 

table: Items on the Security Menu
Item Setting Description
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8.2.12 Server Menu

The [Server] menu sets the server options.

table: Items on the Server Menu
Item Setting Description

O/S Boot Time out • Disabled (Initial value)
• Enabled

Sets whether to enable or disable the OS Boot 
Monitoring function, when ServerView is installed to 
the OS. When this function is enabled, if for some 
reason booting the operating system is interrupted, 
the system will automatically restart. 
The OS Boot Monitoring function can also be 
enabled or disabled from ServerView.
Note: 

If ServerView is not installed to the OS, be 
sure to set to [Disabled]. If the setting is 
enabled, the server may automatically turn off 
or restart improperly.
Even when ServerView is installed to the OS, 
if starting the system while the ServerStart 
CD-ROM or DOS diskette is inside, be sure to 
disable the OS Boot Monitoring function. If the 
system is started with this function enabled, 
the server may automatically turn off or restart 
improperly. 
When setting this function, refer to 
"ServerView User’s Guide" to fully learn about 
its specifications, in order to use it properly 
with the correct settings. 

Action • Continue
• Reset (Initial value)
• Power Cycle

Sets the operation when the OS did not boot 
successfully within the time set with the [Timeout 
Value] setting.

Timeout Value • 0 (Initial value)
• 1–100

Sets the timeout period in minutes. 

Item Specific Help

Change Values

Enter F10

Select Item

Select Menu Select     Sub-Menu

-/+F1

Esc

Help

Exit
F9 Setup Defaults

Save and Exit

Advanced Security Server ExitMain

O/S Boot Timeout:

   Action:

   Timeout Value:

ASR&R Boot Delay:

Power Cycle Delay:

Boot Retry Counter:

Diagnostic System:

Temperature Monitoring:

CPU Status

Memory Status

Console Redirection

[Disabled]

[Reset]

[0]

[2]

[7]

[3]

[Disabled]

[Disabled]
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CPU Status Submenu
This submenu sets whether or not to allow the use of the installed CPU. 

Memory Status Submenu
This submenu sets whether or not to allow the use of the installed memory. 

ASR&R Boot Delay • 2 (Initial value)
• 1–30

Sets the standby time for startup after shutdown due 
to trouble (such as overheating) in minutes. The 
system restarts after the set standby time. 

Power Cycle Delay • 7 (Initial value)
• 0-15

Sets the time until the server is turned on after it is 
turned off.

Boot Retry Counter • 3 (Initial value)
• 0–7

Sets the maximum number of retries to boot the 
operating system within the range of 0 to 7. 

Diagnostic System Disabled (Unchangeable) Sets whether or not to diagnose the BootDevice when 
restarting with ASR&R. 

Next Boot uses Boot option (Unchangeable) Sets the boot device for restarting.

Device Instance 1 (Unchangeable) Sets the device ID of LAN Boot Device diagnosis.

Temperature Monitoring • Disabled (Unchangeable)
• Enabled

Sets whether or not the server can be turned on when 
the temperature is not in its operating environment 
range (10-35 °C). 

CPU Status Press the [Enter] key to display the "  CPU Status Submenu" ( pg.230) window.

Memory Status Press the [Enter] key to display the "  Memory Status Submenu" ( pg.230) 
window.

Console Redirection Press the [Enter] key to display the "  Console Redirection Submenu" ( pg.231) 
window.

table: Items on the CPU Status Menu
Item Setting Description

CPU 0 Status Enabled (Unchangeable) Sets whether or not to allow the use of CPUs installed 
in CPU Socket 0.

table: Items on the Memory Status Menu
Item Setting Description

DIMM-1A Enabled (Unchangeable) Sets whether or not to allow the use of memory in 
Memory Slots 1A to 2B. DIMM-2A

DIMM-1B

DIMM-2B

table: Items on the Server Menu
Item Setting Description
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Console Redirection Submenu
This submenu configures detailed settings for console redirection. 

table: Items on the Console Redirection Menu
Item Setting Description

Console Redirection • Disabled (Initial value)
• Enabled

Sets whether to enable or disable console redirection. 
 When set to [Enabled] the following parameters 
appear. Set each of them. If set to [Disabled], the 
items are not displayed.

Port • Serial1 (Initial value)
• Serial2

Sets the serial port to be used for console redirection.

Baud Rate • 1200
• 2400
• 4800
• 9600 (Initial value)
• 19.2K
• 38.4K
• 57.6K
• 115.2K

Sets the speed of the console redirection connection 
(in bps).

Protocol • VT100
• VT100,8bit
• PC-ANSI,7bit
• PC-ANSI
• VT100+ (Initial value)

Sets the console type for console redirection. 

Flow Control • None
• XON/XOFF
• CTS/RTS (Initial value)

Sets flow control for console redirection. 

Mode • Standard
• Enhanced (Initial value)

Sets the range of use for console redirection. 
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8.2.13 Exit Menu

This menu exits the BIOS Setup Utility. 

Select the option for handling BIOS settings when exiting the utility. 

table: Items on the Exit Menu
Item Description

Save Changes & Exit Save the current settings and exit the BIOS Setup Utility. After it exits the 
server reboots.

Discard Changes & Exit Exits the BIOS Setup Utility without saving current settings. Previously 
saved settings remain valid. 

Get Default Values Returns to the server's default values for all items. 

Load Previous Values Sets all items to the values before the last changes by reading from CMOS. 
Current setting values are discarded. 

Item Specific Help

Change Values-/+ F9

Advanced Security Server ExitMain

Save Changes & Exit

Discard Changes & Exit

Get Default Values

Load Previous Values

Select Item

Select Menu Enter

F1

Esc

Help

Exit F10

Setup Defaults

Save and ExitExecute Command
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Chapter 9

Operation and
Maintenance

This chapter explains the operations that 
become necessary after starting to use this 
server as well as daily care and maintenance.

9.1 Daily Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
9.2 Troubleshooting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
9.3 System Event Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
9.4 Security  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
9.5 Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
9.6 Restoring the System  . . . . . . . . . . . . . . . . . . . . . . . . . . . 262
9.7 Reinstalling the OS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264
9.8 Maintenance Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
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9.1 Daily Maintenance

This section explains how to check the status of the operating server, as well as how 
to perform daily maintenance.

Information for PRIMERGY

For the latest information on PRIMERGY, update modules, drivers and the software, refer to the Fujitsu 
PRIMERGY website.
http://primergy.fujitsu.com

9.1.1 Checking the Server Condition

Checking Each LED
This server is equipped with LEDs that display various hardware conditions.
Check the server status via each LED after starting the server. For positions and functions of each status 
LED, refer to "1.3 Component Names and Functions" ( Pg.22).

Server Monitoring Tool (ServerView)

ServerView is software that monitors whether the server hardware is in a normal state in order to protect 
important server resources. When using ServerView, the server hardware is monitored all the time. If an 
error that could cause trouble is detected, the administrator is notified in real-time which enables early 
detection. This allows the server administrator to remove a system error early and avoid trouble. 
For an overview and installation of ServerView and other high reliability tools, refer to "1.2.2 High 
Reliability Tools" ( Pg.20) and "Chapter 6 High Reliability Tools" ( Pg.171).

9.1.2 Cleaning

Clean the server regularly.

Cleaning the Server
Wipe with a soft, dry cloth. For stains that do not come off with a dry cloth, wipe with a cloth lightly 
dampened with a mild detergent. Once the stain has been removed, wipe off any remaining detergent 
with a cloth dampened with water. When wiping the server, be sure that no moisture enters the server 
machine. 
Do not use solvents. Use a mild detergent only. Otherwise, the server may be damaged. 
Use a vacuum cleaner periodically to prevent dust buildup in ventilation holes.

• Before cleaning, turn off the server and unplug the power cables from the 
outlets. Also power off peripherals and disconnect them from the server. Failure 
to do so may cause electric shock ( "1.4.4 Turning Off the Server" (Pg.34)).

http://primergy.fujitsu.com
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In dusty environments, dust piles up on the front and rear panels of the server over short periods. 
Install the server in a different location to avoid failures.

Cleaning the Server Interior
In dusty environments, dust deposits in the server. Dust deposits may cause a server failure, fire, or 
electric shock. To keep the PRIMERGY server in good condition, use a vacuum cleaner periodically to 
remove dust deposits.

Cleaning components

CPU: Dust deposits must be removed because it will impair the cooling performance.
Fan: Remove dust from and around the fan.
Memory / Expansion cards: Remove dust between memory modules and between expansion cards. 
Remove dust from the connector before adding a memory module or an expansion card.
Internal hard disk units / 5-inch internal devices: Remove dust deposits from units and devices. Tape 
devices are particularly susceptible to dust and may cause failures. Install them in a clean 
environment.

Be careful when removing components such as CPU, memory modules, or hard disk units. Be sure to 
install parts and cables in the original position.
Leaving dust on the server can cause failure. Be sure to remove any dust from the server.

Cleaning the Keyboard
Wipe with a soft, dry cloth. 

Cleaning the Mouse
Wipe the surface with a soft, dry cloth. If the tracking ball does not spin or roll smoothly, remove the 
ball and clean it.

Cleaning Method

1 Remove the cover from the base of the mouse.
Remove the cover by rotating it in the direction of the arrow.

• Do not disassemble the PSU when cleaning the server interior. Doing so can 
cause failures or electric shock.
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2 Remove the ball and rinse it with water.
Flip the mouse over to remove the ball. Afterwards, wash it with water.

3 Clean the inside of the mouse.
Wipe the inside of the mouse, the roller, and the bottom cover with a damp cloth.

4 Insert the ball and apply the cover.
After the ball and inside of the mouse are dry, insert the ball and apply the cover.

Cleaning the Floppy Disk Drive
Prolonged use of the floppy disk drive accumulates dust on the device head (the part which reads/writes 
data). A dirty head can impair the ability to read/write data to/from a floppy disk correctly. 
Clean the head once every three months.

Cleaning Method

1 Insert the cleaning disk into the floppy disk drive.

2 Access the floppy disk drive from the OS.
• For Windows, access it via Explorer.
• For Linux, execute the "mount" or "dd" commands of the floppy disk drive.
The process is completed when an error message such as indicating that the disk cannot be read is 
displayed.

3 Remove the cleaning disk from the floppy disk drive.

Optional Devices
For details about cleaning optional devices, refer to "PRIMERGY ServerBooks" supplied with the 
server, and "Supplement" supplied with options.

Roller
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9.2 Troubleshooting

This section explains the resolutions when the server is not running properly or when 
error messages are displayed.
For each situation, refer to the following. 
 - Hardware problems: "9.2.1 Hardware Troubleshooting"
 - Error messages: "9.2.2 Error Messages" ( Pg.239)
 - Software problems: "9.2.3 Software Troubleshooting"

If the problem is not resolved after performing these troubleshooting, contact an office listed in the 
"Contact Information" of "Start Guide". 
When contacting your maintenance engineer, refer to "9.8.1 Contacting Maintenance Support" 
( Pg.265) and collect the required information.

Information for PRIMERGY

For the latest information on PRIMERGY, update modules, drivers and the software, refer to the Fujitsu 
PRIMERGY website.
http://primergy.fujitsu.com

9.2.1 Hardware Troubleshooting

This section explains hardware related troubleshooting. If it does not operate properly or if a failure is 
suspected, check the following.
For optional devices, refer to "PRIMERGY ServerBooks" supplied with the server, and "Supplement" 
supplied with options.

Server

The server does not power on, or the power LED on the front of the server 
does not light up.

Check to see whether the power cable is properly connected to the outlet. For instructions on connecting 
the power cable, refer to "Start Guide".

The access LED does not light up.

The server may be damaged. Contact an office listed in the "Contact Information" of "Start Guide". 
When contacting your maintenance engineer, refer to "9.8.1 Contacting Maintenance Support" 
( Pg.265) and collect the required information.

An error message is displayed.

Adopt suitable measures, referring to "9.2.2 Error Messages" ( Pg.239). 

http://primergy.fujitsu.com
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Display

The display does not power on.

Check to see whether the power cable of the display is properly connected to the outlet. For details, refer 
to "Start Guide" and the manual of the display. 

The screen is distorted when Linux shuts down.

Although the screen display may be distorted when shutting down the system in the Linux environment, 
the system is shut down normally. This has no harmful effect on the system.

Nothing is displayed on the screen.

• Check to see whether the display cable is connected properly. If it is not connected, turn the server 
off and then connect the cable. For the connection location, refer to "Start Guide".

• Check that the brightness volume and contrast volume of the display are adjusted correctly. If they 
need to be adjusted, perform the necessary adjustments. 
For details, refer to the manual of the display.

• There may be an error in the system area of the memory. Contact an office listed in the "Contact 
Information" of "Start Guide". 

Typing the keyboard does not display any characters, or the mouse cursor 
does not move.

Check to see whether the keyboard and mouse are connected properly. If they are not connected, turn the 
server off and then connect the cables to the server. For the connection location, refer to "Start Guide".

The screen shakes.

If a device that produces a strong magnetic field such as a television or speaker is near the display, place 
them further away from the display.
The display may also shake if a nearby cell-phone receives a call. Do not use a cell-phone near the 
display.

Floppy Disk Drive

Cannot read or write to the floppy disk.

The head may be dirty. Clean the drive using a cleaning disk. For cleaning methods, refer to "9.1.2 
Cleaning" ( Pg.234).

Cannot write to the floppy disk.

The write protection of the floppy disk may be applied. 
Flip the switch on the disk to allow writing.
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SCSI Device (Internal / External)

The unit does not operate properly.

• Check to see whether the internal cable is connected properly. If it is not connected, correctly connect 
the internal cable. For the connection location, refer to "7.6.2 Installable 5-inch Internal Devices and 
Notes" ( Pg.199).

• For SCSI devices, check to see whether the SCSI ID and terminator are set correctly. If they are not 
set, correctly set the SCSI ID and terminator.

CD-ROM Drive Unit / DVD-RAM Drive Unit

Cannot read data.

• Check to see whether the CD-ROM is inserted properly. If it is not inserted, correctly insert the CD-
ROM so that the label is facing up.

• The CD-ROM may be dirty. If it is dirty, wipe it with a soft, dry cloth.
• The CD-ROM may be scratched or bent. If scratched or damaged, replace the CD-ROM.

The unit does not operate properly.

Check to see whether the internal cable is connected properly. If it is not connected, correctly connect 
the internal cable. 

9.2.2 Error Messages

POST Error Messages

This section explains error messages of Power On Self Test: a device check performed during the server 
startup (POST).
If an error occurs during POST, the following messages are displayed.

When checking/changing the settings of the BIOS Setup Utility, refer to "8.2 BIOS Setup Utility" 
( Pg.213).
For instructions on checking peripheral connections, refer to "Start Guide". 
For details on installing internal options, refer to "Chapter 7 Installing Hardware Options" ( Pg.177).

table: List of POST Errors
Message Description

Failure Fixed Disk IDE device error. Confirm the [Parallel ATA] setting on the 
[Main] menu of the BIOS Setup Utility. If the message still 
appears, the baseboard must be replaced. Contact an office 
listed in the "Contact Information" of "Start Guide".

Stuck Key Keyboard error. Check whether the keyboard is connected 
properly. If the message still appears, the keyboard must be 
replaced.

Keyboard error
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Keyboard controller error Keyboard controller error. Release any keys held down on the 
keyboard. If the message still appears, the baseboard must be 
replaced. Contact an office listed in the "Contact Information" 
of "Start Guide".

System RAM Failed at offset: ********h Memory error. Power off the server and turn it back on. If the 
message still appears, check the error log and replace the faulty 
memory module.

Shadow RAM Failed at offset: ********h

Extended RAM Failed at address line: ****h

Memory type mixing detected The installation configuration of the memory is wrong. Verify 
that the same types of memory modules are installed in the 
slots of the same bank. If the message displays even though the 
installation is correct, replace the memory module.

Memory decreases in Size Memory error. Due to a memory failure, available memory 
capacity is less than the capacity of the installed memory. 
Check the error log and replace the faulty memory module. If 
the message still appears after the replacement, the baseboard 
must be replaced. Contact an office listed in the "Contact 
Information" of "Start Guide".

Non Fujitsu Siemens Memory Module detected 
- Warranty restricted!

Memory error. Check that the jumper pin settings and BIOS 
Setup Utility settings are correct. If the message still appears, 
the baseboard must be replaced. Contact an office listed in the 
"Contact Information" of "Start Guide".

System battery is dead - Replace and run 
SETUP

Battery error. Contact an office listed in the "Contact 
Information" of "Start Guide".

System CMOS checksum bad - Default 
configuration used

The CMOS setting is invalid. Correct the current settings with 
the BIOS Setup Utility or restore the settings to the initial 
values. If the message still appears, the baseboard must be 
replaced. Contact an office listed in the "Contact Information" 
of "Start Guide".

System timer error System clock error. Power off the server and turn it back on. If 
the message still appears, the baseboard must be replaced. 
Contact an office listed in the "Contact Information" of "Start 
Guide".

Real time clock error Real Time Clock (RTC) error. Start the BIOS Setup Utility and 
enter the current time. If the message still appears, the 
baseboard must be replaced. Contact an office listed in the 
"Contact Information" of "Start Guide".

Check date and time settings The set date and time are invalid. Start the BIOS Setup Utility 
and enter the current date and time. If the message still appears, 
the baseboard must be replaced. Contact an office listed in the 
"Contact Information" of "Start Guide".

Previous boot incomplete - Default 
configuration used

POST did not complete during the last startup. Be sure to 
perform the following operation. Failure to do so can result in 
the OS not starting or the server not operating correctly.

1. Start the BIOS Setup Utility.
2. From the [Exit] menu, select [Save Changes & Exit] and 

press the [Enter] key.
The message "Save configuration changes and exit 
now?" is displayed.

3. Select [Yes] and press the [Enter] key.
The BIOS Setup Utility closes and the server restarts.

table: List of POST Errors
Message Description
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CPU had been changed - Run SETUP The CPU has been replaced.
If the correct CPU is installed and this message is displayed, 
select [Yes] for the [Reset Configuration Data] setting on the 
[Advanced] menu of the BIOS Setup Utility. If the message 
still appears, the CPU or baseboard must be replaced. Contact 
an office listed in the "Contact Information" of "Start Guide".

CPU mismatch detected The CPU frequency has changed.
If the correct CPU is installed and this message is displayed, 
update the BIOS using the BIOS Update Utility supplied with 
the CPU. If the message still appears after the update, select 
[Yes] for the [Reset Configuration Data] setting on the 
[Advanced] menu of the BIOS Setup Utility. If the message 
still appears, the CPU or baseboard must be replaced. Contact 
an office listed in the "Contact Information" of "Start Guide".

Available CPUs do not support the same bus 
frequency- system halted!

Baseboard Management Controller Error BMC error. Power off the server and turn it back on. If the 
message still appears, the baseboard must be replaced. Contact 
an office listed in the "Contact Information" of "Start Guide".

Diskette drive A error Floppy disk drive error. Check whether the floppy disk drive 
cable is connected properly. Also check the settings of 
[Diskette A] or [Diskette B] on the [Main] menu of the BIOS 
Setup Utility.

Diskette drive B error

Incorrect Drive A type - run SETUP

Incorrect Drive B type - run SETUP

System cache Error - Cache disabled System cache error. Power off the server and turn it back on. If 
the message still appears, check the error log and replace the 
CPU if it is faulty. Else, the baseboard must be replaced. 
Contact an office listed in the "Contact Information" of "Start 
Guide".

Verify CPU Frequency selection in Setup CPU error. Power off the server and turn it back on. If the 
message still appears, check the error log and replace the CPU 
if it is faulty. If the message still appears, the baseboard must 
be replaced. Contact an office listed in the "Contact 
Information" of "Start Guide".

CPU runtime error (IERR#) detected Installed CPU error. Check the error log and replace the CPU. 
If the message still appears, the baseboard must be replaced. 
Contact an office listed in the "Contact Information" of "Start 
Guide".

Correctable memory error in module X Memory error. Check the error log and replace the memory 
module. If the message still appears, the baseboard must be 
replaced. Contact an office listed in the "Contact Information" 
of "Start Guide".

Uncorrectable memory error

Memory configuration has changed - Run 
SETUP

DRAM error. The DRAM size has changed since the last 
startup. Check the error log and replace the memory module. If 
the message still appears, the baseboard must be replaced. 
Contact an office listed in the "Contact Information" of "Start 
Guide".

No usable system memory Memory error. No memory modules available to the system are 
detected. Check the error log and replace the memory module. 
If the message still appears, the baseboard must be replaced. 
Contact an office listed in the "Contact Information" of "Start 
Guide". After the replacement, enable the use of the memory in 
the BIOS Setup Utility.

table: List of POST Errors
Message Description
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Memory module disabled! This module is no 
longer available for the operating system.

Memory error. Turn off the server and check whether the 
memory module is installed correctly. If the message still 
appears, check the error log and replace the memory module. If 
the message still appears after the replacement, the baseboard 
must be replaced. Contact an office listed in the "Contact 
Information" of "Start Guide".

Manually-operated Retention Latch is not 
closed at Hot-Plug PCI slot x

The card guide is not closed. Check whether the card guide is 
closed. If the message still appears, the baseboard must be 
replaced. Contact an office listed in the "Contact Information" 
of "Start Guide".

No usable CPU Installed CPU error. Replace the CPU. If the message still 
appears, the baseboard must be replaced. Contact an office 
listed in the "Contact Information" of "Start Guide". After the 
replacement, enable the CPU in the BIOS Setup Utility.

Patch for installed CPU not loaded. Please run 
the bios flash update diskette.

Check that the correct CPU is installed. If the correct CPU is 
installed and the message is displayed, select [Yes] for the 
[Reset Configuration Data] setting on the [Advanced] menu of 
the BIOS Setup Utility. If the message still appears, the CPU or 
baseboard must be replaced. Contact an office listed in the 
"Contact Information" of "Start Guide".

CPU disable! CPU is no longer available for 
the operating system.

CPU error. No CPUs available to the system are detected. 
Check the error log and replace the CPU. If the message still 
appears, the baseboard must be replaced. Contact an office 
listed in the "Contact Information" of "Start Guide". After the 
replacement, enable the use of the CPU in the BIOS Setup 
Utility.

Invalid System Configuration Data The system configuration is invalid. Select [Yes] for the [Reset 
Configuration Data] setting on the [Advanced] menu of the 
BIOS Setup Utility.

Resource Conflict IRQ, DMA, or I/O address conflicts between an onboard 
device and an expansion card. Check and modify the 
configuration using the BIOS Setup Utility. If the message still 
appears, the expansion card or baseboard must be replaced. 
Contact an office listed in the "Contact Information" of "Start 
Guide".

IRQ not configured The IRQ for an onboard device or an expansion card is not 
configured. Check and modify the configuration using the 
BIOS Setup Utility. If the message still appears, the expansion 
card or baseboard must be replaced. Contact an office listed in 
the "Contact Information" of "Start Guide".

Expansion ROM not initialized Initialization error of the PCI extended ROM. Disconnect the 
initialized device/card on the screen and replace the card. If the 
message still appears, the baseboard must be replaced. Contact 
an office listed in the "Contact Information" of "Start Guide".

Allocation error static node # An onboard device or an expansion card cannot be used. 
Disconnect the device/card and replace the card. If the message 
still appears, the baseboard must be replaced. Contact an office 
listed in the "Contact Information" of "Start Guide".

Baseboard Management Controller has 
detected an Error

BMC error. The error log needs to be checked and the relevant 
part(s) replaced. Contact an office listed in the "Contact 
Information" of "Start Guide".

table: List of POST Errors
Message Description
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iRMC reports sensor status: CRITICAL temp Abnormal temperature. Check the operating environment. If 
the message still appears, the error log needs to be checked and 
the relevant part(s) replaced. Contact an office listed in the 
"Contact Information" of "Start Guide".

iRMC reports sensor status: WARNING temp

iRMC reports sensor status: CRITICAL Volt-

ages

Power voltage error. Turn off the server and unplug the power 
cable from the outlet. Then, reconnect the power cable and turn 
on the server. If the message still appears, the baseboard must 
be replaced. Contact an office listed in the "Contact 
Information" of "Start Guide".

iRMC reports sensor status: CRITICAL 
Battery

Voltage of a battery error. Turn off the server and unplug the 
power cable from the outlet. Then, reconnect the power cable 
and turn on the server. If the message still appears, the 
baseboard must be replaced. Contact an office listed in the 
"Contact Information" of "Start Guide".

iRMC reports sensor status: WARNING 
Battery

iRMC reports sensor status: CRITICAL FAN1 
SYS

System fan error.
Check whether there are any obstacles interfering with the 
rotation of the system fan. If the message still appears, the 
system fan or baseboard must be replaced. Contact an office 
listed in the "Contact Information" of "Start Guide".

RMC reports sensor status: CRITICAL FAN 
PSU1

PSU fan error.
Check whether there are any obstacles interfering with the
rotation of the PSU fan. If the message still appears, the PSU
fan or baseboard must be replaced. Contact an office listed in
the "Contact Information" of "Start Guide".

table: List of POST Errors
Message Description



244

Chapter 9  Operation and Maintenance

Server Management Tools Error Messages
The following error messages may appear while executing Server Management Tools. In such cases, 
perform the corresponding resolutions. If messages other than the following are displayed, contact an 
office listed in the "Contact Information" of "Start Guide".

table: List of Server Management Tools Error Messages
Message Description

Write protect error writing drive A.
Abort, Retry, Fail?

The inserted floppy disk is write-protected. Disable the 
write-protect, and then press the [R] key.

Not ready writing drive A.
Abort, Retry, Fail?

The floppy disk is not inserted into the floppy disk 
drive. Insert the proper floppy disk ("Server 
Management Tools" disk), and then press the [R] key.

ERROR:Fail to create data file. The following are possible causes. Check the floppy 
disk status again.
• The floppy disk is write-protected. Disable the 

write-protect and retry.
• The floppy disk is not inserted into the floppy disk 

drive. Insert the proper floppy disk, and then retry.
• There is an error in the contents of the floppy disk. 

Create "Server Management Tools" again. If this 
occurred while recovering BIOS information, 
configure the information using the BIOS Setup 
Utility. Then store the BIOS information.

ERROR:Fail to write 1st CMOS data into data file. nn

ERROR:Fail to write 2nd CMOS data into data file. nn

ERROR:Fail to write ESCD data into the data file. nn

ERROR:Fail to write SEEPROM data into the data file. 
nn

ERROR:Fail to open data file. The file for recovering the BIOS information does not 
exist on this floppy disk. Insert the floppy disk on 
which the BIOS information was stored, and then retry.

ERROR:Fail to write 1st CMOS data into system. nn The following are possible causes. Check the floppy 
disk status again.
• The floppy disk is not inserted into the floppy disk 

drive. Insert the proper floppy disk, and then retry.
• A different model or an unsupported version of 

BIOS information. Insert the proper floppy disk, and 
then retry.

• The floppy disk contains abnormal contents. Create 
"Server Management Tools" again. If this occurred 
while recovering BIOS information, configure the 
information using the BIOS Setup Utility. Then 
store the BIOS information.

ERROR:Fail to write 2nd CMOS data into system file. 
nn

ERROR:Fail to write ESCD data into system file. nn

ERROR:Fail to write SEEPROM data into system. nn

Other messages Contact an office listed in the "Contact Information" of 
"Start Guide". 
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9.2.3 Software Troubleshooting

This section explains software related troubleshooting. For troubles during OS installation or system 
operation, refer to the following contents.

Trouble at a ServerStart Startup

After a boot from the ServerStart CD-ROM, nothing is displayed on the 
screen.

This problem may occur if the hard disk drive still contains previous information. In that case, this 
problem will still occur when the Windows Server 2003 Installation CD-ROM is inserted.
To eliminate this problem, physically format the hard disk drive to delete the previous information and 
start up ServerStart. 

Trouble during OS Installation

Automatic logon fails during Windows 2000 setup.

During OS installation, ServerStart installs applications and hardware utilities supplied with the OS. 
Installation and subsequent restart and logon are performed automatically as necessary. In rare cases, 
however, automatic logon is not performed and the logon window appears. In this window, use the user 
name and password you have set before starting installation. After logon, the setup procedures are 
continued.

Error Messages during Installation
The following error messages may appear during installation using ServerStart. Check the corrective 
action against the relevant error.

"WzDiskAdmin: System Error! ......................, Last Error: The device is not 
ready." appears

Optional SCSI devices (e.g., hard disk cabinet, MO disk unit, or DAT unit) may be connected.
Disconnect the optional SCSI devices and perform installation again. Connect the optional devices after 
the installation completes.

"Operating System not found" appears when the system restarts after file 
copy from the CD-ROM 

The following are possible causes. Please check.
• The array controller card comes later than the onboard SAS in order of device startup.
• The Active flag is specified.

"Missing Operating System" appears during installation 

The installation partition size may be too large. Specify the installation partition size correctly. 
 For details on the installation partition size, refer to "2.3.1 Installation Partition Size" ( Pg.47).
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"Error 1920. Service (PXE Services) failed to start" appears during 
preconfigured installation 

The system installed with the preconfigured settings (PXE server) may not be connected to the network. 
Check the LAN cable connection and click [Rerun].

An application where the tftp client function (tftp.exe) is used does 
not operate properly

In the system in which Windows Server 2003 is installed, the tftp client function (tftp.exe) is not 
installed by default, and the application where the tftp client function (tftp.exe) is used does not operate 
properly.
To use the tftp client function (tftp.exe), install "tftp.exe" from the OS CD-ROM according to the 
following procedures.

1 Insert the OS CD-ROM into the CD-ROM drive.
The OS CD-ROM must be either Windows Server 2003 CD that has applied SP1, Windows 
Server 2003 x64 CD or Windows Server 2003 R2 Disc 1 CD.

2 Move to the i386 folder of CD-ROM drive. 

3 Start the command prompt and execute the following commands to extract 
"tftp.exe" in the "%Systemroot%\system32" folder. 
[CD-ROM drive]:\i386>expand -r:tftp.exe TFTP.EX_ %Systemroot%\system32

4 Confirm that "tftp.exe" exists in the "%Systemroot%\System32" folder.

Error Window Appears after Installing or Uninstalling ServerView (on 
Windows Server 2003 )

If Windows Server 2003 Service Pack 1 is applied, the following message may appear on restarting after 
installing/uninstalling ServerView. There is no problem with operations. Click [Close Message] to close 
the message.

In order to protect the computer, this program is terminated by 
Windows.
Name: SNMP Service



247

PRIMERGY TX150 S5 User’s Guide

9

O
peration and M

aintenance

Error Window Appears after LAN Driver Installation (on Windows 
Server 2003)

The following window may appear when the installation of the LAN driver to the [Ethernet controller] 
under [Other devices] starts.

This is because the LAN driver for the network adapter recognized immediately after the OS installation 
is not updated.
Clicking [Finish] in this window displays the [Help and Support Center] window. Click [X] to close this 
window. 
The "!" mark is displayed at the LAN device name in Device Manager. Device names are displayed 
properly when all LAN drivers are installed and the system is restarted. 
For details on LAN driver installation, refer to "4.3.2 Installing the LAN Driver (Windows Server 2003 
/ SBS 2003)" ( Pg.131).

LAN Operation Fails or Error Message Appears during LAN Driver 
Installation

A conflict may have occurred between system resources including the LAN and other expansion cards. 
Delete all LAN drivers and check that conflicts between system resources do not exist. Then, restart the 
system and reinstall the LAN drivers again. For the LAN driver installation procedure, refer to "4.3 
Installing the LAN Driver" ( Pg.128).
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Event Log Errors after Installation
After installation, the following events may be displayed in Event Viewer. Check and perform the 
corrective action against the relevant event.

Cannot Collect the Memory Dump 
If the memory dump file cannot be created, perform the following procedures.

Correcting the settings

If the memory dump cannot be collected, check the settings of the paging file and memory dump file. 
For setting procedures, refer to "5.1 Memory Dump/Paging File Setting" ( Pg.136).

Collecting memory dump to other than the system drive

If the memory dump was set to be collected to the system drive (C:\), change the settings so that the 
memory dump can be saved to a drive other than the system drive.
For setting procedures, refer to "5.1 Memory Dump/Paging File Setting" ( Pg.136). 
If only the system drive exists, or if there is no free space in any of the drives, perform one of the 
following:
• Adding a hard disk
• Replacing with a larger hard disk

table: List of Event Log Errors That Can Occur after Installation
ID Description Cause and corrective action

62 This computer is a domain PDC at the 
root of forest. 
 Use the net command "net time /
setsntp:<server name>" to configure it 
for synchronization from an external 
time source.

Cause:
An NTP was selected as a component. 
 Corrective action: 
ServerStart cannot configure the NTP server due to the 
absence of items for specifying it. After OS installation, 
perform the following procedure to specify the time server.

1. Start SNTP server operation on another machine.
Assume that the SNTP server address is 
<172.22.78.246>.

2. Enter the following at a command prompt.
net time /setsntp:172.22.78.246
w32tm -s 172.22.78.246

1000 The user or computer name cannot be 
identified. The return value is "1722".

Cause:
The primary DNS server address may be invalid or the server 
cannot be connected. 
 Corrective action:
Perform the following procedure to correct the DNS address in 
Internet protocol (TCP/IP) properties.

1. Right-click [My Network] and click [Properties].
2. Right-click [Local Area Connection] and click 

[Properties].
3. Click [Internet Protocol (TCP/IP)] and click 

[Properties].
4. Enter the correct DNS address in the [Primary DNS 

server] box.
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Reducing the installed memory to collect the memory dump

There must be enough free disk space that matches the size of the installed memory; therefore, reduce 
the installed memory to a collectable size.
Check the memory dump settings when changing the installed memory size. 
For setting procedures, refer to "5.1 Memory Dump/Paging File Setting" ( Pg.136).

Changing the write type of the debugging information

If the memory dump cannot be collected, select a write type of debugging information within the range 
of free space of the volume size.
If the above does not provide a solution, try increasing the size of the hard disk or adding an additional 
hard disk.

Restoring the System
In the event where the system file, system configuration, or environment changes during startup are 
corrupted, use the repair information stored on the repair disk created at the installation to restore the 
system. 
 For restoration procedures, refer to the following:
• "9.6.1 For Windows Server 2003" ( Pg.262)
• "9.6.2 For a Windows 2000 Server" ( Pg.263)

Failed in Remote Installation
If remote installation fails, check the following.

Checking Services

Check that the DHCP, PXE Service, and TFTP Service are running. 
For checking procedures, refer to "3.4 Remote Installation" ( Pg.88).

Setting TFTP

To access TFTP Service, add a Guest account to the TFTP folder and set appropriate access rights. 
For setting procedures, refer to "3.4 Remote Installation" ( Pg.88).

Checking Network Function Settings

The server must support network startup (PXE). Network startup must be enabled in advance. 
For setting procedures, refer to "2.1.2 Hardware Settings" ( Pg.43).

Checking the MAC Address

Check that the current MAC address is the correct MAC address of the server. 
For the MAC address checking procedure, refer to "2.1.2 Hardware Settings" ( Pg.43).

Checking LAN Cable Connection

Check that the LAN cable is connected to the LAN card corresponding to the specified MAC address 
and that the LAN card is connected to the network.
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SNMP Service Startup Fails

If the Simple Network Management Protocol (SNMP) is installed, but has not started, perform the 
following procedure to start the service.

For Windows Server 2003

1 Click [Start] → [Computer Management] in this order.

2 Select [Services] from the [Services and Applications] menu.

3 From the details, select [SNMP Service].

4 Select [Start] from the [Action] menu.

For Windows 2000 Server

1 Right-click the [My Computer] icon on the desktop and click [Manage] from the 
displayed menu.

2 Select [Services] from the [Services and Applications] menu.

3 From the details, select [SNMP Service].

4 Select [Start] from the [Action] menu.

To have the service automatically start each time the OS starts, double-click [SNMP Service] from the 
details, and select [Automatic] for the [Startup type] setting of the [SNMP Service Properties] window.

Time Display in Linux OS Environment

Difference in Time between the OS and the Hardware Clock

During OS operation in a Linux environment, the software clock on the OS, rather than the hardware 
clock in the server, is used to display the time. 
This may cause a difference in time between the OS and the hardware clock. 
When you want to see the accurate time on the OS, it is recommended to use the NTP service to 
periodically correct the time displayed on the OS.



251

PRIMERGY TX150 S5 User’s Guide

9

O
peration and M

aintenance

Changing the Time Settings for the OS and Hardware Clock

In a Linux environment, the time displayed on the OS (the software clock value on the OS) is written to 
the hardware clock in the server when the OS is shut down.
• Procedure for prohibiting the time on the OS from being written to the hardware clock

When you do not want the time on the OS to be written to the hardware clock at an OS shutdown, 
comment the following line out in /etc/rc0.d/S01halt.
runcmd $"Syncing hardware clock to system time" /sbin/hwclock $CLOCKFLAGS
↓
#runcmd $"Syncing hardware clock to system time" /sbin/hwclock $CLOCKFLAGS

• Procedure for reflecting the hardware clock value to the time on the OS
To reflect the hardware clock value to the software clock value on the OS, run the following 
command.
>hwclock --hctosys
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9.3 System Event Log

To operate system event log, use Server Management Tools.

When the area for writing to the system event log is full, new event log cannot be recorded. To 
overwrite older event logs automatically, start up the BIOS Setup Utility, select the [IPMI] submenu 
from the [Advanced] menu and set [Event Log Full Mode] to [Overwrite]. [Wrap Around] is an initial 
value. For details on this setting, refer to "8.2.10 IPMI Submenu" ( Pg.225).

9.3.1  How to Use Server Management Tools

This section explains how to use Server Management Tools.
Server Management Tools perform the following to the system event log.
• Viewing the system event log
• Saving the system event log
• Deleting the system event log

When a system event log occurs, save the log using Server Management Tools and contact an office 
listed in the "Contact Information" of "Start Guide".

Notes

• The "Server Management Tools" disk supplied with this server is for use with this server only. Do 
not use those tools on other systems. If it is used, the system can be damaged.

• Make sure to perform this operation only when the server is started with the "Server Management 
Tools" disk. Do not run Server Management Tools on the server started from the hard disk or by the 
other floppy disk. Otherwise, the system may be damaged.

• Do not eject the floppy disk when the Floppy disk access LED is on. Doing so may destroy the data 
on the floppy disk.

Starting Server Management Tools

Before rebooting the system, first check that the ServerView "OS Boot Monitoring" function has been 
disabled (default setting is "Disabled"). 
If the system is started with this function enabled, the server may automatically turn off or restart 
improperly. 
If the "OS Boot Monitoring" function is needed, it should be reset to “enabled” before resuming normal 
server operation. For details about ServerView, refer to the "ServerView User’s Guide".



253

PRIMERGY TX150 S5 User’s Guide

9

O
peration and M

aintenance

1 Turn on the server and insert the "Server Management Tools" disk into the 
floppy disk drive.
The window for selecting a keyboard appears.

2 Select a keyboard.
Select [1] for Japanese keyboard or select [2] for English keyboard. Japanese keyboard is 
selected by default.

3 Enter the following command and press the [Enter] key.
A:\SMT\>IPMIVIEW.EXE
The IPMI Tool window appears. 

4 Select [System Event Log (SEL)] and press the [Enter] key.
The list of system event logs is appears.

Please select:
   1 = JP Keyboard
   2 = US Keyboard
Your selection

General Information
Temperature Information
Fan Information
Voltage Information
Powersupply Information
System Event Log (SEL)
FRU Information (ID Proms)
User Management
LAN Configuration
FSC/System Specific Functions

FUJITSU
 SIEMENS
  COMPUTERS

IPMI-Tool - Vx.xx

<   > Select     <ENTER> Start       <ESC> Exit

004 MMM-DD-YYYY HH:MM:SS [*****] XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
003 MMM-DD-YYYY HH:MM:SS [*****] XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
002 MMM-DD-YYYY HH:MM:SS [*****] XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
001 MMM-DD-YYYY HH:MM:SS [*****] XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
000 MMM-DD-YYYY HH:MM:SS [*****] XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

FUJITSU
 SIEMENS
  COMPUTERS

SYSTEM EVENT LOG (SEL)

<    ,PgUp/Dn,(Ctrl-)Home/End> Move  <F2> SaveToFile  <F3> Clear  <ESC> Exit
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Exiting Server Management Tools

1 Press the [Esc] key in the SYSTEM EVENT LOG window.
The power can be turned off when the DOS prompt is displayed.

9.3.2 Saving/Deleting the System Event Log

Saving the Log

1 Start Server Management Tools to display the SYSTEM EVENT LOG window. 

2 Press the [F2] key.

3 Enter the name of the file to save the log to, and press the [Enter] key.
The log is saved to the floppy disk under the specified file name.

Deleting the Log

1 Start Server Management Tools to display the SYSTEM EVENT LOG window. 

2 Press the [F3] key.

3 Press the [Enter] key.
This deletes the log.
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9.4 Security

Security features are provided in order to protect the server hardware and software 
from theft. Additional security functions, which prevent unauthorized use, provided by 
the BIOS Setup Utility are also available to help maintain a highly reliable data 
security system.

9.4.1 Hardware Security

This section describes security function of hardware.

Locking the drive cover
Lock the drive cover to protect the hardware (hard disk units and 5-inch internal options) in the server 
from theft or tampering.
Turn the key clockwise to lock the cover.

Do not lose the drive cover key. If the key is lost, contact an office listed in the "Contact Information" of 
"Start Guide".
For instructions on opening the drive cover, refer to "1.4.1 Sliding the Drive Cover" ( Pg.30).
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Rack Type
Lock the rack door to protect the hardware in the rack from theft.
To close the rack door, shut the door and return the rack handle, and turn the rack key.

Do not lose the rack key. If the key is lost, contact an office listed in the "Contact Information" of "Start 
Guide".
For instructions on opening the rack door, refer to "1.4.2 Opening the Rack Door" ( Pg.31).
The above explanation is based on the 40U standard rack. For details on other rack systems, refer to 
their respective manuals.

9.4.2 Security against Unauthorized Use

A password can be set to prevent unauthorized use of the server. 
Setting a password makes it necessary to enter the password in order to access the server. Without the 
password, the server cannot be used.

Password Types
There are two types of passwords that define the privileges of server operations.

User Password (System Password)

The password required to use the server. Unless the set password is entered, part of the BIOS setup 
cannot be accessed and the OS cannot be booted.

Administrator Password (Setup Password)

This is the password that only allows the administrator to set up this server. Unless the set password is 
entered, the BIOS setup cannot be accessed and the OS cannot be booted.

Key hole

Rack key

Rack handle
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Setting a Password
The password is set in the BIOS Setup Utility. For details on the BIOS Setup Utility, refer to "8.2.11 
Security Menu" ( Pg.227).

1 Start the BIOS Setup Utility.
"8.2.1 Starting and Exiting the BIOS Setup Utility" (Pg.213)

2 Select the [Security] menu and select the type of password to set.
• For the administrator password, select [Set Setup Password] and press the [Enter] key.
• For the user password, move the cursor to [Set System Password] and press the [Enter] key.

3 When the password input window is displayed, enter the password to set.

4 Enter the password again to confirm it. 

5 Press the [Enter] key.
This sets the password.

Changing / Deleting Passwords

If a password is already set, perform the above password setting operations to display the password 
change window.
• To change the password, perform the following settings and press the [Enter] key.

• To delete the password, enter the current password, and then press the [Enter] key without entering 
anything in the second and third fields. The status of "Setup (System) Password" changes to "Not 
installed".

The system shuts down after three invalid password entries. If this happens, turn off the server, turn it 
back on, and then enter the correct password.
If you forgot your password and cannot start the server, change the jumper setting on the baseboard to 
reset the passwords. For jumper settings, refer to "8.1 Jumper Settings" ( Pg.212).

Set Setup(System) Password:

Enter New Password   [     ]
Confirm New Password   [     ]

Enter the password
Enter the password again for confirmation

Set Setup(System) Password:

Enter Current Password   [     ]

Confirm New Password   [     ]

Enter New Password   [     ]

Enter the current password
Enter the new password
Enter the new password again for confirmation
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9.4.3 Security When Disposing of the Server

Notes regarding the Deletion of Data from the Hard Disk When 
Disposing of or Transferring the Server

When disposing of or transferring a server that has been used, the data in the hard disk may be read and 
used unscrupulously. To prevent confidential or important data from leaking out, the data on the hard 
disk must be wiped before disposal or transfer.
However, wiping the hard disk is not an easy task. Simply initializing (formatting) the hard disk or 
deleting the files may give the pretense that the data no longer exists, but in reality the data is simply no 
longer accessible to the OS, and it is still accessible to malicious individuals that can restore the data.
Therefore, if confidential or important data is saved to the hard disk, in addition to the operations 
mentioned above, it is recommended to use third-party tools or services to wipe the data completely 
from the disk to prevent its restoration.
When disposing of or transferring the server, it is the customer’s responsibility to wipe data contained in 
the hard disk in order to prevent such important data from leaking.
Also, if software license agreements prohibit unauthorized distribution of software (OS or application 
software), transferring the server without removing the software may violate the license agreements. 
These issues must be taken into consideration.
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9.5 Backup

This server utilizes high-reliability components and hard disks, however, as a 
precautionary measure, it is recommended that periodic backups be taken of the 
data.

9.5.1 Importance of Backups

A backup of data stored on the server is required for data restoration in the event of server trouble 
resulting in a system failure or accidental data loss due to operational errors. If the data on the server is 
backed up, it can be restored from the backup in the event of hardware failures or data corruption in hard 
disks due to operational errors. If backups are not made, restoration is impossible and data will be 
permanently lost. To prepare for unexpected problems, be sure to perform periodic backups of the 
system.

9.5.2 Backup Devices, Software and Their Operations

Backup operations differ depending on network operating systems, applications, and system operations. 
Contact an office listed in the "Contact Information" of "Start Guide" and make backups using the 
following items.
• Backup device (e.g., Tape Drv DAT72)
• Backup software

(Standard backup software supplied with the OS, e.g., ARCserve, Changer Option)
• Backup operations (schedules)

Use our genuine backup devices and software. Observe the backup medium (tape) storage conditions.

Mirroring/disk array systems
To improve system reliability, a mirroring or disk array system using an array controller, in addition to 
periodic backup creation, is recommended.

Notes on Operating Backups
Notes on operating backups are as follows. 
For details, refer to the device manuals.
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Head Cleaning

Airborne dust and dust from the magnetic media can collect on the head of the magnetic tape device. To 
remove this dust, head cleaning must be implemented. Implement head cleaning when the device 
displays a cleaning request. Particularly DDS devices require periodic head cleaning, otherwise dust can 
cling to the magnetic head, creating a situation that cannot be cleaned with standard head cleaning 
methods, and eventually render the device useless. 
Also note that the cleaning media has a limit on how many times it can be used. Using cleaning media 
that exceeded its lifespan will have no cleaning effect. Note these points especially when performing 
automatic backups with library devices.

Managing Media Lifespan

Media is a consumable product that must be replaced regularly.
Continued use of media exceeding its lifespan can have negative effects on the device (e.g. increase the 
speed of dust accumulation). The lifespan of media varies depending on the environment and operation 
condition of the device, the type of backup software used, and other operation conditions, however, it is 
recommended that they be replaced sooner than later.
To manage the lifespan, write the use start date on the media.

Rotating Media

When using a single media cartridge repeatedly, backup data can be temporarily lost in the event the 
backup fails. Also if the hard disk fails during backup, the backup data cannot be recovered. 
Perform backup operations using multiple mediums on a rotating basis.

Avoid Leaving Media in Devices

Because the magnetic recording surface of the device is exposed, media can easily affected by airborne 
dust when left inserted for a long period of time. Insert the media before using it, and remove the media 
after use, and restore it in its case. 
Also note that some tape devices write management information to the tape when ejecting the media. If 
the power were to go out when the media is still in the device, this writing process will not be performed 
and the media may become corrupted. 
To avoid this, remove the media from the device when turning off the server/device.

Verifying Data after a Backup

Some backup software products provide data verification functions after a backup is completed. Such 
functions will read and verify the data written to the media after a backup is completed. This will 
increase the usage of the media, thus reducing the number of times it can be used for backups.
Depending on the hardware being used, some devices perform "read after write" operations on data; note 
the points of this section as necessary.
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Ejecting Media after a Backup

Some backup software products provide functions for ejecting media after a backup is completed. Such 
functions will rewind the tape after a backup is completed and then eject the media from the drive.
Be sure to execute this function for autoloader/library devices. Depending on the structure of some 
servers, this function may cause the media to eject from an internal device of the server and hit the 
chassis door. If this is the case, open the door when ejecting, or do not eject the media.

Media Label Types and Positions

When writing information such as the name on media, use the label that came with the media. 
The area in which a label can be posted on the media of each device varies.
Failing to post labels in the designated area can damage the device.

Data Storage

When storing data for long periods of time, store the media in a location least affected by temperature, 
humidity and magnetic fields.
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9.6 Restoring the System

In the unfortunate event where the system file, system configuration, or environment 
changes during startup are corrupted, use the repair information stored on the 
recovery disk created at the installation to restore the system.

Create a recovery disk when you have installed an OS or changed the system configuration. Refer to 
"5.2 Creating a Disk for System Recovery" ( Pg.146).
If the procedures of restoring the system are described in the manual of the backup devices or 
Readme.txt of the device drivers, refer to these procedures.

9.6.1 For Windows Server 2003 

Items Required

• Windows Server 2003 CD-ROM
• Automated System Recovery (ASR) floppy disk (created beforehand)
• Backup media (created beforehand)
• Driver disk (for an onboard array controller / for an array controller card) 

 For details about required driver disk and how to create a drive disk, refer to "4.1 Creating Driver 
Disks" ( Pg.112).

1 Turn on the server and insert the Windows Server 2003 CD-ROM immediately.
Check there are no floppy disks in the floppy disk drive.

2 When the active area is specified on the hard disk, the following message 
appears. Press any key while this message is displayed.

Setup window for Windows Server 2003 x64 appears.

3 The following message appears at the bottom of the window. Press the [F6] 
key.

This message will be displayed for a short time after the setup window (blue screen) appears.
Press the [F6] key immediately after the window turns blue.

4 When a message prompts you to press the [F2] key, press the [F2] key.
A message prompts you to insert the ASR floppy disk.

Press any key to boot from CD....

Press F6 if you need to install a third party 
SCSI or RAID driver ...
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5 Insert the ASR floppy disk and follow the window instructions.

6 Install the driver.
For details on how to install the driver, refer to  "4.2.1 Installing Windows Server 2003 x64" 
( Pg.117) or  "4.2.2 Installing Windows Server 2003 / SBS 2003" ( Pg.120).

7 Follow the window instructions to restore the system.
• When prompted to change the floppy disk, follow the instructions and change it. 
• If a message appears indicating that the driver has not passed Windows Logo testing to verify 

its compatibility with Windows, select [Yes] to continue the installation procedure.
• When prompted to insert media, set the backup media created beforehand and follow the 

messages to continue.

Notes on Automated System Recovery

Automated System Recovery does not restore data files.

9.6.2 For a Windows 2000 Server

Items Required

• Windows 2000 Server CD-ROM
• Windows 2000 Server system recovery disk (created beforehand)

1 Insert the Windows 2000 Server CD-ROM immediately after the server is 
turned on .
Confirm that there is no floppy disk in the floppy disk drive. 

2 From the [Welcome to Setup] window of the Windows 2000 Server Setup 
program, press the [R] key to select restoration.

3 Follow the message on the setup window to restore the system.

Notes on system restoration

The system may return to the initial installation conditions depending on the restoration information 
used. In this case, the system must be configured after system restoration.
Windows 2000 Server may have to be reinstalled if system files or system information are severely 
damaged. If this is the case, reinstall it. Refer to "9.7 Reinstalling the OS" ( Pg.264).
The message "The file XXXXXX.XXX is not the original file copied when Windows 2000 was installed." 
appears during file restoration. Press the [Enter] or [A] key to restore the file.
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9.7 Reinstalling the OS

This section explains the procedure for reinstalling the OS.

9.7.1 Checking before OS Reinstallation

Removing the Optional Devices
Remove the following optional devices before reinstalling the OS. Install or connect them after OS 
installation.
• Optional SCSI devices (e.g., hard disk cabinet or DAT unit) connected via a SCSI card (e.g., hard 

disk cabinet or DAT unit)
• Internal hard disk units that do not contain the OS installation folder
• 5-inch internal devices
• USB devices

Deletion of Data from the Disc
Reinstalling a disk will delete all the contents of that disk. Please be careful. Save the necessary data and 
system configuration in a different location. 
Some drivers and software are not installed together with the OS. Install them after OS installation.

Other Notes
Other notes are the same as those that apply for first time installation. Please check in advance.

9.7.2 Reinstallation Using ServerStart

When the previous installation was performed in guide or preparation mode, the ServerStart floppy disk 
used in that installation can be used again. When the reinstallation is performed with the same 
configuration as that for the previous installation, you do not have to edit the configuration file on the 
ServerStart floppy disk. You do not have to configure setting on wizards. After ServerStart starts up, 
click [Start (OS) Installation] to perform installation. 
Use the expert mode when you want to perform reinstallation while maintaining the existing partitions.
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9.8 Maintenance Service

This section explains the details of the maintenance service.
If the cause of the failure is uncertain or if the original condition cannot be restored, 
contact the seller or an office listed in the "Contact Information" of "Start Guide".

9.8.1 Contacting Maintenance Support

Before contacting maintenance support, check the following.

Fill in the “Configuration Sheet” and “Accident Sheet” of "Configuration Sheets".

Item

• Model name and product ID of the server
They are described on the label on the server. For the label location, refer to "Start Guide".

• Hardware configuration (Types and locations of internal options)
• Configuration information (BIOS Setup Utility, SCSI Setup Utility settings)
• OS
• LAN/WAN system configuration
• Phenomena (what happened when doing what, what was displayed, etc.) 
• Date and time of an accident
• Environmental settings of the server
• LED statuses
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This appendix explains the specifications for the 
server and for its internal options.
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A Server Specifications

This section explains the specifications for the server.

A.1 Diskless Type

The specifications for this server are liable to be updated without any notice. Please be forewarned.

table: Server Specifications - Diskless Type
Item Functions and Specifications

Product ID PGUT1551A PGUT1554A PGUT1552A

CPU 
modules

Standard Intel® Celeron® D 346 Processor 
3.06GHz

Intel® Xeon® 3040 Processor 
1.86GHz

Intel® Pentium® D 925 Processor 
3GHz

Level 2 cache 256KB 2MB 2 × 2MB
Number of 
multiplication 1

Memory
Standard 512MB (DDR2 533 Unbuffered Lowprofile DIMM × 1)
Adding size 512MB / 1GB / 2GB
Maximum 8GB (2GB × 4)

Graphics VGA chip: built-in iRMC 640x480, 800x600, 1024x768, 1280 × 1024
Displayed colors: Differ depending on resolution and OS

CD-ROM drive 48x ATAPI CD-ROM drive (Standard)
5-inch storage bay 3 bay (including the standard bay)
3.5-inch storage bay 4 bays (Adding hotplug for all bays)

Standard Optional
Adding size 73GB / 146.8GB

Expansion slots PCI slot × 1,PCI-X slots × 2, PCI Express slots × 2
Floppy disk drive 3.5-inch (2 mode 1.44MB/720KB) (Standard)

Interface LAN (1Gbit Ethernet) × 2(Standard, 1 port is used only for Remote Management Controller),
 Serial × 2(1port id optional), Parallel × 1(optional), Keyboard, Mouse, Monitor,  USB × 3

Keyboard and Mouse Optional

Dimensions (Width × 
Depth × Height (mm))

205 × 602 × 444
When the Rack Conversion kit for TX150S5 is used:

 482 (including protrusion) × 597 (including protrusion) × 221.2 (5U)
Weight 27kg (29kg for rack type)
Internal clock precision ± 2 to 3 minutes/month
Power consumption Max. 280W（1008kJ/h）
Power 100-240 VAC (50-60Hz)
Power supply unit 1 (Standard)
Fan 1 (Standard)

OS

Windows Server 2003 R2 Standard Edition / Windows Server 2003 Standard Edition /
 Windows Server 2003 R2  Standard x64 Edition / Windows Server 2003 Standard x64 Edition / 

Windows Small Business Server 2003 R2 / Windows Small Business Server 2003 / 
Windows 2000 Server / 

Red Hat Enterprise Linux ES (v.4 for x86) /  Red Hat Enterprise Linux ES (v.4 for EM64T)

ka
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B Specifications for Internal 
Options

This section explains the specifications for internal options for the server. 
When you have bought an internal option as a standard option, check that the 
package contains the following items before use. Should it happen that items are 
missing, contact an office listed in the "Contact Information" of "Start Guide". 

B.1 Memory 

Package

• Memory modules (1)

Specifications

table: Memory Specifications
Item Function and Specifications

Product Name Memory Module-512MB Memory Module-1GB Memory Module-2GB

Models PG-RM51BE PG-RM1BE PG-RM2BE

Capacity 512MB 1GB 2GB

Clock frequency 533MHz (Dual edge)

PIN count 240PIN
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B.2 Internal Hard Disk Units 

Package

• Hard disk unit (1)

Specifications

*1:The value indicates memory capacity of the formatted hard disk (1GB = 10003 bytes). 
*2:A Hot plug carrier is not included.

B.3 Parallel Port Option 

Package

• Parallel Port Option (1)

Specifications

table: Internal Hard Disk Unit Specifications
Item Function and Specification

Models PG-HDB75A PG-HDB45A

Interface SAS (Serial Attached SCSI)

Storage media 3.5-inch hard disk

Memory capacity *1 73.4GB 146.8GB

Maximum data transfer speed 3Gbit/s 

Average latency speed 2.00ms

Rpm 15,000rpm

Dimensions *2 101.6 × 146.0 × 25.4 (mm)

Weight *2 0.8kg

table: Parallel Port Option Specifications
Item Function and Specification

Product Name Parallel Port Option

Model PG-PP06
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B.4 Serial Port

Package

• Serial Port (1)
• Serial Port cable

Specifications

B.5 Power Cord Selection

The power cord for this unit has been packed separately and has been selected according to the country 
of destination. It must be used to prevent electric shock. Use the following guidelines if it is necessary to 
replace the original cord set.
The female receptacle of the cord set must meet CEE-22 requirements (see Figure).

For the United States and Canada
Use a UL listed and CSA labeled cord set consisting of a three conductor cord with a maximum length 
of 15 feet.
For units which stand on a desk or table, type SVT or SJT cord sets should be used.
For units which stand on the floor, only SJT type cord sets should be used.
The cord set must be selected according to the current rating for your unit.
Please consult the table below for the selection criteria for power cords used in the United States and 
Canada.

table: Serial Port Specifications
Item Function and Specification

Product Name Serial Port

Model PG-COM04
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For units set at 230 V (outside of the United States and Canada):

Use a cord set consisting of a minimum AWG according to the table above and a grounding type 
attachment plug rated 15 A, 250 V. The cord set should have the appropriate safety approvals for the 
country in which the equipment will be installed and should be marked HAR.

For the United Kingdom
Should the plug on the flexible cord not be of the type for your socket outlets, do not use an adapter but 
remove the plug from the cord and discard. Carefully prepare the end of the supply cord and fit a suitable 
plug.

The wires in this mains lead are colored in accordance with the following code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

As the colors of the wires in the mains lead of this appliance may not correspond with the colored 
markings identifying the terminals in your plug, proceed as follows:
• The wire which is colored Green and Yellow must be connected to the terminal in the plug which is 

marked with the letter E or by the earth symbol or colored Green or Green and Yellow.
• The wire which is colored Blue must be connected to the terminal which is marked with the letter N 

or colored Black.
• The wire which is colored Brown must be connected to the terminal which is marked with the letter L 

or colored Red.

table: Selection Criteria for Power Cords Used in the United States and Canada
Cord Type Size of Conductors in Cord Maximum Current Rating of Unit

SJT 18 AWG
16 AWG
14 AWG

10 Amps
12 Amps
12 Amps

SVT 18 AWG
17 AWG

10 Amps
12 Amps

• Parallel
For units set at 115 V:
Use a parallel blade, grounding type 
attachment plug rated 15 A, 125 V.

• Tandem
For units set at 230 V:
Use a tandem blade, grounding type 
attachment plug rated 15 A, 250 V.

• This appliance must be earthed. 
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C Remote Control Function

This server supports the Remote Control function. 
When a personal computer (PC) is connected to the serial port of this server with an 
RS-232C cross cable, the PC can be used to control the server power supply (turn 
on/off and reset) remotely. 

C.1 Preparation for Using Remote Control Function

To enable the remote control function, perform the following procedure.
• Configuring the BIOS
• Connecting the Server to a PC
• Configuring terminal software communication settings on the PC

Configuring the BIOS
To use the function of the server management port, perform the following setting using the BIOS Setup 
Utility.

1 Turn on the server. Press the [F2] key during POST to start up the BIOS Setup 
Utility.

2 Select the [Advanced] menu → the [Peripheral Configuration] submenu, and 
set [Serial Multiplexer] to [iRMC].

3 From the [Exit] menu, select [Saving Changes & Exit] to exit the BIOS Setup 
Utility.
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Connecting the Server to a PC
Connect the server to a PC using an RS-232C cross cable.

Configuring the Terminal Software (PC)
Perform settings for the remote control function using terminal software on the PC.

Port Configuration

Configure the port on the PC as follows:

(Window example)

table: Port Settings
Item Contents 

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None

Serial Port

RS-232C cross cable

Serial Port

Server Rear

PC Rear
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C.2 Remote Power Supply Control

This section explains how to control the server power supply remotely.
The server power supply can be remote-controlled with the terminal software on the PC.

Starting Up the Remote Controller

1 Start up the terminal software.
The remote control window appears.

Power state is displayed next to "Power Status:".

2 When "Please enter user name:" appears, enter the user name and press the 
[Enter] key.

table: Meaning of [Power Status]
Display Description

On The server is powered on.

Off The server is powered off.

****************************************
*  Welcome to PRIMERGY Remote Manager  *
*  Firmware Revision x.xxA (x.xx)      *
*  SDRR *.**   ID 0203  TX150S5        *
*  Firmware built xxx xx xxxx xx:xx:xx *
****************************************

System Type  : PRIMERGY TX150 S5
System ID    : xxxxxxxx
System Name  : TX150S5-2 (xxx.xxx.xxx.xxx)
System OS    : xxxxxxxx
System Status: OK
Power Status : On

Please enter user name : 
Please enter pass phrase : 
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3 When "Please enter pass phrase:" appears, enter the password and press the 
[Enter] key.
Note that the password is case-sensitive. As shown below, the characters you have entered are 
displayed as asterisks.

The remote control main menu appears.

4 Press the [2] key and select "Power Management".
The Power Management menu appears.

Please enter pass phrase: ******

****************************************
*  Welcome to PRIMERGY Remote Manager  *
*  Firmware Revision x.xxA (x.xx)      *
*  SDRR *.**   ID 0203  TX150S5        *
*  Firmware built xxx xx xxxx xx:xx:xx *
****************************************

System Type  : PRIMERGY TX150 S5
System ID    : xxxxxxxx
System Name  : TX150S5-2 (xxx.xxx.xxx.xxx)
System OS    : xxxxxxxx
System Status: OK
Power Status : On

    Power Management Menu

(1) Immediate Power Off
(2) Immediate Reset
(3) Power Cycle
(*) Power On

(*) Graceful  Power Off (Shutdown)
(*) Graceful  Reset     (Reboot)

Enter selection or (0) to quit:

****************************************
*  Welcome to PRIMERGY Remote Manager  *
*  Firmware Revision x.xxA (x.xx)      *
*  SDRR *.**   ID 0203  TX150S5        *
*  Firmware built xxx xx xxxx xx:xx:xx *
****************************************

System Type  : PRIMERGY TX150 S5
System ID    : xxxxxxxx
System Name  : TX150S5-2 (xxx.xxx.xxx.xxx)
System OS    : xxxxxxxx
System Status: OK
Power Status : On

    Power Management Menu

(1) Immediate Power Off
(2) Immediate Reset
(3) Power Cycle
(*) Power On

(*) Graceful  Power Off (Shutdown)
(*) Graceful  Reset     (Reboot)

Enter selection or (0) to quit:
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5 Select a menu and press the corresponding number key.
"*" is displayed in the bracket of unavailable menu.

6 If pressing the [1], [2], [3], [4], [5] or [6] key, perform the following operation.
When "Do you really want reboot (Yes/No)?" appears, enter "Yes" and press the [Enter] key.
For [3], [5] or [6], the pop-up window "System shutdown due to <software command> in 60 
seconds! Press Cancel to abort!" appears when Windows is operating. Select [OK].

table: Remote Control Menu
Menu name Key Operation

Immediate Power Off [1] Turns the server off.

Immediate Reset [2] Resets the server.

Power Cycle [3] Turns the server off and back on again. When Windows is 
operating, the server restarts after the OS is shut down.

Power On [4] Turns the server on.

Graceful Power Off
(Shutdown)

[5] Shuts down the OS and turns the server off. When 
Windows is operating, the server is turned off after the OS 
is shut down.

Graceful Reset [6] Shuts down the OS and resets the server. When Window is 
operating, the server is reset after the OS is shut down.

- [0] Exits the remote controller.
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D Remote Management Controller

This section explains functions and features of the Remote Management Controller 
(iRMC) and the optional Remote Management Controller Upgrade (PG-RMCU1). 

D.1 Overview of the Remote Management Controller

PRIMERGY TX150 S5 has the Remote Management Controller on the baseboard. The Remote 
Management Controller makes the high-quality, high-reliability remote service board function possible.
To use the console redirection function and the remote storage function, the license key of optional 
Remote Management Controller Upgrade (PG-RMCU1) is necessary. For details of Remote 
Management Controller Upgrade (PG-RMCU1), refer to "D.4 Remote Management Controller Upgrade  
(PG-RMCU1)" ( pg.281).

Features of the Remote Management Controller

• The Remote Management Controller and LAN are provided on the baseboard. This makes possible to  
control power supply and reset of the server without depending on the state of the server.

• The console redirection function and the remote storage function can be used by optional Remote 
Management Controller Upgrade (PG-RMCU1).

• It provides with LAN interface.
• It has the server monitoring function (monitoring server's hang/temperature/voltage).
• It has the server abnormality notification function (it is possible to notify abnormally at the server 

hang).
• It is possible to display the server status and control power supply/reset of the server by using the 

Web interface.

When the baseboard is replaced, the Remote Management Controller may have to be set again. In 
case of reconfiguration, write down the set values in configuration sheets.
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D.2 Preparation for Using Remote Management 
Controller

To enable the Remote Management Controller, perform the following procedure.
• Configuring the BIOS
• Connecting the Server to a PC

Configuring the BIOS
To use the function of the Remote Management Controller, perform the following setting using the 
BIOS Setup Utility.

1 Turn on the server. Press the [F2] key during POST to start up the BIOS Setup 
Utility.

2 Select the [Advanced] menu → [IPMI] → the [LAN Settings] submenu, and set 
the each item.
.For setting items, refer to "  LAN Settings Submenu" ( pg.226).

3 From the [Exit] menu, select [Saving Changes & Exit] to exit the BIOS Setup 
Utility.

Save the setting information of set parameters using the Server Management Tools.
 For details, refer to "5.3 Storing the System Configuration Information"( → pg.148).

Connecting the Server to a PC
Connect the server to a PC using a LAN cable.

LAN cable

LAN Port

Server Rear

PC Rear

Remote Management

Controller Port

HUB
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D.3 Window of the Remote Management Controller

The Remote Management Controller uses the Web interface function.
The following window appears when starting the Remote Management Controller.

The following functions are available.

For usage of the Remote Management Controller, refer to "ServerView User's Guide".

Comparison with server management function of ServerView
ServerView, software provided with the server, can manage the server remotely if OS is normally 
operating. The Remote Management Controller can operate even in the state of the server hang, 
therefore, it is effective when the server cannot be monitored by ServerView.

table: Functions of the Remote Management Controller
Item Description

System Information Displays the system information.

iRMC Information Displays Remote Management Controller information and configures 
the license key.

Power On/Off This is used to turn the server power ON/OFF or restart.

Sensors Displays the status of each server sensor (fan, temperature, voltage and 
power supply).

System Event Log Displays the system event log.

Server Management Displays and configures the server management information.

Network Settings Configures the network settings.

Alerting Sends alert.

User Management Displays and configures  the user information.

Advanced Video Redirection Starts up the console redirection.
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D.4 Remote Management Controller Upgrade 
(PG-RMCU1)

This option is a license key to make Remote Management Controller's console redirection function and 
remote storage function effective.

Console Redirection Function 

The server can be remotely operated by using console redirection function. Remote operation such as the 
keyboard and mouse operation, and seeing the contents of the display of the server are possible. 
By using console redirection function, it makes possible to achieve the function of the KVM switching 
in the environment where multiple servers are used. The composition of the multiple servers’ 
environment is shown in the figure below.

table: Specifications of Remote Management Controller Upgrade
Item Specifications

Product Name Remote Management Controller Upgrade

Model PG-RMCU1

Function Console redirection function / Remote storage function
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Remote Storage Function

This is a function to recognize the external memory device connected by using the console redirection 
function as a remote device of the server.
The configuration of the remote storage function is shown in the figure below.

The following devices can be used in the remote storage connection. However, the writing into the 
DVD drive is not supported. 
• Internal floppy disk drive
• ATAPI CD-ROM drive
• ATAPI DVD drive
• USB floppy disk drive
• USB CD-ROM drive

License Key Settings

Enter the license key from the Web to make effective the console redirection function and the remote 
storage function.
For details of the setting method, refer to the manual supplied with PG-RMCU1.

PRIMERGY

HUB

LANLAN

Console PC

Accessing as the remote drive

CD-ROM drive

Floppy disk drive
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E Recycling

This section explains how to recycle this server. 

Disposing of the Server
When scrapping this server,  contact an office listed in the "Contact Information" of "Start Guide". This 
server must be disposed of as industrial waste.
Furthermore, if the server is disposed of as it is, someone else may gain access to the information 
contained on the hard disks. It is therefore recommended that all drives be formatted before disposal.
However, just formatting or deleting files may not avoid the risk that the data is restored and used for 
wrongful purposes. If confidential or private information is saved, in order to make it impossible to be 
restored, it is recommended to use third-party data wiping tools. 

Disposing of Used-up Batteries
Used-up batteries must be disposed of as industrial waste and therefore require special processing. Let a 
licensed industrial waste disposal company take care of disposal.

Disposing of Liquid Crystal Displays
Liquid crystal displays must be disposed of as industrial waste and therefore require special processing. 
Let a licensed industrial waste disposal company take care of disposal.
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